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About this Manual

Scope

Mellanox WinOF-2 is the driver for adapter cards based on the Mellanox ConnectX®-4 family of
adapter IC devices. It does not support earlier Mellanox adapter generations.

The document describes WinOF-2 Rev 1.60 features, performance, diagnostic tools, content and
configuration. Additionally, this document provides information on various performance tools
supplied with this version.

Intended Audience
This manual is intended for system administrators responsible for the installation, configuration,

management and maintenance of the software and hardware of Ethernet and InfiniBand adapter
cards. It is also intended for application developers.

Documentation Conventions

Table 2 - Documentation Conventions

Description Convention Example
File names file.extension
Directory names directory
Commands and their parameters command param1 mts3610-1 > show hosts
Required item <>
Optional item []
Mutually exclusive parameters {pl, p2, p3 } or {pl|
p2 | p3}
Optional mutually exclusive [pl|p2|p3]
parameters
Variables for which users supply Italic font enable
specific values
Emphasized words Italic font These are emphasized words
Note e <text> Q This is a note..
Warning <text> May result in system
‘ . ‘ . instability.

14 Mellanox Technologies | Rev 1.60
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Common Abbreviations and Acronyms

Table 3 - Abbreviations and Acronyms

Abbreviation / Acronym Whole Word / Description

B (Capital) ‘B’ is used to indicate size in bytes or multiples of
bytes (e.g., 1IKB = 1024 bytes, and 1MB = 1048576 bytes)

b (Small) ‘b’ is used to indicate size in bits or multiples of bits
(e.g., IKb = 1024 bits)

FwW Firmware

HCA Host Channel Adapter

HW Hardware

IB InfiniBand

LSB Least significant byte

Isb Least significant bit

MSB Most significant byte

msb Most significant bit

NIC Network Interface Card

NVGRE Network Virtualization using Generic Routing Encapsulation

SW Software

VPI Virtual Protocol Interconnect

IPoIB IP over InfiniBand

PFC Priority Flow Control

PR Path Record

RDS Reliable Datagram Sockets

RoCE RDMA over Converged Ethernet

SL Service Level

MPI Message Passing Interface

QoS Quality of Service

ETW Event Tracing for Windows

WPP Windows Software Trace Preprocessor

Rev 1.60
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Related Documents
Table 4 - Related Documents

Document Description

MFT User Manual Describes the set of firmware management tools for a single Infini-

Band node. MFT can be used for:

* Generating a standard or customized Mellanox firmware image
Querying for firmware information

* Burning a firmware image to a single InfiniBand nodeEnabling
changing card configuration to support SRIOV

WinOF-2 Release Notes For possible software issues, please refer to WinOF-2 Release
Notes.

README file Includes basic installation instructions, summary of main features
and requirements.

ConnectX®-4 Firmware For possible firmware issues, please refer to ConnectX®-4 Firm-
Release Notes ware Release Notes.

InfiniBand™ Architecture | The InfiniBand Specification by IBTA
Specification, Volume 1,
Release 1.2.1

16 Mellanox Technologies Rev 1.60



Yiiiy

Mellanox

TECHNOLOGIES

Introduction

This User Manual describes installation, configuration and operation of Mellanox WinOF-2
driver Rev 1.60 package.

Introduction

Mellanox WinOF-2 is composed of several software modules that contain InfiniBand and Ether-
net drivers. It supports 10, 25, 40, 50 or 100 Gb/s Ethernet, and 40, 56 or 100 Gb/s InfiniBand
network ports. The port type and speed are determined upon boot based on card capabilities and
user settings.

The Mellanox WinOF-2 driver release introduces the following capabilities:

* General applicabilities:

Support for Single and Dual port Adapters

Receive Side Scaling (RSS)

Hardware Tx/Rx checksum offload

Large Send Offload (LSO)

Adaptive interrupt moderation

Support for MSI-X interrupts

Network Direct Kernel (NDK) with support for SMBDirect
Virtual Machine Queue (VMQ) for Hyper-V

Quality of Service (QoS)

» Support for global flow control and Priority Flow Control (PFC)

» Enhanced Transmission Selection (ETS)

* Ethernet capabilities:

Receive Side Coalescing (RSC)
Hardware VLAN filtering

RDMA over Converged Ethernet

* RoCE MAC Based (v1)

* RoCE IP Based (v1)

*  RoCE over UDP (v2)

VXLAN

NDKPI v2.0

VMMQ

PacketDirect Provider Interface (PDPI)
NVGRE hardware encapsulation task offload
Single Root I/O Virtualization (SR-IOV)

* InfiniBand capabilities:

Rev 1.60

Mellanox Technologies
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* Large Receive Offload
* Receive Side Scaling
* Checksum Offloads

For the complete list of Ethernet and InfiniBand Known Issues and Limitations, refer to the latest
WinOF-2 Release Notes (www.mellanox.com -> Products -> Software -> InfiniBand/VPI Driv-
ers -> Windows SW/Drivers).

1.1 Supplied Packages
Mellanox WinOF-2 driver Rev 1.60 includes the following package:
« MLNX WinOF2-1 60 All x64.exe

1.2 Windows MPI (MS-MPI)
Message Passing Interface (MPI) is meant to provide virtual topology, synchronization, and com-
munication functionality between a set of processes. MPI enables running one process on several
hosts. For further details on MPI, please refer to Appendix B,“Windows MPI (MS-MPI),” on
page 166.
*  Windows MPI runs over the following protocols:

* Sockets (Ethernet or I[PoIB)
* Network Direct (ND) Ethernet and InfiniBand

1.3 Windows Nano Server 2016
Windows Server 2016 offers a new installation option: Nano Server. Nano Server is a remotely
administered server operating system. WinOF-2 currently supports driver-only installation over
Nano server, with the following capabilities:
» Support for Single and Dual port Adapters
* Receive Side Scaling (RSS)
* Receive Side Coalescing (RSC)
» Hardware Tx/Rx checksum offload
» Large Send Offload (LSO)
* Adaptive interrupt moderation
*  Support for MSI-X interrupts
* Network Direct Kernel (NDK) with support for SMBDirect
* Virtual Machine Queue (VMQ) for Hyper-V
* Hardware VLAN filtering
* RDMA over Converged Ethernet
* RoCE MAC Based (v1)
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RoCE IP Based (v1)

RoCE over UDP (v2)

VXLAN

VMMQ

PacketDirect Provider Interface (PDPI)

NVGRE hardware encapsulation task oftfload

Quality of Service (QoS)

Support for global flow control and Priority Flow Control (PFC)
Enhanced Transmission Selection (ETS)

Single Root I/O Virtualization (SR-IOV)

Introduction

Rev 1.60
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2 Installation

2.1 Hardware and Software Requirements

Table 5 - Hardware and Software Requirements

Description® Package

Windows Server 2012 R2 MLNX WinOF2-1 60 All x64.exe
Windows Server 2012 MLNX WinOF2-1 60 All x64.exe
Windows Server 2016 MLNX WinOF2-1 60 All x64.exe
Windows 8.1 Client (64 bit only) MLNX WinOF2-1 60 All x64.exe
Windows 10 Client (64 bit only) MLNX WinOF2-1 60 All x64.exe

a. The Operating System listed above must run with administrator privileges.

2.2 Downloading Mellanox WinOF-2 Driver

To download the .exe according to your Operating System, please follow the steps below:
Step 1. Obtain the machine architecture.
For Windows Server 2012 /2012 R2 / 8.1 Client
1. To go to the Start menu, position your mouse in the bottom-right corner of the
Remote Desktop of your screen.
2. Open a CMD console (Click Task Manager-->File --> Run new task, and enter
CMD).
3. Enter the following command.
> echo $PROCESSOR ARCHITECTURES

On an x64 (64-bit) machine, the output will be “AMD64”.

Step 2. Go to the Mellanox WinOF-2 web page at:
http://www.mellanox.com > Products > InfiniBand/VPI Drivers => Windows SW/Drivers.

Step 3. Download the .exe image according to the architecture of your machine (see Step 1). The
name of the .exe is in the following format
MLNX_ WinOF2-<version>_ <arch>.exe.

example, if you try to install a 64-bit .exe on a 32-bit machine, the wizard will display the follow-
ing (or a similar) error message:

Windows Installer x|

=) Thiz inztallation package is ot supported by this
processor bpe. Contact your product vendar.

oK |

@ Installing the incorrect .exe file is prohibited. If you do so, an error message will be displayed. For

-
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2.3 Installing Mellanox WinOF-2 Driver

WinOF-2 supports adapter cards based on the Mellanox ConnectX®-4 family of adapter IC
devices only. If you have ConnectX-3 and ConnectX-3 Pro on your server, you will need to install

WinOF driver.
For details on how to install WinOF driver, please refer to WinOF User Manual.

This section provides instructions for two types of installation procedures:
» “Attended Installation”

An installation procedure that requires frequent user intervention.
e “Unattended Installation”

An automated installation procedure that requires no user intervention.

Q Both Attended and Unattended installations require administrator privileges.

2.3.1 Attended Installation

The following is an example of an installation session.
Step 1. Double click the .exe and follow the GUI instructions to install MLNX WinOF2.
Step 2. [Optional] Manually configure your setup to contain the logs option.

> MINX WinOF2-1 60 All x64.exe /v"/l*vx [LogFile]"

Step 3. [Optional] If you do not want to upgrade your firmware version!.

> MLNX_WinOF2-1 60 All x64.exe /v" MT SKIPFWUPGRD=1"

1. MT_SKIPFWUPGRD default value is False

Rev 1.60 Mellanox Technologies
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Step 4. Click Next in the Welcome screen.

Welcome to the InstallShield Wizard for
MLNX_WinOF2

The InstallShield(R) Wizard will install MLMNX_WinOF2 on your
computer. To continue, dick Next.

WARMING: This program is protected by copyright law and
international treaties.

Step 5. Read then accept the license agreement and click Next.

License Agreement

Please read the following license agreement carefully.

Copyright (c) 2005-2015, Mellanox Technologies R11
rights reserved.

Redistribution and use in source and binary forms, with
or without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notiece, this list of conditions and the
following disclaimer.

(O 1 accept the terms in the license agreement

(®) 1 do not accept the terms in the license agreement

InstallShield

<Back | Met: || cancel
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Step 6. Select the target folder for the installation.

Click Mext to install to this folder, or dick Change to install to a differen

’ Install MLMX_WinOF 2 to:
C:\Program Files \Mellanox MLNX_WinDF2\

InstallShield
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Step 7. The firmware upgrade screen will be displayed in the following cases:
o Ifthe user has an OEM card. In this case, the firmware will not be displayed.

e Ifthe user has a standard Mellanox card with an older firmware version, the firmware will be
updated accordingly. However, if the user has both an OEM card and a Mellanox card, only the
Mellanox card will be updated.

i MLNX_WinOF2 - InstallShield Wizard -

Firmware Upgrade

Upgrade the HCA's firmware version (Recommended).
Upgrading the firmware version will reboot your machine.

Mote: One or more of your HCA adapters has an old firmware version. We recommend
upgrading to a newer firmware version to enable improved functionality and
support driver's capabilities.

Installshield

< Back || Mext = | | Cancel
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Step 8. Select a Complete or Custom installation, follow Step a and on.

i, MLNX_WinOF2 - InstallShield Wizard

Setup Type
Choose the setup type that best suits your needs.

Please select a setup type,

) Complete
i All program features wil be installed. (Requires the most disk
space.)

(®) Custom

Choase which program features you want installed and where they
wil be installed, Recommended for advanced users,

InstallShield

< Back || Mext = || Cancel

a.Select the desired feature to install:

* Performances tools - install the performance tools that are used to measure performance in user

environment

* Documentation - contains the User Manual and Release Notes

* Management tools - installation tools used for management, such as mlxstat

Installation
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* Diagnostic Tools - installation tools used for diagnostics, such as mlx5cmd

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

= Feature Description
=R |rerformance Tools
Install tools used to measure

"= | Dacumentation performance through bandwidth
=3 - | Management tools and latency over various
-+ (=] « | Diagnostic Tools configurations (Metwork Direct,
InfiniBand).

This feature requires 304E on
your hard drive.

Install to:

C:\Program Files\Mellanox\MLNX_WinOF 2\Performance toals),

Installshield

| vep || spa= || <Bak || Cancel

b. Click Install to start the installation.

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield
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Step 9. In case firmware upgrade option was checked in Step 7, you will be notified if a firmware

upgrade is required (see 7 ] ).

Installing MLNX_WinOF2
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs MLMY_WinQF 2. This may
take several minutes.

Status:

o Firmware upgrade is required. This may take several minutes.

Instalishield

< Badk MNext =

Step 10.Click Finish to complete the installation.

8, MLNX_WinOF2 - InstallShield Wizard 2

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed
MLMX_WinOF 2, Click Finish to exit the wizard.

[] Show release notes

| < Back ” Finigh | | Cancel
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2.3.2 Unattended Installation

displaying any prompt or warning to the user.

Q If no reboot options are specified, the installer restarts the computer whenever necessary without
Use the /norestart or /forcerestart standard command-line options to control reboots.

The following is an example of an unattended installation session.

Step 1. Open a CMD console-> Click Start-> Task Manager File-> Run new task-> and enter CMD.
Step 2. Install the driver. Run:

> MLNX WinOF2-1 60 All x64.exe /S /v/qn
Step 3. [Optional] Manually configure your setup to contain the logs option:

> MINX WinOF2-1 60 All x64.exe /S /v/qn /v"/l*vx [LogFile]"

Step 4. [Optional] if you want to control whether to install ND provider or not!.
> MLNX WinOF2-1 60 All x64.exe /vMT NDPROPERTY=1

Step 5. [Optional] If you do not wish to upgrade your firmware version®.

> MLNX WinOF2-1 60 All x64.exe /vMT SKIPFWUPGRD=1

Applications that hold the driver files (such as ND applications) will be closed during the unat-
tended installation.

2.4 Installation Results

Upon installation completion, you can verify the successful addition of the network card(s)
through the Device Manager.

Upon installation completion, the inf files can be located at:
*  %ProgramFiles%\MellanoxX\MLNX_ WinOF2\Drivers\<OS>

To see the Mellanox network adapters, display the Device Manager and pull down the “Network
adapters” menu.

1. MT_NDPROPERTY default value is True
2. MT _SKIPFWUPGRD default value is False
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Figure 1: Installation Results
= Device Manager

File Action View Help
e = B Hm & 2 &S

4 25 1-dev-wi1
b (M Computer
b ¢ Disk drives
R Display adapters
g IDE ATA/ATAPI controllers
@ IEEE 1384 host controllers
. Texas Instruments 1394 OHCI Compliant Host Controller
== Keyboards
}E Mice and other pointing devices
B Monitors
&F Network adapters
=¥ Broadcom NetXtreme Gigabit Ethernet =5
=¥ Broadcom NetXtreme Gigabit Ethemnet #6
&F Broadcom NetXtreme Gigabit Ethernet =7
& Broadcom NetXtreme Gigabit Ethemnet #8
[%F Mellanox ConnectX-4 Adapter |
=F Mellanox ConnectX-4 Adapter #2
4 |15 Other devices
iy Base System Device
b "5 Ports (COM &LPT)
b =5 Print queues
b |2} Processors
b € Storage controllers
4 M System devices

| 4

b v v ¥

2.5 Extracting Files Without Running Installation

To extract the files without running installation, perform the following steps.

Step 1. Open a CMD console-> Click Start-> Task Manager-> File-=> Run new task-> and enter
CMD.

Step 2. Extract the driver and the tools:
> MLNX WinOF2-1 60 All x64 /a
* To extract only the driver files.
> MLNX WinOF2-1 60 All x64 /a /vMT DRIVERS ONLY=1
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Step 3. Click Next to create a server image.

Welcome to the InstallShield Wizard for
LN _WinOF2

The Installshieldi{R} wizard will create a server image of
MLMX_WINOFZ at a specified network location, To continue,
click Mest,

Mext = | | Cancel

Step 4. Click Change and specify the location in which the files are extracted to.

Metwork Location
Spedfy a network location for the server image of the product.

Enter the netwark location or dick Change to browse to a location. Click Install to create a
server image of MLMNX_WinOF 2 at the spedfied network location or dick Cancel to exit the
wizard,

Metwork location:

IN:‘I,

InstallShield
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Step 5. Click Install to extract this folder, or click Change to install to a different folder.

Network Location
Specify a network location for the server image of the product.

Enter the network location or dick Change to browse to a location. Click Install to create a
server image of MLNX_WinOF 2 at the specified network location or dick Cancel to exit the
wizard.
MNetwork location:
JFy
InstallShield
<Back || mstal || concel

Step 6. To complete the extraction, click Finish.

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed
- MLMNX_WinOF2. Click Finish to exit the wizard.

Cancel |

2.6 Uninstalling Mellanox WinOF-2 Driver

2.6.1 Attended Uninstallation
» To uninstall MLNX_WinOF?2 on a single node:
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Click Start-> Control Panel-> Programs and Features-> MLNX_ WinOF2-> Uninstall.
(NOTE: This requires elevated administrator privileges — see Section 1.1, “Supplied Packages”,
on page 18 for details.)

2.6.2 Unattended Uninstallation

If no reboot options are specified, the installer restarts the computer whenever necessary without
0 displaying any prompt or warning to the user.

Use the /norestart or /forcerestart standard command-line options to control reboots.

» To uninstall MLNX_WinOF?2 in unattended mode:

Step 1. Open a CMD console-> Click Start-> Task Manager-> File-> Run new task-> and enter
CMD.

Step 2. Uninstall the driver. Run:
> MLNX WinOF2-1 60 All x6d.exe /S /x /v"/qn"

2.7 Firmware Upgrade

If the machine has a standard Mellanox card with an older firmware version, the firmware will be
automatically updated as part of the WinOF-2 package installation.

For information on how to upgrade firmware manually, please refer to MFT User Manual:
www.mellanox.com ->Products -> InfiniBand/VPI Drivers -> Firmware Tools

2.8 Deploying the Driver on a Nano Server

2.8.1 Offline Installation

» To deploy the Driver on a Nano Server:

Step 1. Go to the Mellanox WinOF web page at
http://www.mellanox.com > Products > InfiniBand/VPI Drivers => Windows SW/Drivers.

Step 2. Download the driver (MLNX WinOF2 MLNX WinOF2-1 60 miIx5 All win2016_x64 -
fre 1 60 15407.exe).

Step 3.  Extract the driver to a local directory (see Section 2.5, “Extracting Files Without Running
Installation”, on page 29).

Step 4.  Copy the contents of this directory to C:A\WS2016TP5_Drivers.
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The directory contents should appear as follows:

I [ ] = | win2016
Home Share View

&« v > This PC » Win2016DCx64_14393 Regular (C:) » msi » Win2016
MName Date modified Type
7 Quick access
= auls] 8 116 3:19 PM Security Catalog
[ Desktop < - - J
4] mix3 8 116 3:18 PM Setup Information
* Downloads %] mix5.sys 8 System file
=] Documents %] mixSui.dil 8 Application extens...
&=| Pictures
[ This PC
¥ Metwork

This location should be specified for DriversPath property when injecting driver into the
Nano server image:

New-NanoServerImage -MediaPath \\Path\To\Media\en us -BasePath .\Base -TargetPath
.\InjectingDrivers.vhdx -DriversPath C:\WS2016TP5 Drivers

Step 5. Create the Nano server image.

Follow the instructions in the TechNet article for "Getting Started with Nano Server"
https://technet.microsoft.com/en-us/library/mt126167.aspx

2.8.2 Online Update
Step 1. Go to the Mellanox WinOF web page at
http://www.mellanox.com > Products > InfiniBand/VPI Drivers => Windows SW/Drivers.
Step 2. Download the driver package.

Step 3.  Extract the Mellanox drivers to a local directory (see Section 2.5, “Extracting Files Without
Running Installation”, on page 29).

Step 4. Open a remote connection to the Nano server.
Step 5. Copy all the driver files to the Nano server
Step 6. Install the driver:

pnputil -I -a <Driver Folder>\mlx5.inf

When upgrading the driver on a server where the remote connection was done over Mella-
nox device, there will be a loss of connectivity. To upgrade, it is recommended to run a
script that will execute all the required upgrade commands.
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3 Features Overview and Configuration

Once you have installed Mellanox WinOF-2 package, you can perform various modifications to
your driver to make it suitable for your system’s needs

Changes made to the Windows registry happen immediately, and no backup is automati-
A cally made.

Do not edit the Windows registry unless you are confident regarding the changes.

3.1 Ethernet Network

3.1.1 Packet Burst Handling

This feature allows packet burst handling, while avoiding packet drops that may occur when a
large amount of packets is sent in a short period of time. For the feature’s registry keys, see 3.5.4
“Performance Registry Keys,” on page 113.

1. By default, the feature is disabled, and the AsyncRecievelndicate registry key is set to 0. To
enable the feature, choose one of the following options:

a. To enable packet burst buffering using threaded DPC (recommended), set the AsyncRecievelndicate registry
keyto 1.

b. To enable packet burst buffering using polling, set the AsyncRecievelndicate to 2.

2. To control the number of reserved receive packets, set the RfdReservationFactor registry key:

Default 150
Recommended 10,000
Maximum 5,000,000

The memory consumption will increase in accordance with the "RfdReservationFac-
tor" registry key value.

3.1.2 Mode Configuration

» For retrieving the port types, perform one of the following:

1. Run mlx5cmd -stat from the "Command Prompt", and check the link layer from the output.
2. Accomplish the following steps:

Step 1.  Display the Device Manager and expand "Network adapters".
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Step 2.

Step 3.

Figure 2: Network Adapters

o Device Manager
File Action View Help
o @ E HBE B EX®

v i dev-l-vrt-057
|j: Computer
= Disk drives
& Display adapters
=@ |DE ATA/ATAPI controllers
v i [EEE 1394 host controllers
i, Texas Instruments 1384 OHCI Compliant Host Controller
£ Keyboards
3 Mice and cther pointing devices
H Monitors
~ [ Network adapters
L Broadcom MetXtreme Gigabit Ethernet £5
lf‘ Broadcom Metktreme Gigabit Ethernet #6
L Broadcom MetXtreme Gigabit Ethernet 7
L+ Broadcom MetXtreme Gigabit Ethernet 28
L Hyper-V Virtual Ethernet Adapter
[? Mellanox Connect®-4 Adapter
2P Mellanox ConnectX-4 Adapter #2

= W ek e e

Right-click on the Mellanox “ConnectX-4/ConnectX-5 Adapter”, and left-click to select
“Properties”.

Open the "Information" tab, and check the Port Type. The figure bellow is an example of the
displayed Information window for an InfiniBand port.

Features Overview and Configuration
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Figure 3: IB Port

Mellanox ConnectX-4 Adapter Properties >
Events Resources Power Management
General Advanced Information Driver Details

Adapter Information

Mellanox

Infamation ] Walue

Drriver Version 1.50.15450.0
Firmware Version 1217120

Port Mumber 1

Bus Type PCI-EB0GTsx16
Link Speed -

Part Mumber MCX456A-ECAT
Device Id 4115

Revision Id 0

Cumrent MAC Address E&-10-2D-0F-68-0E
Pemanent MALC Address E6-10-2D-0F-68-0E
Metworl: Status Disconnected
Adapter Friendhy Name Ethemet &

Port Type |PolB

IPvwd Addrese H1 1RG 2R4 737 M7

For configuring the port types to Ethernet/InfiniBand mode on a device, use the mlxconfig.exe
utility, which is a part of the MFT package for Windows, and is available at http://www.mella-

nox.com/page/management_tools.
1. Install the WinMFT package.

2. Retrieve the device name:

a. In command prompt, run "mst status -v'":

> mst status -v
MST devices:

mt4099 pci cr0 bus:dev.fn=04:00.0
mt4099 pciconfl bus:dev.fn=04:00.0
mt4103 pci cr0 bus:dev.fn=21:00.0
mt4103 pciconfl bus:dev.fn=21:00.0
mt4115 pciconf0 bus:dev.fn=24:00.0

b. Identify the desired device by its "bus:dev.fn" PCle address.
3. To configure the port type to:
* Ethernet, execute the following command with the appropriate device name:
mlxconfig -d mt4115 pciconf( set LINK TYPE P1=2

* InfiniBand, execute the following command with the appropriate device name:
mlxconfig -d mt4115 pciconfl set LINK TYPE Pl=1
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0 In order to set the type of the second port, set the parameter LINK TYPE P2.

4. Reboot the system.
For further information, please refer to the MFT User Manual.

Changing the port type will change some of the registry keys to the default values of
the new port type.

Features Overview and Configuration

3.1.3 Assigning Port IP After Installation
By default, your machine is configured to obtain an automatic IP address via a DHCP server. In
some cases, the DHCP server may require the MAC address of the network adapter installed in
your machine.
» To obtain the MAC address:
Step 1. Open a CMD console-> Click Start-> Task Manager-> File-> Run new task-> and enter
CMD.
Step 2. Display the MAC address as “Physical Address”
> ipconfig /all
Configuring a static IP is the same for Ethernet adapters.
» To assign a static IP address to a network port after installation:
Step 1. Open the Network Connections window. Locate Local Area Connections with Mellanox
devices.
& MNetwork Connections I;Ii-
4+ |8 o Network and Inter... » MNetwork Connections v G | Search Network Connections » |
Organize = = - [ &
Mame Status Device Name
U Ethemnet 11 Network Broadcom NetXtreme Gigabit Et.,
w«w Ethernet 12 Metwork cable unplugged Broadcom NetXtreme G
< Ethermet 13 Network cable unplugged Broadcom NetXtreme G
J Ethemnet 15 Metwork cable unplugged Broadcom NetXtreme Gig
W Ethernet Unidentified network Mellanox Connectd-4 VPl A
% Ethermet 3 MNetwork cable unplugged Me onnectX-4
U Local Area Connection® 9 Disabled Microsoft Kernel Debug MNetwor.,
7 itemns =
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Step 2. Right-click a Mellanox Local Area Connection and left-click Properties.

] Ethernet 4 Properties -

Networking | Sharing

Connect using:

l_-T Mellanox Connect-4 VP| Adapter (MT4115) #6

This connection uses the following items:
R o Client for Microsoft Networks »

O Q File and Printer Sharing for Microsoft Networks
SOOS Packet Scheduler

w2 NDISTest600F041Prot instance

[ -2 NDISAPITest0F041Prot instance

<& NDISTest6003d41 Prot instance

[ - NDISAPITest03d41Prot instance v
£ m >
| Install... | | Uninstall Properties
Description
Allows your computer to access resources on a Microsoft
network.
[ ok || cancel |

Step 3. Select Internet Protocol Version 4 (TCP/IPv4) from the scroll list and click Properties.

Step 4. Select the “Use the following IP address:” radio button and enter the desired IP information.

Internet Protocol Version 4 (TCP/IPv4) Properties _

General | Alternate Configuration

Yfou can get IP settings assigned automatically if your network supparts
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(®) Obtain an IP address automatically
(Z) Use the following IP address:

(0 Obtain DNS server address automatically

(®) Use the following DNS server addresses:

Preferred DNS server: l:l
Alternate DNS server: l:l

[ validate settings upon exit

| oK || Cancel |

Step 5. Click OK.
Step 6. Close the Local Area Connection dialog.
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Step 7. Verify the IP configuration by running ‘ipconfig’ from a CMD console.

> ipconfig
Ethernet adapter Local Area Connection 4:

Connection-specific DNS Suffix

IP Address. . . v v v v v vowo.o. o 11.4.12.63
Subnet Mask . . . . . . . . .. . ¢ 255.255.0.0
Default Gateway . . . . . . . . .:

3.1.3.1 Configuring 56GbE Link Speed

Mellanox offers proprietary speed of S6GbE link speed over FDR systems. To achieve this, only

the switch, supporting this speed, must be configured to enable it. The NIC, on the other hand,
auto-detects this configuration automatically.

» To achieve 56GbE link speed over a SwitchX® based switch system

Make sure your switch supports S6GbE speed rates, and that you have the required switch
license installed.

Step 1. Set the system profile to be eth-single-switch, and reset the system:

switch (config) # system profile eth-single-profile

Step 1. Set the speed for the desired interface to S6GbE as follows. For example (for interface 1/1)::

profileswitch (config) # interface ethernet 1/1
switch (config interface ethernet 1/1) # speed 56000
switch (config interface ethernet 1/1) #
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3.14

Step 1. Verify that the speed rate is S6GbE.:

switch (config) # show interface ethernet 1/1
Ethl/1

Admin state: Enabled
Operational state: Down
Description: N\A

Mac address: 00:02:c9:5d:e0:26
MIU: 1522 bytes

Flow-control: receive off send off
Actual speed: 56 Gbps
Switchport mode: access

Rx

0 frames

0 unicast frames

0 multicast frames

0 broadcast frames

0 octets

0 error frames

0 discard frames

Tx

0 frames

0 unicast frames

0 multicast frames

0 broadcast frames

0 octets

0 discard frames

switch (config) #

RDMA over Converged Ethernet (RoCE)

Remote Direct Memory Access (RDMA) is the remote memory management capability that
allows server to server data movement directly between application memory without any CPU
involvement. RDMA over Converged Ethernet (RoCE) is a mechanism to provide this efficient
data transfer with very low latencies on loss-less Ethernet networks. With advances in data center
convergence over reliable Ethernet, ConnectX® EN with RoCE uses the proven and efficient
RDMA transport to provide the platform for deploying RDMA technology in mainstream data
center application at 10GigE and 40GigE link-speed. ConnectX® EN with its hardware offload
support takes advantage of this efficient RDMA transport (InfiniBand) services over Ethernet to
deliver ultra-low latency for performance-critical and transaction intensive applications such as
financial, database, storage, and content delivery networks. RoCE encapsulates IB transport and
GRH headers in Ethernet packets bearing a dedicated ether type. While the use of GRH is
optional within InfiniBand subnets, it is mandatory when using RoCE. Applications written over
IB verbs should work seamlessly, but they require provisioning of GRH information when creat-
ing address vectors. The library and driver are modified to provide mapping from GID to MAC
addresses required by the hardware.
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3.1.4.1 IP Routable (RoCEv2)

RoCE has two addressing modes: MAC based GIDs, and IP address based GIDs. In RoCE IP
based, if the IP address changes while the system is running, the GID for the port will automati-
cally be updated with the new IP address, using either IPv4 or IPv6.

RoCE IP based allows RoCE traffic between Windows and Linux systems, which use IP based
GIDs by default.

A straightforward extension of the RoCE protocol enables traffic to operate in layer 3 environ-
ments. This capability is obtained via a simple modification of the RoCE packet format. Instead
of the GRH used in RoCE, routable RoCE packets carry an IP header which allows traversal of
IP L3 Routers and a UDP header that serves as a stateless encapsulation layer for the RDMA
Transport Protocol Packets over IP.

Figure 4: RoCE and RoCE v2 Frame Format Differences

EtherType indicates
that packet is RoCE
(i.e. next header is IB GRH)

| IBPayload | ICRC |

RoCE

_El-ﬂﬂiﬂ . IBPayload | ICRC |

EtherType indicatesT \D
that packet is IP P dport number Indicates

(i.e. next header is IP) ip.protocol_number that next header is IB.BTH
indicates that packet is UDP

RoCEv2

The proposed RoCEv2 packets use a well-known UDP destination port value that unequivocally
distinguishes the datagram. Similar to other protocols that use UDP encapsulation, the UDP
source port field is used to carry an opaque flow-identifier that allows network devices to imple-
ment packet forwarding optimizations (e.g. ECMP) while staying agnostic to the specifics of the
protocol header format.

The UDP source port is calculated as follows: UDP.SrcPort = (SrcPort XOR DstPort) OR
0xC000, where SrcPort and DstPort are the ports used to establish the connection.

For example, in a Network Direct application, when connecting to a remote peer, the destination
IP address and the destination port must be provided as they are used in the calculation above.
The source port provision is optional.

Furthermore, since this change exclusively affects the packet format on the wire, and due to the
fact that with RDMA semantics packets are generated and consumed below the AP applications
can seamlessly operate over any form of RDMA service (including the routable version of RoCE
as shown in Figure 4,“RoCE and RoCE v2 Frame Format Differences”), in a completely trans-

parent Wayl.

1. Standard RDMA APIs are IP based already for all existing RDMA technologies
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Figure 5: RoCE and RoCEv2 Protocol Stack

RDIMA Application E/
B
ND/NDK API
RDIVIA API (Verbs) .
E
RoCE v1 RoCE v2 g\/
Ethernet Link Layer

Q The fabric must use the same protocol stack in order for nodes to communicate.

the default value of RoCE mode will be RoCEv2.

Upgrading from earlier versions to version 1.30 or above will save the old default value
(RoCEv1).

@ In earlier versions, the default value of RoOCE mode was RoCE v1. Starting from v1.30,

3.1.4.2 RoCE Configuration

In order to function reliably, RoCE requires a form of flow control. While it is possible to use
global flow control, this is normally undesirable, for performance reasons.

The normal and optimal way to use RoCE is to use Priority Flow Control (PFC). To use PFC, it
must be enabled on all endpoints and switches in the flow path.

In the following section we present instructions to configure PFC on Mellanox ConnectX™
cards. There are multiple configuration steps required, all of which may be performed via Power-
Shell. Therefore, although we present each step individually, you may ultimately choose to write
a PowerShell script to do them all in one step. Note that administrator privileges are required for
these steps.

42 Mellanox Technologies Rev 1.60



Mellanox

TECHNOLOGIES

3.1.4.2.1 Configuring Windows Host

Since PFC is responsible for flow controlling at the granularity of traffic priority, it is
necessary to assign different priorities to different types of network traffic.

As per RoCE configuration, all ND/NDK traffic is assigned to one or more chosen pri-
orities, where PFC is enabled on those priorities.

Configuring Windows host requires configuring QoS. To configure QoS, please follow the pro-
cedure described in Section 3.1.7, “Configuring Quality of Service (QoS)”, on page 59

3.1.4.2.1.1Global Pause (Flow Control)

» To use Global Pause (Flow Control) mode, disable QoS and Priority:

PS $ Disable-NetQosFlowControl
PS $ Disable-NetAdapterQos <interface name>

» To confirm flow control is enabled in adapter parameters:

Device manager-> Network adapters-> Mellanox ConnectX-4/ConnectX-5 Ethernet Adapter->
Properties
->Advanced tab

= Device Manager =
File Action View Help
e @ E Bm 8 E&sd
4 & |-dev-wiT2

I (M Computer

b g Disk drives [ Detsis [ Everts Resources | Power Management |
» Mg Display adapters General Advanced | Information | Peformance | Driver

Mellanox ConnectX-4 VPI Adapter (MT4115) #4 Prop... -

[ UE, Human Interface Devices

3 i |EEE 1384 host controllers

> &= Keyboards

[3 B Mice and other pointing devices

- B Monitors

4 ¥ Network adapters
ﬁ Intel(R) 1350 Gigabit Network Connection
I_-I'F Intel(R) 1330 Gigabit Netwerk Connection #2

¥ Intel(R) 1350 Gigabit Network Connection #3
I‘-I"‘ Intel(R) 1330 Gigabit Network Connection #4
l‘-"‘ Mellanox CennectX-4 VPI Adapter (MT4115) #£3
I‘-'F Mellanox ConnectX-4 VPI Adapter (MT4115) 24
L Microsoft Kernel Debug Network Adapter

4 [f5) Other devices

5

i PCI Memory Controller
b T3 Ports (COM & LPT)
[ @ Print queues
3 D Processors
I 47 Storage controllers
b (M System devices
[ ' Universal Serial Bus controllers

The following properties are available for this network adapter. Click
the property you want to change on the left, and then select its value
on the right.

Property: Value:

IFb(?:Tx Enabled VI

eader Data Splt

ntermupt Moderation

IPV4 Checksum Offload

Jumbo Packet

Large Send Offload V2 {IPwd)
Large Send Offload V2 {IPvE)
Maximum number of RSS Processc
Mapimum MNumber of RSS Queues
Network Address

Metwork Direct Functionality
Prefemed NUMA Node

Priority & Vian Tag .

3.1.4.3 Configuring SwitchX® Based Switch System

» To enable RoCE, the SwitchX should be configured as follows:

* Ports facing the host should be configured as access ports, and either use global pause or

Port Control Protocol (PCP) for priority flow control

Features Overview and Configuration
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» Ports facing the network should be configured as trunk ports, and use Port Control Proto-
col (PCP) for priority flow control

For further information on how to configure SwitchX, please refer to SwitchX User Manual.

3.1.4.4 Configuring Arista Switch

Step 1. Set the ports that face the hosts as trunk.

(config)# interface etl0
(config-if-Et10)# switchport mode trunk

Step 2. Set VID allowed on trunk port to match the host VID.
(config-if-Et10)# switchport trunk allowed vlan 100

Step 3.  Set the ports that face the network as trunk.
(config)# interface et20
(config-if-Et20)# switchport mode trunk

Step 4.  Assign the relevant ports to LAG.

config)# interface etl0

config-i£-Et10)# speed forced 40gfull

(

(config-if-Et10)# dcbx mode ieee

(

(config-if-Et10)# channel-group 11 mode active

Step 5. Enable PFC on ports that face the network.

config)# interface et20

config-if-Et20)# load-interval 5

config-i£-Et20) # speed forced 40gfull
config-i£-Et20) # switchport trunk native vlan tag

config-if-Et20)# switchport mode trunk
config-if-Et20)# dcbx mode ieee

(
(
(
(
(config-if-Et20)# switchport trunk allowed vlan 11
(
(
(config-if-Et20)# priority-flow-control mode on

(

config-i£-Et20) # priority-flow-control priority 3 no-drop

3.1.4.4.1 Using Global Pause (Flow Control)

» To enable Global Pause on ports that face the hosts, perform the following:

(config)# interface etl0
(config-if-Et10)# flowcontrol receive on
(config-if-Et10)# flowcontrol send on

3.1.4.4.2 Using Priority Flow Control (PFC)

» To enable Global Pause on ports that face the hosts, perform the following:

(config)# interface etl0
(config-if-Et10)# dcbx mode ieee
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(config-if-Et10)# priority-flow-control mode on
(config-if-Et10)# priority-flow-control priority 3 no-drop

3.1.4.5 Configuring Router (PFC only)

The router uses L3's DSCP value to mark the egress traffic of L2 PCP. The required mapping,
maps the three most significant bits of the DSCP into the PCP. This is the default behavior, and
no additional configuration is required.

3.1.4.5.1 Copying Port Control Protocol (PCP) between Subnets

The captured PCP option from the Ethernet header of the incoming packet can be used to set the
PCP bits on the outgoing Ethernet header.

3.1.4.6 Configuring the RoCE Mode

Configuring the RoCE mode requires the following:

* RoCE mode is configured per adapter or per driver. If RoCE mode key is set for the
adapter then it will be used. Otherwise, it will be configured by the per-driver key. The
per-driver key is shared between all devices in the system.

port the needed mode, the fallback mode would be the maximum supported RoCE mode of

Q The supported RoCE modes depend on the firmware installed. If the firmware does not sup-
the installed NIC.

RoCE is enabled by default. Configuring or disabling the RoOCE mode can be done via the
registry key.

» To update it for a specific adapter using the registry key, set the roce_mode as follows:

Step 1. Find the registry key index value of the adapter according to Section 3.5.1, “Finding the
Index Value of the Network Interface”, on page 108.

Step 2. Set the roce_mode in the following path:

HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Class\{4d36e972-e325-11ce-bfcl-
08002bel0318}\<IndexValue>

* To update it for all the devices using the registry key, set the roce_mode as follows:
HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\mlx5\Parameters\Roce

Q For changes to take effect, please restart the network adapter after changing this registry key.
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3.1.4.6.1 Registry Key Parameters

The following are per-driver and will apply to all available adapters.
Table 6 - Registry Key Parameters

Parameters Name Partz;r;:ter Description Allowed Values and Default
roce_mode DWORD | Sets the RoCE mode. The following | * RoCE MAC Based =0
are the possible RoCE modes: * RoCEv2=2
* RoCE MAC Based * NoRoCE=4
* RoCE v2 * Default: RoCE v2
* No RoCE

3.1.5 RoCEv2 Congestion Management (RCM)

Q Please note that this feature is at beta level.

Network Congestion occurs when the number of packets being transmitted through the network
approaches the packet handling the capacity of the network. A congested network will suffer
from throughput deterioration manifested by increasing time delays and high latency.

In lossy environments, this leads to a packet loss. In lossless environments, it leads to “victim
flows” (streams of data which are affected by the congestion, caused by other data flows that pass
through the same network).

Example:

The figure below demonstrates a victim flow scenario. In the absence of congestion control, flow
X'Y suffers from reduced bandwidth due to flow F'G, which experiences congestion.

Figure 6: Victim Flow Example

F EDCBA
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To address this, Congestion Control methods and protocols were defined.

This chapter describes (in High-Level), RoOCEv2 Congestion Management (RCM), and provides
a guide on how to configure it in Windows environment.

RoCEv2 Congestion Management (RCM) provides the capability to avoid congestion hot spots
and optimize the throughput of the fabric.

With RCM, congestion in the fabric is reported back to the “sources” of traffic. The sources, in
turn, react by throttling down their injection rates, thus preventing the negative effects of fabric
buffer saturation and increased queuing delays.

For signaling of congestion, RCM relies on the mechanism defined in RFC3168, also known as
DCQCN.

The source node and destination node can be considered as a “closed-loop control” system. Start-
ing from the trigger, when the destination node reflects the congestion alert to the source node,
the source node reacts by decreasing, and later on increasing, the Tx rates according to the feed-
back provided. The source node keeps increasing the Tx rates until the system reaches a steady
state of non-congested flow with traffic as high rate as possible.

The RoCEv2 Congestion Management feature is composed of three points:

* The congestion point (CP) - detects congestion and marks packets using the DCQCN
bits

* The notification point (NP) (receiving end node) - reacts to the DCQCN marked packets
by sending congestion notification packets (CNPs)

* The reaction point (RP) (transmitting end node) - reduces the transmission rate accord-
ing to the received CNPs

These three components can be seen in the High-Level sequence diagram below:

Features Overview and Configuration
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Figure 7: High-Level Sequence Diagram

m

Transmit at 40Gh rate———— ]

Recognizes congestion on this flow, ‘

Applies ECN marking on the packet

Forward the packet Node B——

Recognizes the ECN marking and

prepare CNP packet back to the RP

[——Transmit CNP packet
ti——Forward the packet to Node &

Entire flow above in a loop

.

This flow will continue in a loop until Node A have decreased the Turate to a
point where:
o2 The switch will no longer feel congested and will stop ECN marking on the

traffic going to Node B.
*2 Node B will stop sending CNPs to Node A

For further details, please refer to the IBTA RoCeV2 Spec, Annex A-17.

3.1.5.1 Restrictions and Limitations

» General:

* In order for RCM to function properly, the elements in the communication path must
support and be configured for RCM (nodes) and DCQCN marking (Switches, Routers).

*  ConnectX®-4 and ConnectX®-4 Lx support congestion control only with RoCEv2.

*  RCM does not remove/replace the need for flow control.
In order for RoCEv2 to work properly, flow control must be configured.
It is not recommended to configure RCM without PFC or global pauses.

> Mellanox:
*  SW Versions

¢  Minimal firmware version - 2.30
¢ Minimal driver version - 1.35

* Mellanox switch support starting from “Spectrum”

3.1.5.2 RCM Configuration

RCM configuration to Mellanox adapter is done via MIx5Cmd tool.
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DcqcnRPEnablePriol:
DcqcnRPEnablePrio?2:
DcgcnRPEnablePrio3:
DcqcnRPEnablePriod:
DcgcnRPEnablePrio):
DcgcnRPEnablePrio6:
DcqcnRPEnablePrio7:

DcqgcenClampTgtRate: 0

0

O O O O o o

In the output example below, RCM is disabled:

DcqgcenClampTgtRateAfterTimeInc: 1
DcgcnRpgTimeReset: 100
DcgcnRpgByteReset: 400

DcgcnRpgThreshold: 5

DcgcnRpgAiRate: 10

DcgcnRpgHaiRate: 100

DcqgcnAlphaToRateShift: 11
DcgcnRpgMinDecFac: 50

DcgcnRpgMinRate: 1

DcgcnRateToSetOnFirstCnp: 3000

DcgcnDeeTcpG: 32
DcqgcnDceTcpRtt: 4

DcgcnRateReduceMonitorPeriod: 32
DcgenInitialAlphaValue: 0

DcgcnNPEnablePrio0:
DcgcnNPEnablePriol:
DcgcnNPEnablePrio2:
DcgcnNPEnablePrio3:
DcgcnNPEnablePriod:
DcgcnNPEnablePriob:
DcgcnNPEnablePrio6:
DcgcnNPEnablePrio7:
DcgenCnpDscp: 0

DcgenCnp802pPrio: 7
DcgenCnpPrioMode: 1

0

O O O O o o o

DCQCN NP attributes for adapter "Ethernet":

The command was executed successfully

Features Overview and Configuration

In order to view the current status of RCM on the adapter, run the following command:

M1x5Cmd.exe -Qosconfig -Dcgcn -Name <Network Adapter Name> -Get

PS C:\Users\admin\Desktop>M1x5Cmd.exe -Qosconfig -Dcqcn -Name "Ethernet" -Get
DCQCN RP attributes for adapter "EthernetcnRPEnablePrio(: 0

In order to enable/disable DCQCN on the adapter, run the following command:
M1x5Cmd.exe -Qosconfig -Dcgcn -Name <Network Adapter Name> -Enable/Disable
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This can be used on all priorities or on a specific priority:

PS C:\Users\admin\Desktop>M1x5Cmd.exe -Qosconfig -Dcqcn -Name "Ethernet" -Enable

PS C:\Users\admin\Desktop>M1x5Cmd.exe -Qosconfig -Dcqcn -Name "Ethernet" -Get

DCQCN RP attributes for adapter "Ethernet":
DcgcnRPEnablePrio0: 1
DcgcnRPEnablePriol:
DcgcnRPEnablePrio?:
DcgcnRPEnablePrio3:
DcgcnRPEnablePriod:
DcgcnRPEnablePrio):
DcgcnRPEnablePrio6:
DcgcnRPEnablePrio’:
DcqgcenClampTgtRate: 0
DcqgcenClampTgtRateAfterTimeInc: 1
DcgcnRpgTimeReset: 100
DcgcnRpgByteReset: 400
DcgcnRpgThreshold: 5
DcgcnRpgAiRate: 10
DcgcnRpgHaiRate: 100
DcgcnAlphaToRateShift: 11
DcgcnRpgMinDecFac: 50
DcgcnRpgMinRate: 1
DcgcnRateToSetOnFirstCnp: 3000
DcgcnDeeTcpG: 32
DcqgcnDceTcpRtt: 4
DcgcnRateReduceMonitorPeriod: 32
DcgenInitialAlphaValue: 0

= b b b e

DCQCN NP attributes for adapter "Ethernet":
DcgcnNPEnablePrio0: 1
DcqcnNPEnablePriol:
DcqcnNPEnablePrio?2:
DcgcnNPEnablePrio3:
DcqcnNPEnablePriod:
DcgcnNPEnablePriob:
DcgcnNPEnablePrio6:
DcqcnNPEnablePrio7:
DcgenCnpDscp: 0
DcgenCnp802pPrio: 7
DcgenCnpPrioMode: 1

The command was executed successfully

= b b b e

3.1.5.3 RCM Parameters

The table below lists the parameters that can be configured, their description and allowed values.
Table 7 - RCM Parameters

Parameter (Type) Default Value Allowed Values

DcgcenEnablePrio0 (BOOLEAN) True 0/1
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Table 7 - RCM Parameters

Parameter (Type) Default Value Allowed Values

DcqgcnEnablePriol (BOOLEAN) True 0/1
DcqgcnEnablePrio2 (BOOLEAN) True 0/1
DcgcenEnablePrio3 (BOOLEAN) True 0/1
DcqcnEnablePrio4 (BOOLEAN) True 0/1

DcqcnEnablePrio5 (BOOLEAN) True 0/1
DcqcenEnablePrio6 (BOOLEAN) True 0/1
DcqgcnEnablePrio7 (BOOLEAN) True 0/1
DcgenClampTgtRate (1 bit) 0 0/1
DcgenClampTgtRateAfterTimelnc (1 bit) 1 0/1

DcgenCnpDscp (6 bits) 0 0-7
DcqenCnp802pPrio (3 bits) 7 0-7
DcqenCnpPrioMode(1 bit) 1 0/1
DcqenRpgTimeReset (uint32) 600 0- 131071 [uSec]
DcqcenRpgByteReset (uint32) 32767 0-32767 [64 bytes]
DcqenRpgThreshold (uint32) 5 1-31
DcqenRpgAiRate (uint32) 5 1 - line rate [Mbit/sec]
DcgenRpgHaiRate (uint32) 50 1 - line rate [Mbit/sec]
DcqcenAlphaToRateShift (uint32) 11 0-11
DcgenRpgMinDecFac (uint32) 50 0-100
DcqcenRpgMinRate (uint32) 1 0 - line rate
DcqcenRateToSetOnFirstCnp (uint32) 100 0 - line rate [Mbit/sec]
DcgenDceTepG (uint32) 4 0 - 1023 (fixed point fraction
DcqenDceeTepRtt (uint32) 1 0-131071 [uSec]
DcqcnRateReduceMonitorPeriod (uint32) 4 0 - UINT32 [uSec]
Dcqcnlnitial AlphaValue (uint32) 0 0- 1023 (fixed point fraction

3.1.5.3.1 RCM Default Parameters

Every parameter has a default value assigned to it. The default value was set for optimal conges-
tion control by Mellanox. In order to view the default parameters on the adapter, run the follow-
ing command:

M1x5Cmd.exe -Qosconfig -Dcgcn -Name <Network Adapter Name> -Defaults

3.1.5.3.2 RCM with Untagged Traffic

Congestion control for untagged traffic is configured with the port default priority that is used for
untagged frames.
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The port default priority configuration is done via MIx5Cmd tool.

Table 8 - Default Priority Parameters

Parameter (Type) Default Value Allowed Values

DefaultUntaggedPriority 0 0-7

* In order to view the current default priority on the adapter, run the following command:
M1x5Cmd.exe -QoSConfig -DefaultUntaggedPriority -Name -Get
* In order to set the default priority to a specific priority on the adapter, run the following
command:

M1x5Cmd.exe -QoSConfig -DefaultUntaggedPriority -Name -Set

3.1.5.4 How Changing the Parameters Affect Congestion Control Behavior

Please make sure you fully understand the parameter usage, value and expected results before

0 Changing the values of the parameters may strongly affect the congestion control efficiency.
changing its default value.

3.1.5.4.1 CNP Priority
» fCnpDscp

This parameter changes the priority value on IP level that can be set for CNPs.
» DcqcnCnpPrioMode

If this parameter is set to '0', then use DcgcnCnp802pPrio as the priority value (802.1p) on the
Ethernet header of generated CNPs. Otherwise, the priority value of CNPs will be taken from
received packets that were marked as DCQCN packets.

» DcqenCnp802pPrio

This parameter changes the priority value (802.1p) on the Ethernet header of generated CNPs.
Set DcgenCnpPrioMode to '0' in order to use this priority value

3.1.5.4.2 alpha -”a” = Rate Reduction Factor
The device maintains an “alpha” value per QP. This alpha value estimates the current congestion
severity in the fabric.
» DcqcnlnitialAlphaValue

This parameter sets the initial value of alpha that should be used when receiving the first CNP
for a flow (expressed in a fixed point fraction of 2*10).

The value of alpha is updated once every DcqecnDceTepRtt, regardless of the reception of a
CNP. If a CNP is received during this time frame, alpha value will increase. If no CNP recep-
tion happens, alpha value will decrease.

» DcqcnDceTcpG and DceqenDceTcpRit
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These two parameters maintain alpha.

» Ifa CNPis received on the RP - alpha is increased:
(1-DcgcnDecTcpG) *a + DcgcnDecTcpG

e If no CNP is received for a duration of DcgcnDeceTcpRtt microseconds, alpha is
decreased:
(1- DcgcnDecTcpG) * alpha

3.1.5.4.3 Decrease (on the “RP”)
Changing the DcgcnRateToSetOnFirstCnp parameter determines the current rate (cr) that will
be set once the first CNP is received.

The rate is updated only once every DcqcnRateReduceMonitorPeriod microseconds (multiple
CNPs received during this time frame will not affect the rate) by using the following two formu-
las:

* Crlpew) = (1- (o /(2"DeqenAlphaToRateShift)) )*Crg1q)
* Cr2(pew) = Cro1gyDeqenRpgMinDecFac

The maximal reduced rate will be chosen from these two formulas.

The target rate will be updated to the previous current rate according to Section 3.1.5.4.4,
“Increase (on the “RP”)” below.

» DcgcnRpgMinDecFac

This parameter defines the maximal ratio of decrease in a single step (Denominator: !zero.
Please see formula above).

» DcqcnAlphaToRateShift
This parameter defines the decrement rate for a given alpha (see formula above)
» DcqcnRpgMinRate

In addition to the bcgenRpgMinDecFac, the DegenRpgMinRate parameter defines the minimal
rate value for the entire single flow.

Note: Setting it to a line rate will disable the congestion control.

3.1.5.4.4 Increase (on the “RP”)

RP increases its sending rate using a timer and a byte counter. The byte counter increases rate for
every DcgcnRpgByteResetx64 bytes (mark it as B), while the timer increases rate every dDcgen-
RpgTimeReset time units (mark it as T). Every successful increase due to bytes transmitted/time
passing is counted in a variable called rpByteStage and rpTimeStage (respectively).

The DcgenRpgThreshold parameter defines the number of successive increase iteration (mark it
as Th).

The increase flow is divided into 3 types of phases, which are actually states in the “RP Rate
Control State Machine”.

The transition between the steps is decided according to bcgenRpgThreshold parameter.
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» Fast Recovery
If MAX (rpByteStage, rpTimeStage) < Th.

* No change to Tr

* Additive Increase
If MAX (rpByteStage, rpTimeStage) > Th. && MIN (rpByteStage, rpTimeStage) < Th.

* DcgcnRpgAiRate value is used to increase Tr

* Hyper Additive Increase
If MAX (rpByteStage, rpTimeStage) > Th. && MIN (rpByteStage, rpTimeStage) > Th.

* DcqcnRpgHaiRate value is used to increase Tr

For further details, please refer to 802.1Qau standard, sections 32.11-32.15.
» DcqcnClampTgtRateAfter Timelnc

When receiving a CNP, the target rate should be updated if the transmission rate was increased
due to the timer, and not only due to the byte counter.

» DcgcenClampTgtRate

If set, whenever a CNP is processed, the target rate is updated to be the current rate.

3.1.5.5 Mellanox Commands and Examples
For a full description of Congestion Control commands please refer to Mellanox WinOF-2 User
Manual section MIxCmd Utilities.
1. Set a value for one or more parameters:

Mix5Cmd.exe -Qosconfig -Dcqen -Name <Network Adapter Name> -Set -Argl <value> -
Arg2 <value>

Example:

PS C:\Users\admin\Desktop>M1x5Cmd.exe -Qosconfig -Dcqgen -Name "Ethernet" -Set -DcqenClampTg-
tRate 1 -DcgenCnpDscp 3

2. Enable/Disable DCQCN for a specific priority:
MIx5Cmd.exe -Qosconfig -Dcqen -Name <Network Adapter Name> -Enable <prio>
Example:
PS C:\Users\admin\Desktop>M1x5Cmd.exe -Qosconfig -Dcgcn -Name "Ethernet" -Enable/Disable 3
3. Enable/Disable DCQCN for all priorities:
MIx5Cmd.exe -Qosconfig -Dcqen -Name <Network Adapter Name> -Enable
Example:
PS C:\Users\admin\Desktop>M1x5Cmd.exe -Qosconfig -Dcqgcn -Name "Ethernet" -Enable/Disable
4. Set port default priority for a specific priority:
MIx5Cmd.exe -DefaultUntaggedPriority -Name <Network Adapter Name> -Set <prio>
Example:
PS C:\Users\admin\Desktop>M1x5Cmd.exe -DefaultUntaggedPriority -Name "Ethernet" -Set 3
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5. Restore the default settings of DCQCN the are defined by Mellanox:
MIx5Cmd.exe -Dcqen -Name <Network Adapter Name> -Restore
Example:

PS C:\Users\admin\Desktop>M1x5Cmd.exe -Dcgcn -Name "Ethernet" -Restore

For information on the RCM counters, please refer to Section 3.6.4.1.5, “Mellanox WinOF-2
Congestion Control Counters”, on page 131.

3.1.6 Teaming and VLAN

Windows Server 2012 and above supports Teaming as part of the operating system. Please refer
to Microsoft guide “NIC Teaming in Windows Server 2012” following the link below:

http://www.microsoft.com/en-us/download/confirmation.aspx?id=40319

For other earlier operating systems, please refer to the sections below. Note that the Microsoft
teaming mechanism is only available on Windows Server distributions.

3.1.6.1 Creating a Port VLAN in Windows Server 2008 R2

You can create a Port VLAN either on a physical Mellanox ConnectX® EN adapter or a virtual
team. The following steps describe how to create a port VLAN.
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Step 1.  Display the Device Manager.

vice Manager

File Action View Help

&9 T HD B

[+ & Computer

¥ u Disk drives

ER % Display adapters

[ DYDICD-ROM drives

= Floppy drive controllers

3] U,,, Human Interface Devices

[#-1_gg IDE ATA/ATAPI controllers

# IEEE 1394 Bus host controllers

[#-ZZ Keyboards

[# ﬂ MMice and other pointing devices

- B Monitors

(=~ B¥ Network adapters
%% Broadcom BCMS706C Metwtreme II GigE (NDIS YBD Client)
%% Broadcom BCMS708C Metxtreme 11 GigE (NDIS YBD Client) #2

B l-"‘ Mellanox Connect} 10Gh Ethernet Adapter ‘,--f"
l" Mellanox Connectx 10Gh Ethernet Adapter #2
l" Mellanoe Yirtual Miniport Driver - Team & "—________
=i Othar devices
[ Base System Device
#-75" Ports (COM & LPT)
) é Processors
(-4 Storage controllers
-4 System devices
# ‘ Urirversal Serial Bus controllers

e t" Mellanox Connect (MT25418) - DDR Channel Adapter ———

M=l
Physical
ﬁf Adapters
—— Virtual Bundle
(Team)
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Step 2. Right-click a Mellanox network adapter (under “Network adapters” list) and left-click Prop-
erties. Select the VLAN tab from the Properties sheet.

Physical Adapter Virtual Bundle (Team)
Mellanox ConnectX 10Gh Ethernet Adapter Properties HE {Mellanox Virtual Miniport Driver - Team A Properties HER
‘ LBFO | Diiver | Details | General VLAN IUHVSI | Detais |
General | Infomation | Advanced | Pefomance  VLAN
Wirtual Lans
Virtual Lans Mellanox
Mellanox
WLANs associated with this adapter
WLANs associated with this adaptes YLAN Name | D l Pricrity I Status |
WLAN Name [ip [ Prigty [ Stalus |
New.. EMmayE Modify |
New... Hemove I odify.. |

This dialog allows you to configure Virual LANS (VLANS) for the &
This dialog allows you to configure Vidual LANS (VLANz) for the & atlapter
adapter.

HOTE: After configuring a YLAN, the adapter associated with the
HOTE: After configuring a WLAN, the adapter associated with the WLAN may experience a momentary [0ss of connectivity.
WLAN may experience a momentary loss of connectivity.

The list view has four columns:
The list views has four columns: VLANHame:  Displays the assigned YLAN name. j
VLAH Hame: Displays the assigned VLAM name ;I

Cace
0K | Comed | b |

If a physical adapter has been added to a team, the VLAN tab will not be
displayed.

Step 3. Click New to open a VLAN dialog window. Enter the desired VLAN Name and VLAN ID,
and select the VLAN Priority.

MLNX_EN YLAN B

WLAM Mame: |1

WLAN ID: |1D1

VLAN Piiiy. |2 =

[his dislog allows you to enter or modify the following VLAN

properies:

VLAH Hame:  The name can be any unigue alphanumeric string.
VLAH ID: The ID i= & number bebvween 1 and 4095,

VLAH Priority:  The priority is & number between 0 and 7 (0-
lowest, 7- highest).

HOTE: After cresting & neww YLAN, the adapter azzocisted with the
YLAN may expetisnce & momentary 055 of connectivity.

oK ] Cancel |
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After installing the first virtual adapter (VLAN) on a specific port, the port becomes dis-
abled. This means that it is not possible to bind to this port until all the virtual adapters
associated with it are removed.

When using a VLAN, the network address is configured using the VLAN ID. There-
fore, the VLAN ID on both ends of the connection must be the same.

Step 4.  Verify the new VLAN(s) by opening the Device Manager window or the Network Connec-
tions window. The newly created VLAN will be displayed in the following format.

Mellanox Virtual Miniport Driver - VLAN <name>

1] a
g2 Device Manager

File Action Wiew Help

¢ |HEE=

=g -supp-10

-8 Computer

Hea Disk, drives

7B} Display adapters

= DVDJCD-ROM drives

JTJ Human Interface Devices

g IDE ATAMATAPT controllers

2 Kevboards

E!, Mice and other painting devices

- Bl Maritors

: - Y Network adapters

- &¥ HP NC36Zi Integrated DP Gigabit Server Adapter
¥ HR NC362i Inkeqrated DP Gigabit Server Adapher #2
Mellanox Connectx-3 Ethernet Adapter

Mellanox Connectk-3 IPolB Adapter #2

L G firkual Miniport Driver - YLAMN Mew_Production_WLAMN
= [f5 Other devices

{7y Unknown device

]& Prarts (COM & LPT)

ALEE:

et

Lal o=

[
-4} Processors

-4 Shorage controllers

(- M System devices

[+~ | Universal Serial Bus contrallers

3.1.6.2 Removing a Port VLAN in Windows Server 2008 R2

» To remove a port VLAN, perform the following steps:

Step 1.  In the Device Manager window, right-click the network adapter from which the port VLAN
was created.

Step 2.  Left-click Properties.
Step 3.  Select the VLAN tab from the Properties sheet.
Step 4. Select the VLAN to be removed.
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Step 5. Click Remove and confirm the operation.

3.1.6.3 Configuring a Network Interface to Work with VLAN in Windows Server 2012 and Above

In this procedure you DO NOT create a VLAN, rather use an existing VLAN ID.

» To configure a port to work with VLAN using the Device Manager.

Step 1.  Open the Device Manager.

Step 2.  Go to the Network adapters.

Step 3.  Go to the properties of Mellanox ConnectX®-4 Ethernet Adapter card.
Step 4. Go to the Advanced tab.

Step 5. Choose the VLAN ID in the Property window.

Step 6.  Set its value in the Value window.

E= Device Manager ] x
File Action View Help
€= =p = H i

4 g5 -dev-wiT2 Mellanox ConnectX-4 VPI Adapter (MT4115) #4 Prop... -
- &8 Computer

7
#
@

I Disk drives | Detmils |  Everts | Resources |  Power Mamagemert |
b B Display adapters General Advenced | information |  Pedformance | Driver
b U5 Human Interface Devices The following properties are available for this networkc adapter. Click
- & IEEE 1384 host contrellers the property you want to change on the left. and then select its value
b == Keyboards on the right
B ¥ Mice and other pointing devices Property Value:
- Bl Monitors Receive Side Scaling P o =
4 & Metwork adapters RSS Base Processor Number =
&% Intel(R) 1250 Gigabit Metwork Connection E’gg hﬂ;fmiﬂa;ggiszg‘ﬁumher
& Intel(R) 1350 Gigabit Metwork Connection #2 Fix Interrupt Moderation Profile
&F Intel(R) 1350 Gigabit Network Connection #3 Rx Interrupt Moderation Type
¥ Intel(R) 1350 Gigabit Metwork Connection 24 g?{%s’,""em
&¥ Mellanox ConnectX-4 VPI Adapter (MT4113) 23 TCP/UDP Checksum Offload (1P
=¥ Mellanox ConnectX-4 VP| Adapter (MT4115) 24 TCP/UDP Checksum Offload (IPw|

T Intemupt Moderation Profils =
Virtual Machine Queues

5 Microsoft Kernel Debug Metwork Adapter
[ Other devices
[ PCI Memory Contraller VMQ VLAN Fitering e
T Ports (COM & LPT)
=i Print queues
X Processors
<& Storage controllers
/88 System devices
- @ Universal Serial Bus controllers

b

TTVVW

3.1.7 Configuring Quality of Service (QoS)

3.1.7.1 QoS Configuration

Prior to configuring Quality of Service, you must install Data Center Bridging using one of the
following methods:

» To Disable Flow Control Configuration
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Device manager->Network adapters->Mellanox ConnectX-4/ConnectX-5 Ethernet Adapter-

>Properties->Advanced tab

=8
File Action View Help

= B EHm e R&sds

Device Manager = | =] 2

4 g |-dev-wl72
| /% Computer
b g Disk drives
I W Display adapters
3 E’ﬁ Human Interface Devices
3 @ |EEE 1394 host controllers
| == Keyboards
I B Mice and other pointing devices
- B Monitors
4 &Y Network adapters
ﬁ_ Intel(R) 1350 Gigabit Metwork Connection
l‘-"‘ Intel(R) 1350 Gigabit Metwork Connection £2
l‘-"‘ Intel(R) 1350 Gigabit Metwork Connection #3
& Intel(R) 1350 Gigabit Network Connection #4
I‘-'F Mellanox ConnectX-4 VPl Adapter (MT4113]) #3
I‘-'F Mellanox ConnectX-4 VPl Adapter (MT4115) 24
¥ Microsoft Kernel Debug Network Adapter
4 |[5 Other devices

5

i PCI Memaory Controller
b Y3 Ports (COM & LPT)
3 m Print queues
3 D Processors
I <& Storage controllers
[ (M System devices
3 a Universal Serial Bus controllers

Mellanox ConnectX-4 VPI Adapter (MT4115) #4 Prop... -

| Details | Events Resources I Power Management |
| Genera | Advanced | Informaion | Pefomance | Driver

The following properties are available for this network adapter. Click
the property you want to change on the left, and then select its value
on the right

Property: Walue

~

ler Data opl
Interrupt Moderation
IPV4 Checksum Offload
Jumbo Packet
Large Send Offload W2 (IPv4)
Large Send Offload W2 (IPv6)
Maxdmum number of RSS Processc
Mzodmum Mumber of RSS Queues
Network Address
Network Direct Functionality
Prefemed NUMA Node
Priority & Vlan Tag b

» To install the Data Center Bridging using the Server Manager:

Step 1. Open the 'Server Manager'.

Step 2.  Select 'Add Roles and Features'.

Step 3.  Click Next.

Step 4.  Select 'Features' on the left panel.
Step 5. Check the 'Data Center Bridging' checkbox.

Step 6.  Click 'Install'.

» To install the Data Center Bridging using PowerShell:

Step 1.  Enable Data Center Bridging (DCB).
PS $ Install-WindowsFeature Data-Center-Bridging

» To configure QoS on the host:

The procedure below is not saved after you reboot your system. Hence, we recom-
mend you create a script using the steps below and run it on the startup of the local
machine.

Please see the procedure below on how to add the script to the local machine startup
scripts.

Step 1.  Change the Windows PowerShell execution policy:
PS $ Set-ExecutionPolicy AllSigned
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Step 2. Remove the entire previous QoS configuration:
PS $ Remove-NetQosTrafficClass
PS $ Remove-NetQosPolicy -Confirm:S$False
Step 3. Set the DCBX Willing parameter to false as Mellanox drivers do not support this feature.
PS $ set-NetQosDcbxSetting -Willing 0
Step 4. Create a Quality of Service (QoS) policy and tag each type of traffic with the relevant prior-
ity.
In this example, TCP/UDP use priority 1, SMB over TCP use priority 3.

PS $ New-NetQosPolicy "DEFAULT" -store Activestore -Default -PriorityValue8021Action 3
PS $ New-NetQosPolicy "TCP" -store Activestore -IPProtocolMatchCondition TCP -Priority-
Value8021Action 1
PS $ New-NetQosPolicy "UDP" -store Activestore -IPProtocolMatchCondition UDP -Priority-
Value8021Action 1
New-NetQosPolicy “SMB” -SMB -PriorityValue8021Action 3

Step 5. Create a QoS policy for SMB over SMB Direct traffic on Network Direct port 445.

PS $ New-NetQosPolicy "SMBDirect" -store Activestore -NetDirectPortMatchCondition 445 -
PriorityValue8021Action 3

Step 6. [Optional] If VLANSs are used, mark the egress traffic with the relevant VlanID.
The NIC is referred as "Ethernet 4” in the examples below.

PS $ Set-NetAdapterAdvancedProperty -Name "Ethernet 4" -RegistryKeyword "V1anID" -Reg-
istryValue "55"

Step 7. [Optional] Configure the IP address for the NIC.
If DHCP is used, the IP address will be assigned automatically.

PS S Set-NetIPInterface -InterfaceAlias “Ethernet 4” -DHCP Disabled

PS $ Remove-NetIPAddress -InterfaceAlias “Ethernet 4” -AddressFamily IPv4 -Con-
firm:$false

PS $ New-NetIPAddress -InterfaceAlias “Ethernet 4” -IPAddress 192.168.1.10 -Prefix-
Length 24 -Type Unicast

Step 8. [Optional] Set the DNS server (assuming its IP address is 192.168.1.2).

PS $ Set-DnsClientServerAddress -InterfaceAlias “Ethernet 4” -ServerAddresses
192.168.1.2

After establishing the priorities of ND/NDK traffic, the priorities must have PFC
enabled on them.

Step 9. Disable Priority Flow Control (PFC) for all other priorities except for 3.
PS $ Disable-NetQosFlowControl 0,1,2,4,5,6,7

Step 10. Enable QoS on the relevant interface.
PS $ Enable-NetAdapterQos -InterfaceAlias "Ethernet 4"
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Step 11. Enable PFC on priority 3.
PS $ Enable-NetQosFlowControl -Priority 3

» To add the script to the local machine startup scripts:

Step 1.  From the PowerShell invoke.
gpedit.msc
Step 2.  In the pop-up window, under the 'Computer Configuration' section, perform the following:

1. Select Windows Settings

2. Select Scripts (Startup/Shutdown)

3. Double click Startup to open the Startup Properties
4. Move to “PowerShell Scripts” tab

=f Local Group Policy Editor =|18] *
File Action View Help
s HE B B
=] Local Computer Po!\:y ] = Scripts (Startup/Shutdown) : =
4 (% Computer Configuration N Startup Properties -
- : Startup ame -
I [ Software Settings =E
. [] Windows Settings 2 Scriptsl PowerShell Scripts IQ
— i 1 Display Properties = Shutdown o
b [7] Mame Resolution Polic = -
= Seripts (Startup/Shutdown) Description: u Windows PowerShell Startup Scripts for Local Computer
[ ecurity Settings Contzins computer startup scripts,
b gliy Policy-based QoS
p (] Administrative Templates MName Parameters Up
a 4%, User Configuration C:\Program Files\PFC\P...

3

3
I

“ Software Settings
= Windows Settings

| Administrative Templates
Forthis GPO, run scripts in the following order:
| Mot configured ~ |

{1 ) PowerShell scripts require at least Windows 7 or Windows Server
2008 R2

5. Click Add
The script should include only the following commands:

PS $ Remove-NetQosTrafficClass
PS $ Remove-NetQosPolicy -Confirm:S$False
PS $ set-NetQosDcbxSetting -Willing 0

PS $ New-NetQosPolicy "SMB" -Policystore Activestore -NetDirectPortMatchCondition
445 -PriorityValue8021Action 3

PS $ New-NetQosPolicy "DEFAULT" -Policystore Activestore -Default -PriorityVal-
ue8021Action 3

PS $ New-NetQosPolicy "TCP" -Policystore Activestore -IPProtocolMatchCondition TCP
-PriorityValue8021Action 1

PS $ New-NetQosPolicy "UDP" -Policystore Activestore -IPProtocolMatchCondition UDP
-PriorityValue8021Action 1

PS $ Disable-NetQosFlowControl 0,1,2,4,5,6,7

PS $ Enable-NetAdapterQos -InterfaceAlias "portl"
PS $ Enable-NetAdapterQos -InterfaceAlias "port2"
PS $ Enable-NetQosFlowControl -Priority 3
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3.1.7.2

3.1.8

3.1.8.1

3.1.8.2

PS $ New-NetQosTrafficClass -name "SMB class" -priority 3 -bandwidthPercentage 50 -
Algorithm ETS

6. Browse for the script's location.
7. Click OK
8. To confirm the settings applied after boot run:

PS $ get-netqospolicy -policystore activestore

Enhanced Transmission Selection

Enhanced Transmission Selection (ETS) provides a common management framework for assign-
ment of bandwidth to frame priorities as described in the IEEE 802.1Qaz specification:
http://www.ieee802.org/1/files/public/docs2008/az-wadekar-ets-proposal-0608-v1.01.pdf

For further details on configuring ETS on Windows™ Server, please refer to:

http://technet.microsoft.com/en-us/library/hh967440.aspx

Differentiated Services Code Point (DSCP)

DSCP is a mechanism used for classifying network traffic on IP networks. It uses the 6-bit Dif-
ferentiated Services Field (DS or DSCP field) in the IP header for packet classification purposes.
Using Layer 3 classification enables you to maintain the same classification semantics beyond
local network, across routers.

Every transmitted packet holds the information allowing network devices to map the packet to
the appropriate 802.1Qbb CoS. For DSCP based PFC or ETS the packet is marked with a DSCP
value in the Differentiated Services (DS) field of the IP header.

System Requirements

* Operating Systems: Windows Server 2008 R2, Windows Server 2012, Windows Server
2012 R2 and

* Firmware version: 12/14/16.18.1000 or higher

Setting the DSCP in the IP Header

Marking DSCP value in the IP header is done differently for IP packets constructed by the NIC
(e.g. RDMA traffic) and for packets constructed by the IP stack (e.g. TCP traffic).
* For IP packets generated by the IP stack, the DSCP value is provided by the IP stack.
The NIC does not validate the match between DSCP and Class of Service (CoS) values.
CoS and DSCP values are expected to be set through standard tools, such as PowerShell
command New-NetQosPolicy using PriorityValue8021Action and DSCPAction flags
respectively.

* For IP packets generated by the NIC (RDMA), the DSCP value is generated according to
the CoS value programmed for the interface. CoS value is set through standard tools,
such as PowerShell command New-NetQosPolicy using PriorityValue8021Action flag.
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The NIC uses a mapping table between the CoS value and the DSCP value configured
through the RroceDscpMarkPriorityFlow- Control[0-7] Registry keys

3.1.8.3 Configuring Quality of Service for TCP and RDMA Traffic
Step 1. Verify that DCB is installed and enabled (is not installed by default).

PS $ Install-WindowsFeature Data-Center-Bridging
Step 2.  Import the PowerShell modules that are required to configure DCB.

PS $ import-module NetQos
PS $ import-module DcbQos
PS $ import-module NetAdapter

Step 3. Configure DCB.
PS § Set-NetQosDcbxSetting -Willing 0

Step 4. Enable Network Adapter QoS.
PS $ Set-NetAdapterQos -Name "CX4 P1" -Enabled 1

Step 5. Enable Priority Flow Control (PFC) on the specific priority 3,5.
PS $ Enable-NetQosFlowControl 3,5

3.1.8.4 Configuring DSCP to Control PFC for TCP Traffic

* Create a QoS policy to tag All TCP/UDP traffic with CoS value 3 and DSCP value 9.
PS $§ New-NetQosPolicy "DEFAULT" -Default -PriorityValue802l1Action 3 -DSCPAction 9

DSCP can also be configured per protocol.

PS $ New-NetQosPolicy "TCP" -IPProtocolMatchCondition TCP -PriorityValue8021Action 3 -

DSCPAction 16
PS $ New-NetQosPolicy "UDP" -IPProtocolMatchCondition UDP -PriorityValue8021Action 3 -

DSCPAction 32

3.1.8.5 Configuring DSCP to Control ETS for TCP Traffic

* Create a QoS policy to tag All TCP/UDP traffic with CoS value 0 and DSCP value 8.
PS $ New-NetQosPolicy "DEFAULT" -Default -PriorityValue8021Action 0 -DSCPAction 8 -Pol-
icyStore activestore

* Configure DSCP with value 16 for TCP/IP connections with a range of ports.

PS $ New-NetQosPolicy "TCP1" -DSCPAction 16 -IPDstPortStartMatchCondition 31000 -IPDst-
PortEndMatchCondition 31999 -IPProtocol TCP -PriorityValue8021Action 0 -PolicyStore
activestore

* Configure DSCP with value 24 for TCP/IP connections with another range of ports.

PS $ New-NetQosPolicy "TCP2" -DSCPAction 24 -IPDstPortStartMatchCondition 21000 -IPDst-
PortEndMatchCondition 31999 -IPProtocol TCP -PriorityValue8021Action 0 -PolicyStore
activestore
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» Configure two Traffic Classes with bandwidths of 16% and 80%.
PS $ New-NetQosTrafficClass -name "TCP1" -priority 3 -bandwidthPercentage 16 -Algorithm

ETS

PS $ New-NetQosTrafficClass -name "TCP2" -priority 5 -bandwidthPercentage 80 -Algorithm

ETS

3.1.8.6 Configuring DSCP to Control PFC for RDMA Traffic

* Create a QoS policy to tag the ND traffic for port 10000 with CoS value 3.
PS $§ New-NetQosPolicy "ND10000" -NetDirectPortMatchCondition 10000 - PriorityVal-

ue8021Action 3

Related Commands:

* Get-NetAdapterQos - Gets the QoS properties of the network adapter

* Get-NetQosPolicy - Retrieves network QoS policies

*  Get-NetQosFlowControl - Gets QoS status per priority

3.1.8.7 Registry Settings

The following attributes must be set manually and will be added to the miniport registry.

For more information on configuring registry keys, see 3.5 “Configuration Using Registry

Keys,” on page 108.
Table 9 - DSCP Registry Keys Settings

Registry Key Description

TxUntagPriorityTag

If 0x1, do not add 802.1Q tag to transmitted packets
which are assigned 802.1p priority, but are not assigned
anon-zero VLAN ID (i.e. priority-tagged).

Default 0x0, for DSCP based PFC set to 0x1.

RxUntaggedMapToLossless

If 0x1, all untagged traffic is mapped to the lossless
receive queue.
Default 0x0, for DSCP based PFC set to 0x1.

PriorityToDscpMappingTable <ID>

A value to mark DSCP for RoCE packets assigned to
CoS=ID, when priority flow control is enabled. The
valid values range is from 0 to 63,

Default is ID value, e.g. PriorityToDscpMapping-
Table 3 is 3.

ID values range from 0 to 7.

DscpBasedEtsEnabled

If 0x1 - all Dscp based ETS feature is enabled, if 0x0 -
disabled. Default 0x0.

DscpForGlobalFlowControl

Default DSCP value for flow control. Default Ox1a.
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For changes to take affect, please restart the network adapter after changing any of the
above registry keys.

3.1.8.7.1 Default Settings

When DSCP configuration registry keys are missing in the miniport registry, the following
defaults are assigned:
Table 10 - DSCP Default Registry Keys Settings

Registry Key Default Value

TxUntagPriorityTag
RxUntaggedMapToLossles
PriorityToDscpMappingTable 0

PriorityToDscpMappingTable 1
PriorityToDscpMappingTable 2
PriorityToDscpMappingTable 3
PriorityToDscpMappingTable 4
PriorityToDscpMappingTable 5
PriorityToDscpMappingTable 6
PriorityToDscpMappingTable 7
DscpBasedEtsEnabled eth:0
DscpForGlobalFlowControl 26

N N | WD~ OO O
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3.1.8.8 DSCP Sanity Testing

To verify that all QoS and DSCP settings are correct, you can capture the incoming and outgoing
traffic by using the mlx5cmd sniffer tool. The tool allows you to see the DSCP value in the cap-

tured packets, as displayed in the figure below.

File

ibdump.pcap [Wireshark 1.8.6 (SUN Rev 48
Edit Mew Go Capture Analyze  Statistics Telephunz Tools  Irternals  Help

Fadea EEXSE LesDTF R Eiﬁ Qe @aEB % 8

Filter:

Mo,

8 Fr

Expression.. Clear Apphy  Zave

Jlme  Soure Destination Rratacol Jlength o
80.042502 11.7.33.148 11.7.33.149 uop 1086 Source port: 119153 pestination port: axpl
G 0.042502 11.7.33.148 11.7.335.149 uop 1086 Source port: 40153 pestination port: axpl
10 0.043752  11.7.32.148 11.7.35.149 uop 1086 Source port: 48153 pestination port: expl
11 0.043752 11.7.33.148 JESFE3RE4g uop 1086 Source gort: 49153 Destination port: expl
12 0.043752 11.7.33.148 11.7.33.149 uop 1086 Source gort: 40153 pestination port: expl

ame 9: 10686 bytes on wire (BG68 hits), 1086 bytes capt

% Ethernst II, Src Mellanox_e9:57:11 (0D:02:¢9:e9:57:11), Dst: Meﬂanux_e9:56:4]_ (00:02:c9:e0:56:41)
= Internet Protocal version 4, src: 11.7.33.148 (11.7.33.14B), Dst: 11.7.33.145 (11.7.33.149)

B

version: 4
Header Tengrh: zo bytes

pifferentlated services Fleld: Uxoeunknown DSCPy ECM: Ox0Z: ECTUO) (ECH-Capable Transportl)
o000 11.. = pifferentiated services eedapale : unknown C0x030

Total LEI"II]‘Eh 1068
[dentification: Ox0001 1)

Flags: Ox02 (Don't Fragment)
Fragment offset: O

Time to liwa: 16

PrOTDCD]: UDP (17D

Hoader chacksum: Ox0d?7c [carrect]
Source: 11.7.33.148 (11.7.33.148)
pestinatian: 11.7.33.140 (11.7.33.145)
[Source GeoIP: Unknown]
[pestination Geolr: unknown]

% User Datagram Protocol, Src Port: 49153 491530, 0st Port: expl (10210
# Data (1040 hytes)

3.1.9 Configuring the Ethernet Driver

The following steps describe how to configure advanced features.

Step 1.  Display the Device Manager.

Step 2.

Properties. Select the Advanced tab from the Properties sheet.

Step 3. Modify configuration parameters to suit your system.

Please note the following:

» For help on a specific parameter/option, check the help button at the bottom of the dialog.

» Ifyou select one of the entries Offload Options, Performance Options, or Flow Control Options,
you’ll need to click the Properties button to modify parameters via a pop-up dialog.

Right-click a Mellanox network adapter (under “Network adapters™ list) and left-click

Features Overview and Configuration

3.1.10 Receive Segment Coalescing (RSC)
RSC allows redaction of CPU utilization when dealing with large TCP message size. It allows
the drive to indicate to the Operating System once, per-message and not per-MTU that Packet
Offload can be disabled for IPv4 or IPv6 traffic in the Advanced tab of the driver proprieties.
RSC provides diagnostic counters documented at Table 21, “Mellanox WinOF-2 Port Traffic
Counters,” on page 125: Receive Segment Coalescing (RSC)
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3.1.11 Receive Side Scaling (RSS)
RSS settings can be set per individual adapters as well as globally.
» To do so, set the registry keys listed below:
For instructions on how to find interface index in registry <nn>, please refer to Section 3.5.1,
“Finding the Index Value of the Network Interface”, on page 108.
Table 11 - Registry Keys Setting
HKLM\SY STEM\CurrentControlSet\Con- Maximum number of CPUs allotted.
trol\Class\{4d36e972-¢325-11ce-bfc1- Sets the desired maximum number of
08002be10318}\<nn>\*MaxRSSProcessors processors for each interface. The num-
ber can be different for each interface.
Note: Restart the network adapter after
you change this registry key.
HKLM\SYSTEM\CurrentControlSet\Con- Base CPU number. Sets the desired
trol\Class\{4d36e972-e325-11ce-bfcl- base CPU number for each interface.
08002be10318}\<nn>\*RssBaseProcNumber The number can be different for each
interface. This allows partitioning of
CPUs across network adapters.
Note: Restart the network adapter when
you change this registry key.
HKLM\SYSTEM\CurrentControlSet\Con- NUMA node affinitization
trol\Class\{4d36e972-e325-11ce-bfcl-
08002be10318}\<nn>\*NumaNodelD
HKLM\SY STEM\CurrentControlSet\Con- Sets the RSS base processor group for
trol\Class\{4d36e972-¢325-11ce-bfc1- systems with more than 64 processors.
08002be10318}\<nn>\*RssBaseProcGroup
3.1.12 Wake on LAN (Wol)
Wake on LAN is a technology that allows a network admin to remotely power on a system or to
wake it up from sleep mode by a network message. WoL is enabled by default.
3.1.13 Data Center Bridging Exchange (DCBX)
Data Center Bridging Exchange (DCBX) protocol is an LLDP based protocol which manages
and negotiates host and switch configuration. The WinOF-2 driver supports the following:
* PFC - Priority Flow Control
e ETS - Enhance Transmission Selection
* Application priority
The protocol is widely used to assure lossless path when running multiple protocols at the same
time. DCBX is functional as part of configuring QoS mentioned in section Section 3.1.7, “Con-
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figuring Quality of Service (QoS)”, on page 59. Users should make sure the willing bit on the
host is enabled, using PowerShell if needed.:

set-NetQosDcbxSetting -Willing 1

This is required to allow negotiating and accepting peer configurations. Willing bit is set to 1 by
default by the operating system.

The new settings can be queried by calling the following command in PowerShell
Get-NetAdapterQos
Note: The below configuration was received from the switch in the below example.

The output would look like the following:
udimi ni strator: get-netadaptergos

: Ethernet 9
nahled : True

| arme : Ethernet 10
nabled : True

i Ethern
1 True
Hardware Current

: NotSupported MotSupported
I

iperationalFl : ol q iorities 0-4 Enabled
onalr ;
temoteTratfi

1fications

In a scenario where both peers are set to Willing, the adapter with a lower MAC address takes the
settings of the peer.

DCBX is disabled in the driver by default and in the some firmware versions as well.
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» To use DCBX:

1. Query and enable DCBX in the firmware.
a. Install WinMFT package and go to \Program Files\Mellanox\WinMFT
b. Get the list of devices, run "mst status".

o1 Select Administrator; cmd

\Program Files\Mellanox\WinHFTmst status
ST devices:

nt4183_pei_crB
nt4183_peiconf@

mt4115_pciconf@
nt411? pciconf@
\Program Files\Mellanox\WinMFI>_

c. Verify is the DCBX is enabled or disabled, run "mlxconfig.exe -d mt4117 pciconf0 query".
. I
RATE_REDUCE_MONMITOHR_PERIOD_F2
INITIAL_ALFHA_UALUE_F2
MIN_TIME_BETUWEEN_CHPS_PZ2
CHF_DSCFP_F2
CHP_8@2P_PRIC_P2
PORT _OWNER Truecl>
ALLOW_RD_COUNTERS Truecl?
IP_UER
HUM_OF_TCG_P1
HUM_OF_VUL_P1
HUM_OF_TCG_P2
KIIM_OFE_ T, P32 A T3y
LLDP_NB_R&E_MODE_P1 2
LLDP_NB_TXE_MODE_P1 2
LLDP_NB_DCBZ_FP1 Truedl>
LLDF_MB_RE_MODE_P2 a
LLDP_MB_TX_MODE_P2 @A
LLDP_NB_DCBX_P2 True (1)

Leiin L LLG_ L LIUG L F
I 2
H

d. If disabled, run the following commands for a dual-port card.

mlxconfig -d mt4117 pciconf(O set LLDP NB RX MODE P1=2
mlxconfig -d mt4117 pciconf(0 set LLDP NB TX MODE P1=2
mlxconfig -d mt4117 pciconfl set LLDP NB DCBX Pl=1
mlxconfig -d mt4117 pciconf(O set LLDP NB RX MODE P2=2
mlxconfig -d mt4117 pciconf( set LLDP NB TX MODE P2=2
mlxconfig -d mt4117 pciconfl set LLDP NB DCBX P2=1

2. Add the "DcbxMode™ registry key, set the value to "2" and reload the adapter.
The registry key should be added to HKEY LOCAL MACHINE\SYSTEM\CurrentControl-
Set\Control\Class\{4d36e972-e325-11ce-bfcl-08002bel0318}\<IndexValue>
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To find the IndexValue, refer to Section 3.5.1, “Finding the Index Value of the Network Inter-
face”, on page 108

4 Registry Editor
File Edit ‘iew Favaorites Help
%1-- . oois ~ || Marne Type Data
- L Linkage ab|*TCPUDPChecksumOffloadIPu REG_SZ 3
© b-le NDI ab|*TransmitBuffers REG_SZ 2048
© b MicSwitches ab|“ipA0 REG_SZ 1
b-de 0018 aBMMOVIanFilkering REG_SZ 1
by 0020 ab|BusType REG_SZ 5
b ggi; 28| Characteristics REG_DMYORD 000000084 (137)
B - s pimsiag_15b3 Ziclen 1015
roperties
REG_SZ 2
b || [4d36e073-2325-T1ce-bfc1-08002be10316] = ir e
B | {4d36e074-2325-11ce-bfc1-08002be 10318) ! = Bt -
. ab| Mrivearlata RFR =7 B-11-7MA

3.1.14 Receive Path Activity Monitoring

In the event where the device or the Operating System unexpectedly becomes unresponsive for a
long period of time, the Flow Control mechanism may send pause frames, which will cause con-
gestion spreading to the entire network.

To prevent this scenario, the device monitors its status continuously, attempting to detect when
the receive pipeline is stalled. When the device detects a stall for a period longer than a pre-con-
figured timeout, the Flow Control mechanisms (Global Pause and PFC) are automatically dis-
abled.

If the PFC is in use, and one or more priorities are stalled, the PFC will be disabled on all priori-
ties. When the device detects that the stall has ceased, the flow control mechanism will resume
with its previously configured behavior.

Two registry parameters control the mechanism’s behavior: the DeviceRxStallTime-out key con-
trols the time threshold for disabling the flow control, and the DeviceRxStallWatermark key con-
trols a diagnostics counter that can be used for early detection of stalled receive. For more
information, see Table 16 - “Ethernet Registry Keys,” on page 117.

3.1.15 Head of Queue Lifetime Limit

This feature enables the system to drop the packets that have been awaiting transmission for a
long period of time, preventing the system from hanging. The implementation of the feature
complies with the Head of Queue Lifetime Limit (HLL) definition in the InfiniBand™ Architec-
ture Specification (see Table 4 - “Related Documents,” on page 16).

The HLL has three registry keys for configuration:

TCHeadOfQueueLifeTimeLimit, TCStallCount and TCHeadOfQueueLifeTimeLimitEnable (see
Table 16 - “Ethernet Registry Keys,” on page 117).

3.2 InfiniBand Network

3.2.1 Feature Limitations

The following features are not supported
« VXLAN
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« NVGRE

* Receive Side Coalescing (RSC)
« VLAN

* SRIOV

* PKeys

3.2.2 Port Configuration

For more information on port configuration, please refer to 3.1.2 “Mode Configuration,” on page
34.

3.2.3 Modifying IPolB Configuration

» To modify the IPoIB configuration after installation, perform the following steps:
Step 1. Open Device Manager and expand Network Adapters in the device display pane.
Step 2. Right-click the Mellanox ConnectX Adapter entry and left-click Properties.

Step 3.  Click the Advanced tab and modify the desired properties.

The IPoIB network interface is automatically restarted once you finish modifying [PoIB parame-
ters. Consequently, it might affect any running traffic.

3.2.4 Displaying Adapter Related Information

To display a summary of network adapter software, firmware- and hardware-related information
such as driver version, firmware version, adapter identity, and network port link information, per-
form the following steps:
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Step 1.

Display the Device Manager.

% Device Manager
File Action View Help

s FE HE B EX®

Features Overview and Configuration

v % dev-l-vrt-057
- EH Computer
b Disk drives
> [ Display adapters
» =@ |DE ATASATAPI controllers
w i IEEE 1394 host controllers
i, Texas Instruments 1394 OHCl Compliant Host Controller
» E2 Keyboards
¥ g Mice and other pointing devices
» [ Monitors
v I? MNetwork adapters
= Broadcom NetXtreme Gigabit Ethernet #5
[ Broadcom Metitreme Gigabit Ethernet 26
[ Broadcom Met¥treme Gigabit Ethernet #7
Iﬁ" Broadcom MetXtreme Gigabit Ethernet 28
I Hyper-V Virtual Ethernet Adapter
I Mellanox ConnectX-4 Adapter
P Mellanox ConnectX-4 Adapter #2

= R e e
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Step 2.  Select the Information tab from the Properties sheet.

Mellanax Conteale A Lx Bthemet Adapicr Properoes I
Events I Resources I Power Management
General | Advanced | Information | Diriver | Details

M Adapter Information

Mellanox

Information | Value ]

Diriver Version 1.40.15345.0

Firmware Version 14.16.246

Port Mumber 1

Bus Type PCI-E 8D GT/sx8

Link Speed 10.0 Gbps./Full Duplex

Fart Mumber MCXAI1AGCAT

Device Id 4117

Revision Id 0

Cument MAC Address E4-1D-2D-FD-5CAE

Permanent MAC Address E4-10-2D-FD-9C-4E

Metwork Status Connected

Adapter Friendhy Name SLOT 1 Port 1

IPvd Address #1 2221

IPvE Address #1 fed0:00:00.00:e61d:2d...
Save To File

| 0K || Cancal |

To save this information for debug purposes, click Save to File and provide
the output file name.

3.2.5 Assigning Port IP After Installation

For more information on port configuration, please refer to Section 3.1.3, “Assigning Port IP
After Installation”, on page 37 under the Ethernet Network.

3.2.6 Receive Side Scaling (RSS)

For more information on port configuration, please refer to Section 3.1.11, “Receive Side Scaling
(RSS)”, on page 68 under the Ethernet Network.
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3.3 Storage Protocols

3.3.1 Deploying SMB Direct

The Server Message Block (SMB) protocol is a network file sharing protocol implemented in
Microsoft Windows. The set of message packets that defines a particular version of the protocol
is called a dialect.

The Microsoft SMB protocol is a client-server implementation and consists of a set of data pack-
ets, each containing a request sent by the client or a response sent by the server.

SMB protocol is used on top of the TCP/IP protocol or other network protocols. Using the SMB
protocol allows applications to access files or other resources on a remote server, to read, create,
and update them. In addition, it enables communication with any server program that is set up to
receive an SMB client request.

3.3.1.1 SMB Configuration Verification

3.3.1.1.1 Verifying Network Adapter Configuration
Use the following PowerShell cmdlets to verify Network Direct is globally enabled and that you
have NICs with the RDMA capability.
* Run on both the SMB server and the SMB client.

PS $ Get-NetOffloadGlobalSetting | Select NetworkDirect
PS $ Get-NetAdapterRDMA
PS $ Get-NetAdapterHardwareInfo

3.3.1.1.2 Verifying SMB Configuration
Use the following PowerShell cmdlets to verify SMB Multichannel is enabled, confirm the
adapters are recognized by SMB and that their RDMA capability is properly identified.
* On the SMB client, run the following PowerShell cmdlets:

PS S Get-SmbClientConfiguration | Select EnableMultichannel
PS $ Get-SmbClientNetworkInterface

*  On the SMB server, run the following PowerShell cmdlets!:

PS $ Get-SmbServerConfiguration | Select EnableMultichannel
PS $ Get-SmbServerNetworkInterface
PS § netstat.exe -xan | ? {$_ -match "445"}

3.3.1.1.3 Verifying SMB Connection

» To verify the SMB connection on the SMB client:
Step 1. Copy the large file to create a new session with the SMB Server.

1. The NETSTAT command confirms if the File Server is listening on the RDMA interfaces.
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Step 2. Open a PowerShell window while the copy is ongoing.
Step 3.  Verify the SMB Direct is working properly and that the correct SMB dialect is used.

PS $ Get-SmbConnection
PS $ Get-SmbMultichannelConnection
PS § netstat.exe -xan | ? {$_-match "445"}

If you have no activity while you run the commands above, you might get an empty
list due to session expiration and absence current connections.

3.3.1.2 Verifying SMB Events that Confirm RDMA Connection

» To confirm RDMA connection, verify the SMB events:
Step 1. Open a PowerShell window on the SMB client.

Step 2. Run the following cmdlets.
NOTE: Any RDMA-related connection errors will be displayed as well.

PS $ Get-WinEvent -LogName Microsoft-Windows-SMBClient/Operational | ? Message -match
"RDMA"

For further details on how to configure the switches to be lossless, please refer to
https://community.mellanox.com

3.4 Virtualization

3.4.1 Hyper-V with VMQ

3.4.1.1 System Requirements
Operating Systems: Windows Server 2012 and Windows Server 2012 R2

3.4.1.2 Using Hyper-V with VMQ
Mellanox WinOF-2 Rev 1.60 includes a Virtual Machine Queue (VMQ) interface to support
Microsoft Hyper-V network performance improvements and security enhancement.
VMQ interface supports:
» Classification of received packets by using the destination MAC address to route the

packets to different receive queues

* NIC ability to use DMA to transfer packets directly to a Hyper-V child-partition's shared
memory
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» Scaling to multiple processors, by processing packets for different virtual machines on
different processors.

» To enable Hyper-V with VMQ using Ul:

Step 1. Open Hyper-V Manager.

Step 2.  Right-click the desired Virtual Machine (VM), and left-click Settings in the pop-up menu.

Step 3. In the Settings window, under the relevant network adapter, select “‘Hardware Accelera-
tion”.

Step 4. Check/uncheck the box “Enable virtual machine queue” to enable/disable VMQ on that spe-
cific network adapter.

» To enable Hyper-V with VMQ using PowerShell:

Step 1. Enable VMQ on a specific VM: Set-VMNetworkAdapter <VM Name> -VmqWeight 100

Step 2. Disable VMQ on a specific VM: Set-VMNetworkAdapter <VM Name> -VmqWeight 0

3.4.2 Network Virtualization using Generic Routing Encapsulation (NVGRE)

Network Virtualization using Generic Routing Encapsulation (NVGRE) offload is currently sup-
ported in Windows Server 2012 R2 with the latest updates for Microsoft.

3.4.2.1 System Requirements
Operating Systems: Windows Server 2012 R2

3.4.2.2 Using NVGRE

Network Virtualization using Generic Routing Encapsulation (NVGRE) is a network virtualiza-
tion technology that attempts to alleviate the scalability problems associated with large cloud
computing deployments. It uses Generic Routing Encapsulation (GRE) to tunnel layer 2 packets
across an IP fabric, and uses 24 bits of the GRE key as a logical network discriminator (which is
called a tenant network ID).

Configuring the Hyper-V Network Virtualization, requires two types of IP addresses:

* Provider Addresses (PA) - unique IP addresses assigned to each Hyper-V host that are
routable across the physical network infrastructure. Each Hyper-V host requires at least
one PA to be assigned.

* Customer Addresses (CA) - unique IP addresses assigned to each Virtual Machine that
participate on a virtualized network. Using NVGRE, multiple CAs for VMs running on a
Hyper-V host can be tunneled using a single PA on that Hyper-V host. CAs must be
unique across all VMs on the same virtual network, but they do not need to be unique
across virtual networks with different Virtual Subnet ID.

The VM generates a packet with the addresses of the sender and the recipient within the CA

space. Then Hyper-V host encapsulates the packet with the addresses of the sender and the recip-
ient in PA space.
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PA addresses are determined by using Virtualization table. Hyper-V host retrieves the received
packet, identifies recipient and forwards the original packet with the CA addresses to the desired
VM.

NVGRE can be implemented across an existing physical IP network without requiring changes
to physical network switch architecture. Since NVGRE tunnels terminate at each Hyper-V host,
the hosts handle all encapsulation and de-encapsulation of the network traffic. Firewalls that
block GRE tunnels between sites have to be configured to support forwarding GRE (IP Protocol
47) tunnel traffic.

For further details on configuring NVGRE, please refer to Appendix A,“NVGRE Configuration
Scripts Examples,” on page 162

Figure 8: NVGRE Packet Structure

Quter Qwler IP GRE Header Inner Inner IF TCP
MaC Header | (Includes 24 B#t TNI) MAC Header | Header TCP user data
(PA) (CA)

3.4.2.3 Enabling/Disabling NVGRE Offloading
To leverage NVGRE to virtualize heavy network 10 workloads, the Mellanox ConnectX®-4 net-
work NIC provides hardware support for GRE offload within the network NICs by default.
» To enable/disable NVGRE offloading:
Step 1.  Open the Device Manager.
Step 2.  Go to the Network adapters.
Step 3.  Right click ‘Properties’ on Mellanox ConnectX®-4 Ethernet Adapter card.
Step 4. Go to Advanced tab.
Step 5. Choose the ‘Encapsulate Task Offload’ option.
Step 6.  Set one of the following values:
* Enable - GRE offloading is Enabled by default

* Disabled - When disabled the Hyper-V host will still be able to transfer NVGRE traffic, but TCP
and inner [P checksums will be calculated by software that significant reduces performance.

3.4.2.3.1 Configuring the NVGRE using PowerShell

Hyper-V Network Virtualization policies can be centrally configured using PowerShell 3.0 and
PowerShell Remoting.

Step 1. [Windows Server 2012 Only| Enable the Windows Network Virtualization binding on the
physical NIC of each Hyper-V Host (Host 1 and Host 2)

PS § Enable-NetAdapterBinding <EthInterfaceName>(a)-ComponentID ms netwnv
<EthInterfaceName> - Physical NIC name
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Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 7.

Step 8.

Features Overview and Configuration

Create a vSwitch.

PS § New-VMSwitch <vSwitchName> -NetAdapterName <EthInterfaceName>-AllowManagementOS
Strue

Shut down the VMs.

PS $ Stop-VM -Name <VM Name> -Force -Confirm
Configure the Virtual Subnet ID on the Hyper-V Network Switch Ports for each Virtual
Machine on each Hyper-V Host (Host 1 and Host 2).

PS § Add-VMNetworkAdapter -VMName <VMName> -SwitchName <vSwitchName> -StaticMacAddress
<StaticMAC Address>

Configure a Subnet Locator and Route records on all Hyper-V Hosts (same command on all
Hyper-V hosts)

PS $ New-NetVirtualizationLookupRecord -CustomerAddress <VMInterfaceIPAddress 1/n>
ProviderAddress <HypervisorInterfaceIPAddressl> -VirtualSubnetID <virtualsubnetID>

MACAddress <VMmacaddress1>? -Rule "TranslationMethodEncap"

PS $ New-NetVirtualizationLookupRecord -CustomerAddress <VMInterfaceIPAddress 2/n>
ProviderAddress <HypervisorInterfaceIPAddress2> -VirtualSubnetID <virtualsubnetID>

MACAddress <VMmacaddress2>? -Rule "TranslationMethodEncap"

a. This is the VM’s MAC address associated with the vSwitch connected to the Mellanox device.

Add customer route on all Hyper-V hosts (same command on all Hyper-V hosts).

PS $§ New-NetVirtualizationCustomerRoute -RoutingDomainID "{11111111-2222-3333-4444-
000000005001}" -VirtualSubnetID <virtualsubnetID> -DestinationPrefix <VMInterfaceIPAd-
dress/Mask> -NextHop "0.0.0.0" -Metric 255

Configure the Provider Address and Route records on each Hyper-V Host using an appro-
priate interface name and I[P address.

PS $ SNIC = Get-NetAdapter <EthInterfaceName>
PS $ New-NetVirtualizationProviderAddress -InterfacelIndex $NIC.InterfaceIndex -Provid-
erAddress <HypervisorInterfaceIPAddress> -PrefixLength 24

PS $ New-NetVirtualizationProviderRoute -InterfaceIndex S$NIC.InterfaceIndex -Destina-
tionPrefix "0.0.0.0/0" -NextHop <HypervisorInterfaceIPAddress>

Configure the Virtual Subnet ID on the Hyper-V Network Switch Ports for each Virtual
Machine on each Hyper-V Host (Host 1 and Host 2).

PS § Get-VMNetworkAdapter -VMName <VMName> | where {$_.MacAddress -eq <VMmacaddressl>}
| Set-VMNetworkAdapter -VirtualSubnetID <virtualsubnetID>

0 Please repeat steps 5 to 8 on each Hyper-V after rebooting the Hypervisor.
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3.4.2.4 \Verifying the Encapsulation of the Traffic

Once the configuration using PowerShell is completed, verifying that packets are indeed encap-
sulated as configured is possible through any packet capturing utility. If configured correctly, an
encapsulated packet should appear as a packet consisting of the following headers:

Outer ETH Header, Outer IP, GRE Header, Inner ETH Header, Original Ethernet Payload.

3.4.2.5 Removing NVGRE configuration

Step 1. Set VSID back to 0 (on each Hyper-V for each Virtual Machine where VSID was set)

PS § Get-VMNetworkAdapter <VMName>(a) | where {$ .MacAddress -eq <VMMacAddress>(b)} |
Set-VMNetworkAdapter -VirtualSubnetID 0

¢ VMName - the name of Virtual machine

¢  VMMacAddress - the MAC address of VM's network interface associated with vSwitch that was
connected to Mellanox device.

Step 2. Remove all lookup records (same command on all Hyper-V hosts).

PS $ Remove-NetVirtualizationLookupRecord

Step 3. Remove customer route (same command on all Hyper-V hosts).

PS $ Remove-NetVirtualizationCustomerRoute

Step 4. Remove Provider address (same command on all Hyper-V hosts).

PS $ Remove-NetVirtualizationProviderAddress

Step 5. Remove provider routed for a Hyper-V host.

PS $ Remove-NetVirtualizationProviderRoute

Step 6. For HyperV running Windows Server 2012 only disable network adapter binding to ms_-
netwnv service

PS § Disable-NetAdapterBinding <EthInterfaceName>(a) -ComponentID ms_netwnv
<EthInterfaceName> - Physical NIC name

3.4.3 Single Root I/0 Virtualization (SR-10V)

Single Root I/O Virtualization (SR-IOV) is a technology that allows a physical PCle device to
present itself multiple times through the PCle bus. This technology enables multiple virtual
instances of the device with separate resources. Mellanox adapters are capable of exposing up to
96 virtual instances called Virtual Functions (VFs) per port. These virtual functions can then be
provisioned separately. Each VF can be seen as an addition device connected to the Physical
Function. It also shares resources with the Physical Function.

SR-IOV is commonly used in conjunction with an SR-IOV enabled hypervisor to provide virtual
machines direct hardware access to network resources hence increasing its performance.

This guide demonstrates the setup and configuration of SR-IOV, using Mellanox adapter cards
family. SR-IOV VF is a single port device.
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3.4.3.1 SR-IOV Ethernet over Hyper-V

3.4.3.1.1 System Requirements

* A server and BIOS with SR-IOV support. BIOS settings might need to be updated to
enable virtualization support and SR-IOV support.

* Hypervisor OS: Windows Server 2012 R2

e Virtual Machine (VM) OS:
* The VM OS can be either Windows Server 2012 and above

*  Mellanox ConnectX®-4 VPI Adapter Card family

*  Mellanox WinOF-2 1.20 or higher

3.4.3.1.2 Feature Limitations

* RDMA (i.e RoCE) capability is not available in SR-IOV mode
* SR-IOV is supported only in Ethernet ports

3.4.3.2 Configuring SR-IOV Host Machines

The following are the necessary steps for configuring host machines:

3.4.3.2.1 Enabling SR-IOV in BIOS
Depending on your system, perform the steps below to set up your BIOS. The figures used in this
section are for illustration purposes only.
For further information, please refer to the appropriate BIOS User Manual.
» To enable SR-IOV in BIOS:
Step 1. Make sure the machine’s BIOS supports SR-IOV.

Please, consult BIOS vendor website for SR-IOV supported BIOS versions list. Update
the BIOS version if necessary.

Step 2.  Follow BIOS vendor guidelines to enable SR-IOV according to BIOS User Manual.
For example:
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a. Enable SR-IOV.

BIOS SETUP UTILITY

Advanced PCI/PnP Settings

Clear NURAN

Plug & Play 0/S
PCI Latency Timer
PCI IDE BHusMaster

3lotl PCI-X OPROH
§1ot2 PCI-X OPROH
§1ot3 PCI-X OPROH
Slot4 PCI-E OFROH
S1ot5 PCI-E OPROM
31ot6 PCI-E OPROM

UARNING: Setting wrong values in below sections
may cause systew to malfunction.

[Nal

[Yesl]

641
[Disabled]

[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabledl
[Enabled]

Load Onboard LAN 1 Option ROH [Enabled]
Load Onboard LAN 2 Option RON [Disabled]
(Inboard LAN Option Rom Select [PHE]

Honts Graphic Adapter Priority [Onboard UGAI

Disabled
Enabled

«  Select Screen
Tl Select Iten
+-  Change Option
Fi  General Help
F10  Save and Exit
ESC  Exit

u02.68 (C)Copyriyhl 1985 2009, fwerican Heyatrends, Inc.

b. Enable “Intel Virtualization Technologhy” Support

BIOS SETUP UTILITY
dvanced

MPS and ACPI HADT ordering

Intel AES-NI

Simultaneous Hulti-Threading
fictive Processor Cores

Intel (R} EIST Teclwology

Hicrocode Rev :14

Cache L1 1296 Kb

Cache L2 :1024 LB

Cache L3 12266 KB

Ratio Status :Unlocked Min:12. Hax:18)
Ratio Actual Value:18

CPll Ratin [Auntnl
C1E Support [Enabled]
Hardware Prefetcher [Enabled]
Adjacent Cache Line Prefetch  [Enabledl
DCll Preletcher [Enahledl
Dala Reuse Oplimizaliun [Enabled]

[Modern ordering]

Execute-Disable it Capability [Enabled]

[Disabled]
[Enabled]
[Alll
[Enabled]

»

When enabled. a UMH
can utilize the
additional HW Caps.
prouided by Intel (R)
Uirtnalization Tech.
Hote: A full reset is

required to change
the setting.

e Belecl Screen
L Select Iten
+-  Change Option
F1  General Help
Fi0  Save and Exil
ESC  Exit

v02.68 (CYCopyright 1985-2009.

American Megatrends. Inc.

For further details, please refer to the vendor's website.
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3.4.3.2.2 Installing Hypervisor Operating System (SR-IOV Ethernet Only)

» To install Hypervisor Operating System:
Install Windows Server 2012 R2

Step 1.
Step 2.

Install Hyper-V role:

* Go to: Server Manager -> Manage -> Add Roles and Features and set the following:
» Installation Type -> Role-based or Feature-based Installation
* Server Selection -> Select a server from the server pool

Select server roles

Server Roles -> Hyper-V (see figures below)

Add Roles and Features Wizard

Select one or more roles to install on the selected server.

Roles

Features Overview and Configuration

_I:I-

DESTINATION SZRWVER
|-dew-wi072

Description

Hyper-V provides the services that
you can use to create and manage
virtual machines and their resources.
Each virtual machine is a virtualized
computer system that operates inan
isolated execution environment, This
allows you ta run multiple operating
systems simultanaously.

[] Active Directory Certificate Services -
[] Active Directory Damain Services
[] Active Directory Federation Services
[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
[] Application Server
[] DHCP Server =
[ DNS Server
[] Fax Server
Filz And Sto srvices (Installzd)
v
[[] Netwerk Pelicy and Access Services
[] Print and Document Services
[ Remate Access
[] Remate Desktop Services .
< Previous | | Mext =

nsta Cancel
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= Add Roles and Features Wizard

DESTINATION SERVER

Select server ro = ; . LAB-GOTSHLITING.mtlIabs.minx
[ Add Roles and Features Wizard
X
Add features that are required for Hyper-\/?
ion
The followuf\g tools are required to manage this feature, but do not provides the services that
have to be installed on the same server.
use to create and manage
achines and their resources.
4 Remote Server Administration Tools B . ;
ual machine is a virtualized
4 Role Administration Tools r system that operates in an

execution environment. This
pu to run multiple operating
simultaneously.

4 Hyper-\V Management Tools
[Tools] Hyper-V Medule for Windows PowerShell
[Tools] Hyper-V GUI Management Tools

Include management tools (if applicable)

Md FeatureséH Cancel |

Next > Install Cancel

Step 3. Install Hyper-V Management Tools.
Features - > Remote Server Administration Tools -> Role Administration Tools ->

Hyper-V Administration Tool.
[2 Add Roles and Features Wizard |;|£-

DESTINATION SERVER

Select features .

Select one or more features to install on the selected server,

Before
Inszallation T Features Description
L R ~ Hyper-V Management Tools
[ Multipath 150 includes GUI and command-line

toals far managing Hyper-\.

[[] Metwork Load Balancing

[] Peer Mame Resclution Protacal

[ Quality Windaws Audic Video Experience

[[] RAS Connection Manager Administration Kit (CM# _
[] Remate Assistance =

[] Remate Differantial Compression

[[] Feature Administration Tools
A Rc ninistration Teoels {Installed)
[] AD DS and AD LDS Tools
[ IR Hyper-V Management Tools (Installed)
[] Remate Desktop Services Taols
[] Windows Server Update Services Tools v

< mn >

Mext = Install Cancel
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Step 4.

=

Confirm insta

Default S

lation selections

Features Overview and Configuration

Confirm the installation

Add Roles and Features Wizard

_I:I-

DESTINATION SERVER
|-rsc-002.mtl.labs.minx

To install the following roles, role services, or features on selected server, click Install.

[] Restart the destination server automatically if required

Optional features (such as administration tools) might be displayed on this page because they have

been selected automatically. If you do not want to install these optional features, click Previous to clear
their check boxes.

Hyper-V
Remote Server Administration Tools
Role Administration Tools
Hyper-V Management Tools
Hyper-V GUI Management Tools
Hyper-V Module for Windows PowerShell

Export configuration settings
Specify an alternate source path

Next >

Step 5.  Click Install

&

Confirm insta

Before You Begin

Installation Ty

Migration
Defau

Confirmation

lation selections

Export configuration settings
Specify an alternate source path

Add Roles and Features Wizard

DESTINATION SERVER
|-rsc-002.mtlJabs.minx

To install the following roles, role services, or features on selected server, click Install.

[7] Restart the destination server automatically if required

Optional features (such as administraticn tools) might be displayed on this page because they have

been selected automatically, If you do not want to install these optional features, click Previous to clear
their check boxes.

Hyper-V
Remote Server Administration Tools
Rele Administration Tools
Hyper-V Management Toals
Hyper-V GUI Management Toals
Hyper-V Module for Windows PowerShell

Step 6. Reboot the system.

3.4.3.2.3 Verifying SR-IOV Support within the Host Operating System (SR-IOV Ethernet Only)

» To verify that the system is properly configured for SR-I0OV:
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Step 1.  Go to: Start-> Windows Powershell.
Step 2. Run the following PowerShell commands.

PS $ (Get-VmHost) .IovSupport
PS $ (Get-VmHost) .IovSupportReasons

In case that SR-IOV is supported by the OS, the output in the PowerShell is as in the
figure below.

Figure 9: Operating System Supports SR-IOV

e Administrator: Windows PowerShell

admini strators

Note: If BIOS was updated according to BIOS vendor instructions and you see the mes-
sage displayed in the figure below, update the registry configuration as described in the
(Get-VmHost).IovSupportReasons message.

Figure 10: SR-IOV Support
Administrator: Windows PowerShell Hi-

E]

ition, the ahility

Step 3. Reboot
Step 4.  Verify the system is configured correctly for SR-IOV as described in Steps 1/2.

3.4.3.2.4 Creating a Virtual Machine (SR-IOV Ethernet Only)

» To create a virtual machine
Step 1.  Go to: Server Manager -> Tools -> Hyper-V Manager.
Step 2.  Go to: New->Virtual Machine and set the following:

* Name: <name>

» Startup memory: 4096 MB

¢ Connection: Not Connected
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Figure 11: Hyper-V Manager

EEl

Hyper-V Manager

File Action View Help

@2 xn@E B=

=3 Hyper-V Manager
53 LAB-N4LABISSSEE

Virtual Machines
Name - State CPUUsage  Assigr

No virtual machines were found on this serve
<] n
Checkpoints

Mo vitual machine selected.
Details
Mo item selected.

<] [T

Actions

LAB-NALABJSS5EE
New
Import Virtual Machine...

Hyper-V Settings...

HE

Virtual Switch Manager...
Virtual 5AN Manager...
Edit Disk...

B
5

Inspect Disk...
Stop Service

Remove Server

S HON =]

’
=

Refresh

View

=

Help

Virtual Machine...

Hard Disk...
Floppy Disk...

Displays the New Virtual Machine Wizard.

Step 3.
Step 4.
Step 5.

Connect the virtual hard disk in the New Virtual Machine Wizard.
Go to: Connect Virtual Hard Disk -> Use an existing virtual hard disk.
Select the location of the vhd file.

Features Overview and Configuration
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Figure 12: Connect Virtual Hard Disk

i New Virtual Machine Wizard -

A kn' Connect Virtual Hard Disk
=

Before You Begin A virtual machine requires storage so that wou can install an operating system. You can specify the

Spediy Name and Location storage now or configure it later by modifying the virtual machine’s properties,

Assign Memory () Create a virtual hard disk

Configure Netwarking Use this option to create a dynamically expanding virtual hard disk with the default fFormat (WHDE),

Connect Yirtual Hard Disk. winl.vhdx

Summary

CiUsersiPublict DocumentsiHyper-yiYirkual Hard Disks),

127 | GB {Maximum: &4 TE)

® Use an existing virtual hard disk

Use this option to attach an existing wirkual hard disk, either YHD ar YHD¥ Format,

Location: |:=:'|,WinBSrv_DC_x64_Fre_9200_vm1 .whd | | Browse, ..

() attach a virtual hard disk laker

Use this option to skip this step now and attach an existing virtual hard disk later,

% Previous | | Mext = | | Einish | | Cancel

3.4.3.2.5 Configuring Host Memory Limit per VF

3.433

In SR-IOV mode, the host allocates memory resources per the adapter's needs for each VF. It is
important to limit the amount of memory that the VF can receive from the host, in order to ensure
the host’s stability. To prevent excessive allocation, the MaxFWPagesUsagePerVF registry key
must be configured to the maximum number of 4KB pages that the host could allocate for VFs
resources. See 3.5.5.4 “SR-IOV Options,” on page 119.

Configuring Mellanox Network Adapter for SR-IOV
The following are the steps for configuring Mellanox Network Adapter for SR-IOV:

3.4.3.3.1 Enabling SR-IOV in Firmware

For non-Mellanox (OEM) branded cards you may need to download and install the new firm-
ware. For the latest OEM firmware, please go to:

http://www.mellanox.com/page/oem_firmware download
» To enable SR-I0OV using mixconfig:

mlxconfig is part of MFT tools used to simplify firmware configuration. The tool is available
with MFT tools 3.6.0 or higher.
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Step 1. Download MFT for Windows.
www.mellanox.com > Products > Software > Firmware Tools
Step 2.  Get the device ID (look for the * pciconf” string in the output).

> mst status

Example:

MST devices:

mt4115 pciconfl

Step 3.  Check the current SR-IOV configuration.
> mlxconfig -d mt4115 pciconfl g

Example:

Device #1:

Device type: ConnectX4
PCI device: mt4115 pciconf0

Configurations: Current
SRIOV_EN N/A
NUM_OF VES N/A
WOL MAGIC EN P2 N/A
LINK TYPE P1  N/A
LINK TYPE P2 N/A

Step 4. Enable SR-IOV with 16 VFs.
> mlxconfig -d mt4115 pciconf( s SRIOV_EN=1 NUM OF VFS=16

All servers are guaranteed to support 16 VFs. Increasing the number of VFs
can lead to exceeding the BIOS limit of MMIO available address space.

OS limits the maximum number of VFs to 32 per Network Adapter.
To increase the number of VFs, the following PowerShell command should be used:

Set-NetAdapterSRIOV - name <AdapterName> -NumVFs <Required number
of VFs>

Rev 1.60 Mellanox Technologies 89



Yiiiy

Mellanox

TECHNOLOGIES

Example:

Device #1:

Device type: ConnectX4
PCI device: mt4115 pciconf0

Configurations: Current New
SRIOV_EN N/A 1
NUM _OF VES N/A 16
WOL_MAGIC EN P2 N/A N/A
LINK TYPE Pl N/A N/A
LINK TYPE P2 N/A N/A

Apply new Configuration? ? (y/n) [n] : y
Applying... Done!
-I- Please reboot machine to load new configurations.

3.4.3.4 Configuring Operating Systems

3.4.3.4.1 Configuring Virtual Machine Networking (Ethernet SR-IOV Only)

» To configure Virtual Machine networking:
Step 1. Create an SR-IOV-enabled Virtual Switch over Mellanox Ethernet Adapter.
Go to: Start -> Server Manager -> Tools -> Hyper-V Manager

In the Hyper-V Manager: Actions -> Virtual SwitchManager -> External->
Create Virtual Switch

Step 2.  Set the following:
* Name:
e External network:

» Enable single-root I/O virtualization (SR-IOV)
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Features Overview and Configuration

Figure 13: Virtual Switch with SR-IOV
=

=1 Virtual Switch Manager for DEV-L-VRT-038

4 Virtual Switches
i’i’a Mew virtual network switch
[ My Lab trusted network S
Broadcom MetXtreme Gigabit Ether...
= Mellanox SRIOV Virtual Switch

wiw Virtual Switch Properties

Mellanox SRIOV Virtual Switch

" Mellanox ConnectX-4 VPI Adapter #2 [ IR
!5‘., Extensions
# Global Network Settings

@ MAC Address Range
00-15-50-34-01-00 to 00-15-

n
tn
=
[

Connection type
What do you want to connect this virtual switch to?
(® External network:

:Mellanox Connect¥-4 VPI Adapter #2

!
Allow management operating system to share this network adapter
VLAM ID
[ Enable virtual LAN identification for management operating system
2
Remove

@ SR-IOV can only be configured when the virtual switch is created. An external

wirtual switch with SR-IOV enabled cannot be converted to an internal or private
swi

Cancel

Step 3. Click Apply.
Step 4. Click OK.
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Step 5. Add a VMNIC connected to a Mellanox vSwitch in the VM hardware settings:
* Under Actions, go to Settings -> Add New Hardware-> Network Adapter-> OK.
* In “Virtual Switch” dropdown box, choose Mellanox SR-IOV Virtual Switch.

Figure 14: Adding a VMNIC to a Mellanox v-Switch

e Settings for vm1 on L-DEV-WO072 \;‘i-

Sl
v v | G
# Hardware ~ U Metwork Adapter
“""Q Add Hardware
i BIOS Specify the configuration of the network adapter or remove the network adapter.
Book fram C0 wirtual switch:
[ Mmooty |Not connecked v
4096 ME

VLAM ID

D Processar
["] Enable wirtual LAM identification

1 Wirtual processor
= E IDE Controller 0

i Hard Drive
WingSry_DC_xéd_Fre_ 920,

= EE IDE Controller 1
% DD Drive
one
B 5CSI Controller
g

Mebwork Adapter
Mot connected

Bandwidth Management
["] Enable bandwidth management

[ Metwork Adapter

)

[+

Inkernal Yirtual Swikch

To remove the network adapter from this virtual machine, click Remove.

[ Diskette Drive

Mone —
I@I Use a legacy network adapter instead of this nebwork adapter to perform a
# Management nietwark-hased installation of the guest operating system or when integration
L] Mame services are not installed in the guest operating system,
vl
7 . .
\*=| Integration Services

Step 6. Enable the SR-IOV for Mellanox VMNIC:
1. Open VM settings Wizard.
2. Open the Network Adapter and choose Hardware Acceleration.
3. Tick the “Enable SR-IOV” option.
4. Click OK.
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Sv.

Settings for vm1 on L-DEV-WQO72

winl

v]

Features Overview and Configuration

Figure 15: Enable SR-IOV on VMNIC

_I:I-

~
L

% Hardware

7

El

11 Add Hardware
L BIOS
Bioaok from CD

F{ rAernary

40965 MB

# [} Processor

1 ¥irtual processor

= [EE IDE Contraller 0

w Hard Drive
WinESre_DiC_x6d_fre_920..,

= [} IDE Controller 1

~ % DD Drive
Mone

[ 5CSI Contraller

Metwork Adapter
Mok connected

U Metwork Adapter
Inkernal virtual Swikch

U Metwork Adapter
Mellano: SRICY Virtual Swikch
Hardware Acceleration
Advanced Features

7 oom1
Mone

Jocomz
Mone

= Disketts Drive

Mone

% Man b

Step 7.

Step 8.
Step 9.
Step 10.
Step 11.

1 Mame

vl

Hardware Accelsration
Specify networking tasks that can be offloaded ko a physical network adapter,

‘irbual machine queue

Wirkual machine queue (YMQ) requires a physical network adapter that supports
this feature.

Enable virtual machine gueue

IPsec task offloading
Support From a physical network adapter and the guest operating system is
required ta offload IPsec tasks,
‘Wwhen sufficient hardware resources are not available, the security associations
are not offloaded and are handled in software by the guest operating system,

Enable IPsec task offloading

Select the maximurn number of offloaded security associations from a range of 1 to

4098,
Offlnaded 54

Maximurn number:

Single-roak IO virtualization
Single-root IO virtualization (SR-ION) requires specific hardware, It also might
require drivers to be installed in the guest operating system.
‘when sufficient hardware resources are not available, nebwork connectivity is
provided thraugh the wvirtual switch,

Enable SR-10Y

Start and connect to the Virtual Machine:

Select the newly created Virtual Machine and go to: Actions panel-> Connect.
In the virtual machine window go to: Actions-> Start

Copy the WinOF-2 driver package to the VM using Mellanox VMNIC IP address.
Install WinOF-2 driver package on the VM.
Reboot the VM at the end of installation.

Verify that Mellanox Virtual Function appears in the device manager.
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Figure 16: Virtual Function in the VM

File Action View Help
&= @ E HE| 8BRS

4 gy dev-l-vrt-227-005
> & Audio inputs and outputs

1> 1M Computer

I ¢ Disk drives

- W Display adapters

» iy DVD/CD-ROM drives

[ l__ﬂ_ﬂ Floppy disk drives

[ tﬂ Floppy drive controllers

> ¥ Human Interface Devices

> g IDEATASATAPI controllers

> == Keyboards

[ B Mice and other pointing devices

- B Monitors

a4 ¥ Metwork adapters
'l_'? Intel 21140-Based PCl Fast Ethernet Adapter (Emulated)
|EF Mellanox ConnectX-4 Virtual Adapter |
¥ Microsoft Hyper-V Network Adapter

> '3 Ports (COM & LPT)

I r&] Print queues

[ D Processors

» 45 Storage controllers

> (M System devices

To achieve best performance on SR-IOV VF, please run the following powershell commands on
the host:

* For 10Gbe:

PS $ Set-VMNetworkAdapter -Name "Network Adapter" -VMName vml -Iov-
QueuePairsRequested 4

e For 40Gbe and above:

PS $ Set-VMNetworkAdapter -Name "Network Adapter" -VMName vml -Iov-
QueuePairsRe-quested 8

3.4.3.5 VF Spoof Protection

WinOF-2 supports two levels of spoof protection:

Hypervisor sets VF's MAC address and only packets with that MAC can be transmitted
by the VF

Hypervisor can control allowed Ethertypes that the VF can transmit
If a VF attempts to transmit packets with undesired source MAC or Ethertype, the packets will be
dropped by an internal e-Switch.

By default, the anti-spoof filter is enabled with the following Ethertypes:
» Internet Protocol version 4 (IPv4) (0x0800)

* Internet Protocol Version 6 (IPv6) (0x86DD)
* Address Resolution Protocol (ARP) (0x0806)
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Table 12 - VF Spoof Protection Registry Keys

Features Overview and Configuration

The hypervisor can configure an Ethertype table for VFs, which includes a set of allowed Ether-
types values for transmission via the NIC registry. The registry keys are as follows:

Key Name Key Type Values Description
VFAllowedTxEther- REG _SZ 0 =Disabled | Enables/disables the feature
TypeListEnable 1 = Enabled

(default)
VFAllowedTxEther- REG_D- Ethertype The first Ethertype to allow VF to
Type0 WORD value transmit
VFAllowedTxEther- REG D- Ethertype The second Ethertype to allow VF
Typel WORD value to transmit
VFAllowedTxEther- REG_D- Ethertype The third Ethertype to allow VF to
Type2 WORD value transmit
VFAllowedTxEther- REG_D- Ethertype The fourth Ethertype to allow VF
Type3 WORD value to transmit
VFAllowedTxEther- REG D- Ethertype The fifth Ethertype to allow VF to
Type4 WORD value transmit
VFAllowedTxEther- REG_D- Ethertype The sixth Ethertype to allow VF to
Type5 WORD value transmit
VFAllowedTxEther- REG_D- Ethertype The seventh Ethertype to allow VF
Type6 WORD value to transmit
VFAllowedTxEther- REG D- Ethertype The eighth Ethertype to allow VF
Type7 WORD value to transmit

* By default, the feature is enabled and uses the default Ethertype table.

* The Source MAC protection cannot be disabled, and the Ethertype protection can be dis-
abled by setting the VFAllowedTxEtherTypeListEnable key to 0.

* When the feature is disabled, only the Ethernet flow control protocol (0x8808) is
restricted to be transmitted by the VF.

» Configuring at least one Ethertype in the registry will override the default table of the

Ethertypes mentioned above.
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3.4.3.5.1 Limitations
When one of the following Ethertypes is enabled, the other is automatically disabled, and vice
versa:
e 0x8906 - Fibre Channel over Ethernet (FCoE)

¢« 0x8914 - FCoE Initialization Protocol

3.4.3.6 Configuring Operating Systems

3.4.3.6.1 Configuring Virtual Machine Networking (InfiniBand SR-IOV Only)

For further details on enabling/configuring SR-IOV on KVM, please refer to the section titled
“Single Root 10 Virtualization (SR-IOV)” in Mellanox OFED for Linux User Manual.

3.4.3.6.2 Configuring Virtual Machine Networking (Ethernet SR-IOV Only)

» To configure Virtual Machine networking:
Step 1.  Create an SR-IOV-enabled Virtual Switch over Mellanox Ethernet Adapter.
Go to: Start -> Server Manager -> Tools -> Hyper-V Manager

In the Hyper-V Manager: Actions -> Virtual SwitchManager -> External->
Create Virtual Switch

Step 2.  Set the following:
¢« Name:
e External network:

* Enable single-root I/O virtualization (SR-IOV)

96 Mellanox Technologies Rev 1.60



Rev 1.60

Mellanox

TECHNOLOGIES

¥irtual Switches

Features Overview and Configuration

Figure 17: Virtual Switch with SR-IOV

Virtual Switch Manager for L-DEV-W072

Mews virtual network, switch

wfu Wirtual Switch Properties

“w Internal Wirtual Switch

Internal only
.

*x Mellanox SRIOY ¥irtual Switch
Mellanox Connect®-3 Etherne
Global Network Settings

]

Mame:

Mellano:: SRICY Wirtual Switch

Mokes:

W MAC Address Range

00-15-50-21-A4C-00 ko 00-15-50-2.,

Connection type

What do you want to connect this virtual switch to?

External network:

Mellanox: Connect®-3 Ethernet Adapter

w
Allow management operating system to share this network adapter
Enable single-rook 1M virtualization (SR-TOW)

Internal network,
Private network,

YLAN ID

[] Enable wirtual LAM identification For management operating system
2

P

Step 3. Click Apply.

Step 4. Click OK.

¥ SR-IOV can only be configured when the wvirtual switch is created. An external
wirtual switch with SR-IOV enabled cannot be converted to an internal or private
switch,
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Step S.

Step 6.

Add a VMNIC connected to a Mellanox vSwitch in the VM hardware settings:

3

Under Actions, go to Settings -> Add New Hardware-> Network Adapter-> OK.
In “Virtual Switch” dropdown box, choose Mellanox SR-IOV Virtual Switch.

Figure 18: Adding a VMNIC to a Mellanox V-switch

=v-

_I:I-

Settings for vm1 on L-DEV-W072

A
wmi v ‘ G
% Hardware A [ Wetwork Adapter
“i Add Hardware
& BIOS Specify the configuration of the network adapter or remove the netwaork adapter,
* Boat from CD Wirkual switch:
B Mermary |N0t connected v
4098 ME
WLAN I

D Processor
1 virkual processar

(= [EE IDE Controller 0

a Hard Drive
Wingsry_DC_x64_fre_920...

(= [EE IDE Controller 1

o4 YD Drive
Mane
B 505 Cantroller
W Metwork Adapter
Mot connected
0 Metwork Adapter
Internal Yirtual Switch

T com1
Mone
T come2
Mone
[ Diskette Crive
Mone
A M k
|| Mame
wml

é‘ Integration Services

[7] Enable virtual LAN identification

Bandwidth Management
[7] Enable bandwidth management

To remove the network adapter From this virtual machine, click Remaove,

Remove

'@' Use a legacy network adapter instead of this network adapter to perform a
nietwork-based installation of the guest operating system or when integration
services are not installed in the guest operating system.

Enable the SR-IOV for Mellanox VMNIC:

1. Open VM settings Wizard.

2. Open the Network Adapter and choose Hardware Acceleration.
3. Tick the “Enable SR-IOV” option.

4. Click OK.
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v

Features Overview and Configuration

Figure 19: Enable SR-IOV on VMNIC

vl

V]

Settings for vm1 on L-DEV-W072

~
A

_I:I-

% Hardware

1 Add Hardware

~

Hardware Acceleration

Specify networking tasks that can be offloaded to a physical network adapter,

A BIOS
Bt From C0 Virtual machine queue
B4 I\:ngngrpﬁs Virkual machine queue (WMQ) requires a physical netwaork adapter that supports

&

D Processar
1 virtual processar
IEl IDE Cantroler 0
Cw Hard Drive

Wingsry_DC_x64_fre_920...

IEl IDE Cantroller t

this Feature.

Enable virtual machine gueue

IPsec task offloading

Support From a physical network adapter and the guest operating system is
required to offload IPsec tasks,

* % DVD Drive ‘when sufficient hardware resources are not available, the security associations
Mone = are not offloaded and are handled in software by the guest operating system,
o] =
5% SCSI Cortroller Enable [Psec task offloading
+ W Metwork Adapter

Mot connecked

&

U Metwork Adapter
Inkernal virtual Switch

= Metwork Adapter

Mellanoz: SRICY Yirtual Switch
Hardware Acceleration
Advanced Features

T com1
Mone

oMz
Mone

H Diskette Drive
Mone

Select the maximum number of offloaded security associations from a range of 1 to

4096,
Offloaded 54

[aximum number:

Single-root IO virtualization
Single-rook I/ virtualization {SR-I0Y) requires specific hardware, It also might
require drivers to be installed in the guest operating system,
‘Wwhen sufficient hardware resources are not available, network connectivity is
provided through the wirtual switch,

Enable SR-10Y

Step 7.  Start and connect to the Virtual Machine:
Select the newly created Virtual Machine and go to: Actions panel-> Connect.
In the virtual machine window go to: Actions-> Start
Step 8. Copy the WinOF driver package to the VM using Mellanox VMNIC IP address.
Step 9. Install WinOF driver package on the VM.

Step 10. Reboot the VM at the end of installation.
Step 11. Verify that Mellanox Virtual Function appears in the device manager.
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Figure 20: Virtual Function in the VM
= Device Manager
File Action View Help

& B HE &
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L Microsoft Kernel Debug Metwork Adapter
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mands on the host:
For 10Gbe:

PS § Set-VMNetworkAdapter -Name "Network Adapter" -VMName vm! -lovQueue-
PairsRequested 4
For 40Gbe and 56Gbe:

PS $ Set-VMNetworkAdapter -Name "Network Adapter" -VMName vm1 -lovQueue-
PairsRequested 8

Q To achieve best performance on SR-IOV VF, please run the following powershell com-

3.4.4 Virtual Machine Multiple Queue (VMMAQ)

Virtual Machine Multiple Queues (VMMQ), formerly known as Hardware vRSS, is a NIC off-
load technology that provides scalability for processing network traffic of a VPort in the host
(root partition) of a virtualized node. In essence, VMMQ extends the native RSS feature to the
VPorts that are associated with the physical function (PF) of a NIC including the default VPort.

VMMQ is available for the VPorts exposed in the host (root partition) regardless of whether the
NIC is operating in SR-IOV or VMQ mode. VMMQ is a feature available in Windows Server
2016.

3.4.4.1 System Requirements

* Operating System(s): Windows Server 2016
e Available only for Ethernet (no IPOIB)
*  Mellanox ConnectX-4/ConnectX-4 LxVPI/ConnectX-5 adapter card family
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3.4.4.2 Enabling/Disabling VMMQ

3.4.4.2.1 On the Driver Level
» To enable/disable VMMQ:

Step 1.  Go to: Display Manager-> Network adapters->Mellanox ConnectX-4/ConnectX-5 Ethernet

Features Overview and Configuration

Adapter->Properties-> advanced tab->Virtual Switch Rss

Events Resources

General Advanced Informaticn

Mellanox Connectd-4 VPI Adapter Properties *

Power Management
Drriver Detail=

The following properties are available for this network: adapter. Click
the property you want to change on the left, and then select its value

on the right.
Property:

Value:

RS5S Maximum Processor Mumber s
Re¢ Intemupt Maoderation Profile

Fo Intemupt Moderation Type

Send Buffers

SR-ICY

TCRAUDP Checksum Offload {IPv-
TCPAUDP Checksum Offlaad (IPw
Ta Intermupt Maderation Profile

Virtual Machine Gueues

Vitual Switch RS55

VLAN ID

WMQ VLAN Fitering

WXLAM Encapsulated Task Offloa
WXLAN UDP destination port numkb %

| Disabled -l

Enabled

Cancs

Step 2.  Select Enabled or Disabled

» To enable/disable VMMQ using a Registry Key:
Set the RssonHostVPorts registry key in the following path to either 1 (enabled) or o (disabled)
HKIM\SYSTEM\CurrentControlSet\Control\Class\{4d36e972-e325-11ce-bfcl-

08002bel0318}\<nn>\* RssOnHostVPorts

3.4.4.2.2 On a VPort

» To enable VMMQ on a VPort:
PS $ Set-VMNetworkAdapter -Name "Virtual Adapter Name" -VmmgEnabled $true
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» To disable VMMQ on a VPort:
PS S Set-VMNetworkAdapter -Name "Virtual Adapter Name" -VmmgEnabled $false

@ Since the VMMAQ is an offload feature for vRss, vRss must be enabled prior to enabling VMMQ.

3.4.4.3 Controlling the Number of Queues Allocated for a vPort

The requested number of queues for a virtual network adapter (vPort) can be set by invoking this
PS cmdlet:

PS § Set-VMNetworkAdapter -Name "VM Name" -name "Virtual Adapter Name" -VmmgQueuePairs <num-
ber>

ever, the OS might decide to not fulfill the request due to some resources and other factors
considerations.

Q The number provided to this cmdlet is the requested number of queues per vPort. How-
3.4.5 Network Direct Kernel Provider Interface

As of v1.45, WinOF-2 supports NDIS Network Direct Kernel Provider Interface version 2. The
Network Direct Kernel Provider Interface (NDKPI) is an extension to NDIS that allows IHVs to
provide kernel-mode Remote Direct Memory Access (RDMA) support in a network adapter.

3.4.5.1 System Requirement

* Operating System: Windows Server 2012 R2 (Without NDK from/to a VM) and Win-
dows 2016

3.4.5.2 Configuring NDK

3.4.5.2.1 General Configurations

Step 1. Make sure the port is configured as Ethernet.

Step 2. Make sure the RoCE mode is configured the same on both ends, run “mix5cmd -stat”
from the "Command Prompt". ROCE v2 is the default mode.

3.4.5.2.2 Configuring NDK for Virtual NICs

Step 1. Create a VMSwitch.

PS $ New-VMSwitch -Name <vSwitchName> -NetAdapterName <EthInterfaceName> -AllowManage-
ment0S $False
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Step 2.  Create the virtual network adapters.

PS § Add-VMNetworkAdapter -SwitchName <vSwitchName> -Name <EthInterfaceName> -Manage-
mentOS

Step 3.  Enable the "Network Direct(RDMA)" on the new virtual network adapters.
PS $ Enable-NetAdapterRdma <EthInterfaceName>

3.4.5.2.3 Configuring the VM

Step 1. Make sure your machine supports SR-IOV.
Step 2. Create a VM (make sure the VM is running the same OS as host)
Step 3. Create an SR-IOV enabled VMSwitch.

PS $ New-VMSwitch -Name <vSwitchName> -NetAdapterName <EthInterfaceName> -Enablelov
$True -AllowManagementOS S$True
Step 4. Add a Network Adapter to the VM in the Hyper-V Manager, and choose the VMSwitch just
created.

&] Settings for w022 on MTI022 - X

wmiz2 v 3]

% Hardware A i

L Metwork Adapher
!" 4dd Hardware
[ B0 Specify the configuration of the netwark adapter or remave the netwark adapter.
Eook From D Yirbual switch:
@ secuity ML ¥
Key Storage Drive disabled
WLAN ID
Wl Memory
40196 ME [[] Enable virbual LAN identification
# [ Processor
1 Yirtual processor
= [ 10E Contraler O
s Hard Drive
Winz2016_DC_x64 14393,
= |8 10E Controller 1 Bandwidth Management
OV Drive [[] Enable bandwidth management

MNong
&l sca1 Controller

Hardware Acceleration
Advanced Features

& comt (i ]

wmiZz
ﬁ COMz To remove the netwark adapter from this virtual maching, click Remave,
Tane
[ piskette Crive Remave

e 0 Use a legacy network adapter instead of this network adapter to perform a

A M 4 netwark-based installation of the guest operating system or when integration
1] Mame services are not installed in the guest operating system.

w2z
ij Integration Services
Some services offered
(b Checkpoinks
Production v

Cancel
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Step 5. Check the "Enable SR-IOV" option on the "Hardware Acceleration" under the Network

Adapter.
t_Hardware o Hardware Acceleration
!" Add Hardware
[ gIos Specify networking tasks that can be offloaded to a physical network adapter.
foot _me 0 Yirtual machine queue
L4 SKez::rSIiirage Drive disabled Vir_tual machine queue (YMC) requires a physical network adapter that supports
this Feature,
W Memary : :
409 ME Enable virtual machine queue
i [J Processor
1 Wirtual processor IPsec task offloading
< [ 1DE Controller 0 Support fram a physical network adapter and the quest operating system is
= Hard Drive required ko offload IPsec tasks,

Win2o1e_DC_xed_ 14393, o ? - Sy
~ when sufficient hardware resources are not available, the security associations
3 |80 10E Contraller 1 are not offloaded and are handled in software by the guest operating system,

DUD Drive Enable IPsec kask offloading
Mane
&l scs1 Cantraller Select the maximum number of offloaded security associations from a range of 1 to
1 I Metwork adapter 4036,
TLIE

Maximum number: Cffloaded 54

Advanced Features

ﬁ coM1 Single-root If wirtualization
wmizz Single-roat I/O virtualization {SR-IOW) requires specific hardware., Tt also might
ﬁ oMz require drivers to be installed in the guest operating system.
Mane ‘When sufficient hardware resources are not available, network connectivity is
H Diskette Drive pravided through the virtual switch.
flene Eniable SR-10V
T M 9
L] Mame
Wl

If you turn ON the VM at this time in the VM Device Manager, you should see Mellanox
Virtual Adapter under the Network adapters.

[ e WVIONITOrS
a4 &Y Network adapters
5_-'." Intel 21140-Based PCI Fast Ethernet Adapter (Emulated)
¥ Mellanox ConnectX-4 Virtual Adapter
¥ Microsoft Hyper-V Network Adapter

Step 6. Instaﬂ the Mellanox Driver in the VM.
Use the same package you installed on the host

Step 7. Enable RDMA on the corresponding network adapter in the VM (Run the command in the
VM)

PS $ Enable-NetAdapterRdma <EthInterfaceName>
3.4.5.3 Utility to Run and Monitor NDK

3.4.5.3.1 Running NDK

Since SMB is NDK’s client, it should be used to generate traffic. To generate traffic, do a big
copy from one machine to the other.
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For instance, use "xcopy" to recursively copy the entire c:\Windows directory or from a "Com-
mand Prompt" window, run:

xcopy /s c:\Windows \\<remote machine ip>\<remote machine directory for receiving>

For example:
xcopy /s c:\Windows \\11.0.0.5\c$\tmp

3.4.5.3.2 Validating NDK

During the run time of NDK test (xcopy), with "RDMA Activity" in the perfmon.

Use the mlx5cmd sniffer to see the protocol information of the traffic packet.

3.4.6 PacketDirect Provider Interface

As of v1.45, WinOF-2 supports NDIS PacketDirect Provider Interface. PacketDirect extends
NDIS with an accelerated I/0 model, which can increase the number of packets processed per

second by an order of magnitude and significantly decrease jitter when compared to the tradi-
tional NDIS I/O path.

@ PacketDirect is supported only on Ethernet ports.

3.4.6.1 System Requirements
* Hypervisor OS: Windows Server 2016
e Available only for Ethernet (no IPOIB)
* Virtual Machine (VM) OS: Windows Server 2012 and above
*  Mellanox ConnectX-4/ConnectX-4 Lx/ConnectX-5/ConnectX-5 Ex
*  Mellanox WinOF-2 1.45 or higher
*  Firmware version: 12.16.1020/14.16.1020 or higher

3.4.6.2 Using PacketDirect for VM

» To allow a VM to send/receive traffic in PacketDirect mode:
Step 1.  Enable PacketDirect:
*  On the Ethernet adapter.
PS $ Enable-NetAdapterPacketDirect -Name <EthInterfaceName>
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* In the Device Manager.

Mellanox ConnectX-4 Adapter Properties *
Events Resources Power Management
General Advanced Information Driver Details

The following properties are available for this network adapter. Click

the property you want to change on the left, and then select its value
on the right.

Property: Value:

Packet Direct - Enabled -
Prefemed NUMA Node

Priority & Vian Tag

Quality Of Service

R/RoCE Max Frame Size

Receive Buffers

Receive Completion Method
Receive Side Scaling

Recv Segment Coalescing {IPv4)
Recv Segment Coalescing {IPvE)
RSS Base Processor Number

RS5 Load Balancing Profile

RSS Maxdmum Processor Number
Fix Intermupt Moderation Profile A

Cancel

Step 2. Create a vSwitch with PacketDirect enabled.

PS $ New-VMSwitch <vSwitchName> -NetAdapterName <EthInterfaceName> -EnablePacketDirect
Strue -AllowManagementOS S$true

Step 3. Enable VFP extension:
*  On the vSwitch.

PS $ Enable-VMSwitchExtension -VmSwitchName <vSwitchName> -Name "Windows Azure VEP
Switch Extension"
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* In the Hyper-V Manager: Action->Virtual Switch Manager...

éE Virtual Switch Manager for MTS007 - X

A Virtual Switches
2% New virtual network switch
El of M

=t Virtual Switch Extensions

Switch extensions:

Name: Type

=i Extensions [ Microsoft Windows Filtering Platform Filter

% Global Network Settings

Mirosoft Azure VFP Switch Extension Forward
D Microsoft NDIS Capture Monitoring

']

Details for selected extension:

Microsoft Azure VFP Switch Extension

Company:
Version:

Cancel Apply
Step 4. Shut down the VM.
PS $ Stop-VM -Name <VMName> -Force -Confirm
Step 5. Add a virtual network adapter for the VM.

PS $ Add-VMNetworkAdapter -VMName <VMName> -SwitchName <vSwitchName> -StaticMacAddress
<StaticMAC Address>

Step 6.  Start the VM.

PS $ Start-VM -Name <VMName>

Since VFP is enabled, without any forwarding rules, it will block all traffic going through
the VM.

Follow the following steps to unblock the traffic
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Stepa.  Find the port name for the VM.
CMD > vfpctrl /list-vmswitch-port

Port name : E431C413-D31F-40EB-AD96-0B2D45FE34AA

Port Friendly name

Switch name : 8B288106-9DB6-4720-B144-6CC32D53E0EC
Switch Friendly name : MlnxSwitch

PortId : 3

VMQ Usage : 0

SR-IOV Usage : 0

Port type : Synthetic

Port is Initialized.
MAC Learning is Disabled.

NIC name ¢ bd65960d-4215-4a4f-bddc-962a5d0e2fa0--e719%a49-6¢cca-
4d3c-a4cd-22907592527e

NIC Friendly name : testnic

MTU : 1500

MAC address : 00-15-5D-4C-46-00

VM name P vm

Command list-vmswitch-port succeeded!

Step 7. Disable the port to allow traffic.

CMD > vfpctrl /disable-port /port <PortName>
Command disable-port succeeded!

Q The port should be disabled after each reboot of the VM to allow traffic.

3.4.6.3 Disable Loopback Mode

In this mode, the NIC switch does not forward traffic from one function to another. All transmitted
traffic is sent to the Up-link port, and the packet classification on the transmit side is performed by
an external switch. Filtering logic only affects packets arriving from the Up-link port.

The user can configure loopback disable mode separately for multi-cast and uni-cast traffic, by set-
ting eSSWUCLoopback and eSWMCLoopback registry values accordingly. For more information,
see Table 20 - “SR-IOV Options,” on page 120.

3.5 Configuration Using Registry Keys

3.5.1 Finding the Index Value of the Network Interface

To find the index value of your Network Interface from the Device Manager please perform the
following steps:

Step 1.  Open Device Manager, and go to Network Adapters.
Step 2. Right click ->Properties on Mellanox Connect-X® Ethernet Adapter.
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Step 3. Go to Details tab.
Step 4. Select the Driver key, and obtain the nn number.
In the below example, the index equals 0010
& Device Manager -0 X |D‘
File Action View Help l_
e I L. . Mellanox ConnectX-4 Adapter Properties I
4 g2y 1-dev-wiD) _ Events | Resowcss | Power Management
b 1% Computer Genersl | Advanced | Idomstion | Driver Detaik
b Disk drives
b % Display adapters ‘. Mellanox ConnectX-4 Adapter
b g IDE ATAJATAPI controllers .
4 @ IEEE 1334 host controllers Propery
%, Texas Instruments 1394 OHCI Compliant Host Controller [Drver key -

I == Keyboards

S ]j Mice and other pointing devices

p IS Menitors

4 %5 Network adapters
Q‘ Broadcom NetXtreme Gigabit Ethernet £5
%" Broadcom NetXtreme Gigabet Ethernet 26
9‘ Broadcom NetXtreme Gigabst Ethernet #7
&¥ Broadcom NetXtreme Gigabit Ethernet #3

| & Mellanox ConnectX-4 Adapter |

& Mellanox Connectx-4 Adapter #2

Other devices

U5 Base System Device

b 7 Ports (COM & LPT)

b = Print queues

[ B Processons

b € Storage controllers

4 M System devices
% ACPI Fived Feature Button

)

All registry keys added for driver configuration should be of string type (REG_SZ).

Vale
(443697223251 Toe-bic1-0800206 103183 [o017]

OK | Canesl

After setting a registry key and re-loading the driver, you may use the mlxScmd -
regkeys command to assure that the value was read by the driver.
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3.5.2 Basic Registry Keys

This group contains the registry keys that control the basic operations of the NIC
Table 13 - Basic Registry Keys

Value Name Default Value Description

*JumboPacket ETH: 1514 The maximum size of a frame (or a packet) that can be sent
[PoIB: 4092 | over the wire. This is also known as the maximum transmis-
sion unit (MTU). The MTU may have a significant impact on
the network's performance as a large packet can cause high
latency. However, it can also reduce the CPU utilization and
improve the wire efficiency. The standard Ethernet frame
size is 1514 bytes, but Mellanox drivers support wide range
of packet sizes.

The valid values are:

* Ethernet: 600 up to 9600

e IPoIB: 256 up to 4092

Note: All the devices across the network (switches and rout-
ers) should support the same frame size. Be aware that differ-
ent network devices calculate the frame size differently.
Some devices include the header, i.e. information in the
frame size, while others do not.

Mellanox adapters do not include Ethernet header informa-
tion in the frame size. (i.e when setting *JumboPacket to
1500, the actual frame size is 1514).

*ReceiveBuffers 512 The number of packets each ring receives. This parameter
affects the memory consumption and the performance.
Increasing this value can enhance receive performance, but
also consumes more system memory.

In case of lack of received buffers (dropped packets or out of
order received packets), you can increase the number of
received buffers.

The valid values are 256 up to 4096.

*TransmitBuffers 2048 The number of packets each ring sends. Increasing this value
can enhance transmission performance, but also consumes
system memory.

The valid values are 256 up to 4096.

3.5.3 Offload Registry Keys

This group of registry keys allows the administrator to specify which TCP/IP offload settings are
handled by the adapter rather than by the operating system.
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Enabling offloading services increases transmission performance. Due to offload tasks (such as
checksum calculations) performed by adapter hardware rather than by the operating system (and,
therefore, with lower latency). In addition, CPU resources become more available for other tasks.

Table 14 - Offload Registry Keys

Value Name DB ENAZING Description

*LsoV2IPv4 1 Large Send Offload Version 2 (IPv4).
The valid values are:

e 0: disable

e 1:enable

*LsoV2IPv6 1 Large Send Offload Version 2 (IPv6).
The valid values are:

e 0: disable

e 1:enable

LSOSize 64000 The maximum number of bytes that the TCP/IP stack can
pass to an adapter in a single packet.

This value affects the memory consumption and the NIC per-
formance.

The valid values are MTU+1024 up to 64000.

Note: This registry key is not exposed to the user via the UL
If LSOSize is smaller than MTU+1024, LSO will be dis-
abled.

LSOMinSegment 2 The minimum number of segments that a large TCP packet
must be divisible by, before the transport can offload it to a
NIC for segmentation.

The valid values are 2 up to 32.

Note: This registry key is not exposed to the user via the UI.

LSOTepOptions 1 Enables that the miniport driver to segment a large TCP
packet whose TCP header contains TCP options.

The valid values are:

* 0: disable

* 1:ecnable

Note: This registry key is not exposed to the user via the UL

LSOIpOptions 1 Enables its NIC to segment a large TCP packet whose [P
header contains IP options.

The valid values are:

* 0:disable

* l:enable

Note: This registry key is not exposed to the user via the UL
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Table 14 - Offload Registry Keys

Value Name

*IPChecksumOff-
loadIPv4

Default Value
3

Description

Specifies whether the device performs the calculation of IPv4
checksums.

The valid values are:

e 0: (disable)

e 1:(Tx Enable)

e 2:(Rx Enable)

e 3:(Tx and Rx enable)

*TCPUDPChecksu-
mOffloadIPv4

Specifies whether the device performs the calculation of TCP
or UDP checksum over IPv4.

The valid values are:

e 0: (disable)

* 1:(Tx Enable)

* 2:(Rx Enable)

e 3:(Tx and Rx enable)

*TCPUDPChecksu-
mOffloadIPv6

Specifies whether the device performs the calculation of TCP
or UDP checksum over IPvo6.
The valid values are:
* 0: (disable)
1: (Tx Enable)
* 2:(Rx Enable)
* 3:(Tx and Rx enable)

*RssOnHostVPorts

Virtual Machine Multiple Queue (VMMQ) HW Offload
The valid values are:

e (: disable

¢ 1:enable

*SwParsing

N/A

Specifies whether the device performs the calculation of TCP
checksum over IP-in-IP encapsulated IPv4/6 sent packets.
The valid values are:

*(: (disable)

*1: (Tx Enable)
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3.5.4 Performance Registry Keys

Features Overview and Configuration

This group of registry keys configures parameters that can improve adapter performance.
Table 15 - Performance Registry Keys

Value Name Default Value Description
TxIntModerationProfile | 1 Enables the assignment of different interrupt modera-
tion profiles for send completions. Interrupt modera-
tion can have great effect on optimizing network
throughput and CPU utilization.
The valid values are:
* 0: Low Latency
Implies higher rate of interrupts to achieve better
latency, or to handle scenarios where only a small num-
ber of streams are used.
* 1: Moderate
Interrupt moderation is set to midrange defaults to allow
maximum throughput at minimum CPU utilization for
common scenarios.
« 2:Aggressive
Interrupt moderation is set to maximal values to allow
maximum throughput at minimum CPU utilization for
more intensive, multi-stream scenarios.
RxIntModerationProfile | 1 Enables the assignment of different interrupt modera-

tion profiles for receive completions. Interrupt moder-

ation can have a great effect on optimizing network

throughput and CPU utilization.

The valid values are:

* 0: Low Latency
Implies higher rate of interrupts to achieve better
latency, or to handle scenarios where only a small num-
ber of streams are used.

* 1: Moderate
Interrupt moderation is set to midrange defaults to allow
maximum throughput at minimum CPU utilization for
common scenarios.

+  2: Aggressive
Interrupt moderation is set to maximal values to allow
maximum throughput at minimum CPU utilization, for
more intensive, multi-stream scenarios.
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Table 15 - Performance Registry Keys

Value Name

RecvCompletionMethod

1

Default Value

Description

Sets the completion methods of the receive packets,
and it affects network throughput and CPU utilization.
The supported methods are:

* Polling - increases the CPU utilization, because the sys-
tem polls the received rings for incoming packets; how-
ever, it may increase the network bandwidth since the
incoming packet is handled faster.

* Adaptive - combines the interrupt and polling methods
dynamically, depending on traffic type and network
usage.

The valid values are:

* 0: polling

+ 1:adaptive

*InterruptModeration

Sets the rate at which the controller moderates or
delays the generation of interrupts, making it possible
to optimize network throughput and CPU utilization.
When disabled, the interrupt moderation of the system
generates an interrupt when the packet is received. In
this mode, the CPU utilization is increased at higher
data rates, because the system must handle a larger
number of interrupts. However, the latency is
decreased, since that packet is processed more quickly.
When interrupt moderation is enabled, the system
accumulates interrupts and sends a single interrupt
rather than a series of interrupts.

The valid values are:

+ 0: disable

* 1:enable

RxIntModeration

Sets the rate at which the controller moderates or
delays the generation of interrupts, making it possible
to optimize network throughput and CPU utilization.
The default setting (Adaptive) adjusts the interrupt
rates dynamically, depending on traffic type and net-
work usage. Choosing a different setting may improve
network and system performance in certain configura-
tions.
The valid values are:
« 1: static
« 2:adaptive
The interrupt moderation count and time are configured
dynamically, based on traffic types and rate.
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Table 15 - Performance Registry Keys

Value Name

TxIntModeration

Default Value
2

Features Overview and Configuration

Description

Sets the rate at which the controller moderates or
delays the generation of interrupts, making it possible
to optimize network throughput and CPU utilization.
The default setting (Adaptive) adjusts the interrupt
rates dynamically, depending on traffic type and net-
work usage. Choosing a different setting may improve
network and system performance in certain configura-
tions.

The valid values are:

+ I: static

+ 2:adaptive

The interrupt moderation count and time are config-
ured dynamically, based on traffic types and rate.

*RSS

Sets the driver to use Receive Side Scaling (RSS)
mode to improve the performance of handling incom-
ing packets. This mode allows the adapter port to uti-
lize the multiple CPUs in a multi-core system for
receiving incoming packets and steering them to their
destination. RSS can significantly improve the number
of transactions per second, the number of connections
per second, and the network throughput.
This parameter can be set to one of two values:
* 1: enable (default)
Sets RSS Mode.
+ 0:disable
The hardware is configured once to use the Toeplitz
hash function and the indirection table is never changed.

ThreadPoll

3000

The number of cycles that should be passed without
receiving any packet before the polling mechanism
stops when using polling completion method for
receiving. Afterwards, receiving new packets will gen-
erate an interrupt that reschedules the polling mecha-
nism.

The valid values are 0 up to 200000.

Note: This registry value is not exposed via the UL
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Table 15 - Performance Registry Keys

Value Name

Vlanld

Default Value

ETH: 0

Description

Enables packets with Vlanld. It is used when no team
intermediate driver is used.
The valid values are:
+ 0:disable
No Vlan Id is passed.
+  1-4095
Valid Vlan Id that will be passed.

Note: This registry value is only valid for Ethernet.

*NumRSSQueues

The maximum number of the RSS queues that the
device should use.

Note: This registry key is only in Windows Server
2012 and above.

BlueFlame

The latency-critical Send WQEs to the device. When a
BlueFlame is used, the WQEs are written directly to
the PCI BAR of the device (in addition to memory), so
that the device may handle them without having to
access memory, thus shortening the execution latency.
For best performance, it is recommended to use the
BlueFlame when the HCA is lightly loaded. For high-
bandwidth scenarios, it is recommended to use regular
posting (without BlueFlame).

The valid values are:

+ 0:disable

* 1:enable

Note: This registry value is not exposed via the UL

*MaxRSSProcessors

The maximum number of RSS processors.

Note: This registry key is only in Windows Server
2012 and above.

AsyncRecievelndicate

Disabled default

Enables packet burst buffering using threaded DPC

Enables packet burst buffering using polling

RfdReservationFactor

150

Controls the number of reserved receive packets,
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3.5.5 Ethernet Registry Keys

Features Overview and Configuration

The following section describes the registry keys that are only relevant to Ethernet driver.
Table 16 - Ethernet Registry Keys

Value Name

RoceMaxFrameSize

Default Value
1024

Description

The maximum size of a frame (or a packet) that can be sent
by the RoCE protocol (a.k.a Maximum Transmission Unit
(MTU).

Using larger RoCE MTU will improve the performance;
however, one must ensure that the entire system, including
switches, supports the defined MTU.

Ethernet packet uses the general MTU value, whereas the
RoCE packet uses the RoOCE MTU

The valid values are:

« 256

e 512

« 1024

2048

Note: This registry key is supported only in Ethernet drivers.

*Priority VLANTag

3 (Packet Pri-
ority &
VLAN
Enabled)

Enables sending and receiving IEEE 802.3ac tagged frames,

which include:

*  802.1p QoS (Quality of Service) tags for priority-tagged pack-
ets.

*  802.1Q tags for VLANS.

When this feature is enabled, the Mellanox driver supports

sending and receiving a packet with VLAN and QoS tag.

DeviceRxStallTime-
out

1000

The maximum period for a single received packet process-
ing. If the packet was not processed during this time, the
device will be declared as stalled and will increase the "Criti-
cal Stall Watermark Reached" counter. The value is given in
mSec. The maximum period is 8000 mSec. the special value
of 0, indicates that the DeviceRxStallTimeout is inactive.

DeviceRxStall Water-
mark

The maximum period for a single received packet process-
ing. If the packet was not processed during this time, the
device will increase a diagnostic counter called "Minor Stall
Watermark Reached”. The value is given in mSec. The maxi-
mum period is 8000 mSec. The special value of 0, indicates
that the DeviceRxStallWatermark is inactive

TCHead-
OfQueueLifeTime-
Limit

0-20
Default: 19

The time a packet can live at the head of a TC queue before it
is discarded. The timeout value is defined by 4,096us multi-
plied by 2"TCHeadOfQueueLifetimeLimit.
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Table 16 - Ethernet Registry Keys

Value Name Default Value Description

TCStallCount 0-7 The number of sequential packets dropped due to Head Of
0: Disabled Queue Lifetime Limit, in order for the port to enter the
TCStalled state. All packets for the TC are discarded in this
state for a period of 8 times the timeout defined by TCHead-

OfQueueLifetimeLimit.
TCHead- 0 The TCs for which Head Of Queue Lifetime Limit is
OfQueueLifeTime- enabled. Bit 0 represents TCO, bit 1 represents TC1 and so
LimitEnable on.

The valid values are:

« 0-255

e 0: disabled

3.5.5.1 Flow Control Options

This group of registry keys allows the administrator to control the TCP/IP traffic by pausing
frame transmitting and/or receiving operations. By enabling the Flow Control mechanism, the
adapters can overcome any TCP/IP issues and eliminate the risk of data loss.

Table 17 - Flow Control Options

Value Name Default Value Description

*FlowControl 3 When Rx Pause is enabled, the receiving adapter generates a
flow control frame when its received queue reaches a pre-
defined limit. The flow control frame is sent to the sending
adapter.

When TX Pause is enabled, the sending adapter pauses the
transmission if it receives a flow control frame from a link
partner.

The valid values are:

* 0: Flow control is disabled

e 1: Tx Flow control is Enabled

* 2:Rx Flow control is enabled

e 3:Rx & Tx Flow control is enabled

3.5.5.2 VMQ Options

This section describes the registry keys that are used to control the NDIS Virtual Machine Queue
(VMQ). VMQ is supported by WinOF-2 and allows a performance boost for Hyper-V VMs.
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For more details about VMQ please refer to Microsoft web site,
http://msdn.microsoft.com/en-us/library/windows/hardware/ff571034(v=vs.85).aspx

Table 18 - YMQ Options

Value Name Default Value Description

*VMQ 1 The support for the virtual machine queue (VMQ) features of
the network adapter.
The valid values are:

* 1:enable

* 0:disable
*RssOrVmgqPrefer- 0 Specifies whether VMQ capabilities should be enabled
ence instead of receive-side scaling (RSS) capabilities.

The valid values are:
* 0: Report RSS capabilities
* 1: Report VMQ capabilities

Note: This registry value is not exposed via the UI.

*VMQVlanFiltering | 1 Specifies whether the device enables or disables the ability to
filter network packets by using the VLAN identifier in the
media access control (MAC) header.

The valid values are:

* 0:disable

e 1:enable

3.5.5.3 RoCE Options
This section describes the registry keys that are used to control RoCE mode.
Table 19 - RoCE Options
Value Name Default Value Description
roce_mode 0 - RoCE The RoCE mode.
The valid values are:
* 0-RoCE
* 4-NoRoCE
Note: The default value depends on the WinOF package
used.
3.5.5.4 SR-IOV Options
This section describes the registry keys that are used to control the NDIS Single Root I/O Virtu-
alization (SR-IOV). The SR-IOV is supported by WinOF-2, and allows a performance boost for
Hyper-V VMs.
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3.6

3.6.1

3.6.1.1

For more details about the VMQ, please see Single Root I/O Virtualization (SR-IOV) on Micro-
soft website.

Table 20 - SR-IOV Options

Value Name Default Value Description
SRIOV 1 The support for the SR-IOV features of the network adapter.
The valid values are:
* 1:enable
* 0: disable
SriovPreferred N/A (hidden) | A value that defines whether SR-IOV capabilities should be

enabled instead of the virtual machine queue (VMQ), or
receive side scaling (RSS) capabilities.

eSWUCLoopback N/A When set to 1, the Unicast traffic Loopback is disabled.
eSWMCLoopback N/A When set to 1, the Multicast traffic Loopback is disabled.
MaxFWPagesUsage- | 250000 This key sets the limitation for the maximum number of 4KB
PerVF pages that the host could allocate for VFs resources. When

set to 0, limitation is disabled.

Performance Tuning and Counters

For further information on WinOF-2 performance, please refer to the Performance Tuning Guide
for Mellanox Network Adapters.

This section describes how to modify Windows registry parameters in order to improve performance.

loss of data, system hang, and you may need to reinstall Windows. As such it is recommended to
back up the registry on your system before implementing recommendations included in this sec-
tion. If the modifications you apply lead to serious problems, you will be able to restore the original
registry state. For more details about backing up and restoring the registry, please visit www.micro-
soft.com.

Q Please note that modifying the registry incorrectly might lead to serious problems, including the

General Performance Optimization and Tuning

To achieve the best performance for Windows, you may need to modify some of the Windows
registries.

Registry Tuning

The registry entries that may be added/changed by this “General Tuning” procedure are:
Under HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters:
* Disable TCP selective acks option for better cpu utilization:

SackOpts, type REG DWORD, value set to 0.

Under HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\AFD\Parameters:
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* Enable fast datagram sending for UDP traffic:
FastSendDatagramThreshold, type REG DWORD, value set to 64K.

Under HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Ndis\Parameters:

* Set RSS parameters:
RssBaseCpu, type REG DWORD, value set to 1.

3.6.1.2 Enable RSS

Enabling Receive Side Scaling (RSS) is performed by means of the following command:

“netsh int tcp set global rss = enabled”

3.6.1.3 Improving Live Migration

In order to improve live migration over SMB direct performance, please set the following regis-
try key to 0 and reboot the machine:

HKEY LOCAL MACHINE\System\CurrentControlSet\Services\LanmanServer\Parameters\RequireSecuritySig-
nature

3.6.2 Application Specific Optimization and Tuning

3.6.2.1 Ethernet Performance Tuning

The user can configure the Ethernet adapter by setting some registry keys. The registry keys may
affect Ethernet performance.

» To improve performance, activate the performance tuning tool as follows:

Step 1.  Start the "Device Manager" (open a command line window and enter: devmgmt.msc).
Step 2.  Open "Network Adapters".

Step 3.  Right click the relevant Ethernet adapter and select Properties.

Step 4. Select the "Advanced" tab

Step 5. Modify performance parameters (properties) as desired.

3.6.2.1.1 Performance Known Issues

* On Intel I/OAT supported systems, it is highly recommended to install and enable the
latest I/OAT driver (download from www.intel.com).

*  With I/OAT enabled, sending 256-byte messages or larger will activate I/OAT. This will
cause a significant latency increase due to I/OAT algorithms. On the other hand,
throughput will increase significantly when using I/OAT.

3.6.2.2 Ethernet Bandwidth Improvements

» To improve Ethernet Bandwidth:
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3.6.2.3

Step 1.

Step 2.

Check you are running on the closest NUMA.

Stepa.  Inthe PowerShell run: Get-NetAdapterRss -Name "adapter name"

PS C: herods= Get-MetAdapterrss -Name "ethernet &"

Name : Ethernet 6
InterfaceDescription : Mellanox ConnectX-4 Lx Ethernet Adapter
Enabled
Numbe;OfReceiueQueues
rofile

Group :Number]
up :Number]

: [Group:Number/NUMA Distance] ;

IndirectionTable: [Group:Number]

Step b.

Validate that the IndirectionTable CPUs are located at the closest NUMA.
As illustrated in the figure above, the CPUs are 0:0 - 0:7, CPU 0 -7 and the distance from the

NUMA is 0, 0:0/0 - 0:7/0, unlike CPU 14-27/32767.
Stepc.  Ifthe CPUs are not close to the NUMEA, change the "RSS Base Processor Number" and

"RSS Max Processor Number" settings under the Advance tab to point to the closest
CPUs.

For high performance, it is recommended to work with at least 8 processors.

Check the Ethernet bandwidth, run ntttcp.exe.
* Server side: ntttcp -r -m 32,* server_ip

* Client side: ntttcp -s -m 32,* server_ip

IPoIB Performance Tuning

The user can configure the IPoIB adapter by setting some registry keys. The registry keys may
affect IPolIB performance.

For the complete list of registry entries that may be added/changed by the performance tuning
procedure, see MLNX VPI WinOF Registry Keys following the path below:

http://www.mellanox.com/page/products_dyn?product family=32&mtag=windows sw_drivers

» To improve performance, activate the performance tuning tool as follows:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Start the "Device Manager" (open a command line window and enter: devmgmt.msc).
Open "Network Adapters".

Right click the relevant IPoIB adapter and select Properties.
Select the "Advanced" tab

Modify performance parameters (properties) as desired.
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3.6.3 Tunable Performance Parameters

The following is a list of key parameters for performance tuning.

Jumbo Packet

The maximum available size of the transfer unit, also known as the Maximum Transmission
Unit (MTU). The MTU of a network can have a substantial impact on performance. A 4K
MTU size improves performance for short messages, since it allows the OS to coalesce many
small messages into a large one.

* Valid MTU values range for an Ethernet driver is between 614 and 9614.

All devices on the same physical network, or on the same logical network, must have
the same MTU.

Receive Buffers

The number of receive buffers (default 512).
Send Buffers

The number of sent buffers (default 2048).

Performance Options

Configures parameters that can improve adapter performance.

* Interrupt Moderation

Moderates or delays the interrupts’ generation. Hence, optimizes network throughput and CPU uti-

lization (default Enabled).

*  When the interrupt moderation is enabled, the system accumulates interrupts and sends a single inter-
rupt rather than a series of interrupts. An interrupt is generated after receiving 5 packets or after 10ms
from the first packet received. It improves performance and reduces CPU load however, it increases

latency.

*  When the interrupt moderation is disabled, the system generates an interrupt each time a packet is
received or sent. In this mode, the CPU utilization data rates increase, as the system handles a larger

number of interrupts. However, the latency decreases as the packet is handled faster.
* Receive Side Scaling (RSS Mode)

Improves incoming packet processing performance. RSS enables the adapter port to utilize the
multiple CPUs in a multi-core system for receiving incoming packets and steering them to the des-
ignated destination. RSS can significantly improve the number of transactions, the number of con-
nections per second, and the network throughput.

This parameter can be set to one of the following values:
* Enabled (default): Set RSS Mode
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* Disabled: The hardware is configured once to use the Toeplitz hash function, and the indirection table
is never changed.

@ IOAT is not used while in RSS mode.

* Receive Completion Method

Sets the completion methods of the received packets, and can affect network throughput and CPU

utilization.

* Polling Method
Increases the CPU utilization as the system polls the received rings for the incoming packets. How-
ever, it may increase the network performance as the incoming packet is handled faster.

e Adaptive (Default Settings)
A combination of the interrupt and polling methods dynamically, depending on traffic type and net-

work usage. Choosing a different setting may improve network and/or system performance in certain
configurations.

e Rx Interrupt Moderation Type

Sets the rate at which the controller moderates or delays the generation of interrupts making it pos-
sible to optimize network throughput and CPU utilization. The default setting (Adaptive) adjusts
the interrupt rates dynamically depending on the traffic type and network usage. Choosing a differ-
ent setting may improve network and system performance in certain configurations.

* Send Completion Method

Sets the completion methods of the Send packets and it may affect network throughput and CPU
utilization.

* Offload Options

Allows you to specify which TCP/IP offload settings are handled by the adapter rather than the
operating system.

Enabling offloading services increases transmission performance as the offload tasks are per-
formed by the adapter hardware rather than the operating system. Thus, freeing CPU resources
to work on other tasks.

¢ [Pv4 Checksums Offload

Enables the adapter to compute IPv4 checksum upon transmit and/or receive instead of the CPU
(default Enabled).

*  TCP/UDP Checksum Offload for IPv4 packets

Enables the adapter to compute TCP/UDP checksum over IPv4 packets upon transmit and/or
receive instead of the CPU (default Enabled).

*  TCP/UDP Checksum Offload for IPv6 packets

Enables the adapter to compute TCP/UDP checksum over IPv6 packets upon transmit and/or
receive instead of the CPU (default Enabled).

* Large Send Offload (LSO)
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Allows the TCP stack to build a TCP message up to 64KB long and sends it in one call down the
stack. The adapter then re-segments the message into multiple TCP packets for transmission on the
wire with each pack sized according to the MTU. This option offloads a large amount of kernel

3.6.4

processing time from the host CPU to the adapter.

Adapter Proprietary Performance Counters

Proprietary Performance Counters are used to provide information on Operating System, applica-
tion, service or the drivers' performance. Counters can be used for different system debugging
purposes, help to determine system bottlenecks and fine-tune system and application perfor-
mance. The Operating System, network, and devices provide counter data that the application
can consume to provide users with a graphical view of the system’s performance quality. WinOF-
2 counters hold the standard Windows CounterSet API that includes:

¢ Network Interface
*  RDMA activity
* SMB Direct Connection

3.6.4.1 Supported Standard Performance Counters

3.6.4.1.1 Proprietary Mellanox WinOF-2 Port Traffic Counters

Proprietary Mellanox WinOF-2 port traffic counters set consists of global traffic statistics which
gather information from ConnectX®-4 and ConnectX®-4 Lx network adapters, and includes
traffic statistics, and various types of error and indications from both the Physical Function and
Virtual Function.

Table 21 - Mellanox WinOF-2 Port Traffic Counters

Mellanox Adapter Traffic Counters Description
Bytes IN

Bytes Received Shows the number of bytes received by the adapter. The counted
bytes include framing characters.

Bytes Received/Sec Shows the rate at which bytes are received by the adapter. The
counted bytes include framing characters.

Packets Received Shows the number of packets received by the network interface.

Packets Received/Sec Shows the rate at which packets are received by the network inter-
face.

include framing characters.

Bytes/ Packets OUT

Bytes Sent Shows the number of bytes sent by the adapter. The counted bytes

bytes include framing characters.

Bytes Sent/Sec Shows the rate at which bytes are sent by the adapter. The counted

Packets Sent Shows the number of packets sent by the network interface.
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Table 21 - Mellanox WinOF-2 Port Traffic Counters

Mellanox Adapter Traffic Counters

Packets Sent/Sec

Description
Shows the rate at which packets are sent by the network interface.

Bytes’ TOTAL

Bytes Total Shows the total of bytes handled by the adapter. The counted bytes
include framing characters.
Bytes Total/Sec Shows the total rate of bytes that are sent and received by the

adapter. The counted bytes include framing characters.

Packets Total

Shows the total of packets handled by the network interface.

Packets Total/Sec

Shows the rate at which packets are sent and received by the net-
work interface.

Control Packets

Packets Outbound Errors®

The total number of successfully received control frames.?

ERRORS, DROP, AND MISC. INDICATIONS

Shows the number of outbound packets that could not be transmit-
ted because of errors found in the physical layer.?

Packets Outbound Discarded?

Shows the number of outbound packets to be discarded in the
physical layer, even though no errors had been detected to prevent
transmission. One possible reason for discarding packets could be
to free up some buffer space.

Packets Received Errors?

Shows the number of inbound packets that contained errors in the
physical layer, preventing them from being deliverable.

Packets Received with Frame
Length Error

Shows the number of inbound packets that contained error where
the frame has length error. Packets received with frame length

error are a subset of packets received errors.?

Packets Received with Symbol
Error

Shows the number of inbound packets that contained symbol error
or an invalid block. Packets received with symbol error are a sub-
set of packets received errors.

Packets Received with Bad
CRC Error

Shows the number of inbound packets that failed the CRC check.
Packets received with bad CRC error are a subset of packets
received errors.

Packets Received Discarded?®

RSC Aborts

Shows the number of inbound packets that were chosen to be dis-
carded in the physical layer, even though no errors had been
detected to prevent their being deliverable. One possible reason for
discarding such a packet could be a buffer overflow.

Receive Segment Coalescing (RSC)

Number of RSC abort events. That is, the number of exceptions
other than the IP datagram length being exceeded. This includes
the cases where a packet is not coalesced because of insufficient

hardware resources.?
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Table 21 - Mellanox WinOF-2 Port Traffic Counters

Mellanox Adapter Traffic Counters Description

RSC Coalesced Events Number of RSC coalesced events. That is, the total number of
packets that were formed from coalescing packets.?

RSC Coalesced Octets Number of RSC coalesced bytes.?

RSC Coalesced Packets Number of RSC coalesced packets.?

RSC Average Packet Size RSC Average Packet Size is the average size in bytes of received
packets across all TCP connections.?

a. This counter is relevant only for ETH ports.

b. Those error/discard counters are related to layer-2 issues, such as CRC, length, and type errors. There is a possi-
bility of an error/discard in the higher interface level. For example, a packet can be discarded for the lack of a
receive buffer. To see the sum of all error/discard packets, read the Windows Network-Interface Counters. Note
that for IPoIB, the Mellanox counters are for IB layer-2 issues only, and Windows Network-Interface counters are

for interface level issues.

3.6.4.1.2 Mellanox WinOF-2 Virtual Function (VF) Port Traffic Counters

Mellanox WinOF-2 VF Port Traffic set consists of counters that measure the rates at which bytes
and packets are sent and received over a virtual port network connection that is bound to a virtual
PCI function. It includes counters that monitor connection errors.

This set is available only on hypervisors and not on virtual network adapters.

This counters set is relevant only for ETH ports.

Table 22 - Mellanox WinOF-2 Virtual Function (VF) Port Traffic Counters

Mellanox WinOF-2 VF Port Traffic Counters Description

Bytes/Packets IN

Bytes Received/Sec

Shows the rate at which bytes are received over each
network VPort. The counted bytes include framing
characters.

Bytes Received Unicast/Sec

Shows the rate at which subnet-unicast bytes are deliv-
ered to a higher-layer protocol.

Bytes Received Broadcast/Sec

Shows the rate at which subnet-broadcast bytes are
delivered to a higher-layer protocol.

Bytes Received Multicast/Sec

Shows the rate at which subnet-multicast bytes are
delivered to a higher-layer protocol.
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Table 22 - Mellanox WinOF-2 Virtual Function (VF) Port Traffic Counters

Mellanox WinOF-2 VF Port Traffic Counters Description

Packets Received Unicast/Sec

Shows the rate at which subnet-unicast packets are
delivered to a higher-layer protocol.

Packets Received Broadcast/Sec

Shows the rate at which subnet-broadcast packets are
delivered to a higher-layer protocol.

Packets Received Multicast/Sec

Bytes Sent/Sec

Shows the rate at which subnet-multicast packets are
delivered to a higher-layer protocol.

Bytes/Packets IN

Shows the rate at which bytes are sent over each net-
work VPort. The counted bytes include framing char-
acters.

Bytes Sent Unicast/Sec

Shows the rate at which bytes are requested to be
transmitted to subnet-unicast addresses by higher-level
protocols. The rate includes the bytes that were dis-
carded or not sent.

Bytes Sent Broadcast/Sec

Shows the rate at which bytes are requested to be
transmitted to subnet-broadcast addresses by higher-
level protocols. The rate includes the bytes that were
discarded or not sent.

Bytes Sent Multicast/Sec

Shows the rate at which bytes are requested to be
transmitted to subnet-multicast addresses by higher-
level protocols. The rate includes the bytes that were
discarded or not sent.

Packets Sent Unicast/Sec

Shows the rate at which packets are requested to be
transmitted to subnet-unicast addresses by higher-level
protocols. The rate includes the packets that were dis-
carded or not sent.

Packets Sent Broadcast/Sec

Shows the rate at which packets are requested to be
transmitted to subnet-broadcast addresses by higher-
level protocols. The rate includes the packets that were
discarded or not sent.

Packets Sent Multicast/Sec

Packets Outbound Discarded

Shows the rate at which packets are requested to be
transmitted to subnet-multicast addresses by higher-
level protocols. The rate includes the packets that were
discarded or not sent.

ERRORS, DISCARDED

Shows the number of outbound packets to be discarded
even though no errors had been detected to prevent
transmission. One possible reason for discarding a

packet could be to free up buffer space.
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Table 22 - Mellanox WinOF-2 Virtual Function (VF) Port Traffic Counters

Mellanox WinOF-2 VF Port Traffic Counters Description

Packets Outbound Errors

Shows the number of outbound packets that could not
be transmitted because of errors.

on

Packets Received Discarded

Shows the number of inbound packets that were cho-
sen to be discarded even though no errors had been
detected to prevent their being deliverable to a higher-
layer protocol. One possible reason for discarding such
a packet could be to free up buffer space.

Packets Received Errors

Shows the number of inbound packets that contained
errors preventing them from being deliverable to a
higher-layer protocol.

3.6.4.1.3 Proprietary Mellanox WinOF-2 Port QoS Counters

Proprietary Mellanox WinOF-2 Port QoS counters set consists of flow statistics per (VLAN) pri-
ority. Each QoS policy is associated with a priority. The counter presents the priority's traffic,

pause statistic.

Q This counters set is relevant only for ETH ports.

Table 23 - Mellanox WinOF-2 Port QoS Counters

Mellanox Qos Counters

Description

Bytes/Packets IN

Bytes Received The number of bytes received that are covered by this pri-
ority. The counted bytes include framing characters (mod-
ulo 2°64).

Bytes Received/Sec The number of bytes received per second that are covered

by this priority. The counted bytes include framing char-
acters.

Packets Received

The number of packets received that are covered by this
priority (modulo 2°64).

Packets Received/Sec

Bytes Sent

The number of packets received per second that are cov-
ered by this priority.

Bytes/Packets OUT

The number of bytes sent that are covered by this priority.
The counted bytes include framing characters (modulo
2°64).
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Table 23 - Mellanox WinOF-2 Port QoS Counters

Mellanox Qos Counters

Description

Bytes Sent/Sec

The number of bytes sent per second that are covered by
this priority. The counted bytes include framing charac-
ters.

Packets Sent

The number of packets sent that are covered by this prior-
ity (modulo 2°64).

Packets Sent/Sec

The number of packets sent per second that are covered by
this priority.

ytes and Packets Total

|

Bytes Total The total number of bytes that are covered by this priority.
The counted bytes include framing characters (modulo
2°64).

Bytes Total/Sec The total number of bytes per second that are covered by

this priority. The counted bytes include framing charac-
ters.

Packets Total

The total number of packets that are covered by this prior-
ity (modulo 2°64).

Packets Total/Sec

Sent Pause Frames

The total number of packets per second that are covered
by this priority.

PAUSE INDICATION

The total number of pause frames sent from this priority to
the far-end port.

The untagged instance indicates the number of global
pause frames that were sent.

Sent Pause Duration

The total duration of packets transmission being paused
on this priority in microseconds.

Received Pause Frames

The number of pause frames that were received to this pri-
ority from the far-end port.

The untagged instance indicates the number of global
pause frames that were received.

Received Pause Duration

The total duration that far-end port was requested to pause
for the transmission of packets in microseconds.

Sent Discard Frames

The number of packets discarded by the transmitter.
Note: this counter is per TC and not per priority.
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3.6.4.1.4 RDMA Activity Counters

Features Overview and Configuration

RDMA Activity counter set consists of NDK performance counters. These performance counters
allow you to track Network Direct Kernel (RDMA) activity, including traffic rates, errors, and

control plane activity.

Table 24 - RDMA Activity Counters

RDMA Activity Counters Description

RDMA Accepted Connections

The number of inbound RDMA connections established.

RDMA Active Connections

The number of active RDMA connections.

RDMA Completion Queue This counter is not supported, and always is set to zero.

Errors

RDMA Connection Errors The number of established connections with an error before a
consumer disconnected the connection.

RDMA Failed Connection The number of inbound and outbound RDMA connection

Attempts attempts that failed.

RDMA Inbound Bytes/sec The number of bytes for all incoming RDMA traffic. This
includes additional layer two protocol overhead.

RDMA Inbound Frames/sec The number, in frames, of layer two frames that carry incoming

RDMA traffic.

RDMA Initiated Connections

The number of outbound connections established.

RDMA Outbound Bytes/sec

The number of bytes for all outgoing RDMA traffic. This
includes additional layer two protocol overhead.

RDMA Outbound Frames/sec

The number, in frames, of layer two frames that carry outgoing
RDMA traffic.

3.6.4.1.5 Mellanox WinOF-2 Congestion Control Counters

Mellanox WinOF-2 Congestion Control counters set consists of counters that measure the
DCQCN statistics over the network adapter.

Table 25 - Congestion Control Counters

Congestion Control Counters

Notification Point — CNPs Sent Successfully

Description
Notification Point

Number of congestion notification packets
(CNPs) successfully sent by the notification
point.

Notification Point — RoCEv2 DCQCN Marked

Packets

Number of RoCEv2 packets that were marked as
congestion encountered.

Reaction Point

Reaction Point — Current Number of Flows

Current number of Rate Limited Flows due to
RoCEv2 Congestion Control.
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Table 25 - Congestion Control Counters

Reaction Point — Ignored CNP Packets Number of ignored congestion notification pack-
ets (CNPs).

Reaction Point — Successfully Handled CNP Number of congestion notification packets

Packets (CNPs) received and handled successfully.

3.6.4.1.6 Mellanox WinOF-2 Diagnostics Counters

Mellanox WinOF-2 diagnostics counters set consists of the following counters:
Table 26 - WinOF-2 Diagnostics Counters

Mellanox WinOF-2 Diagnostics Counters Description

Reset Requests Number of resets requested by NDIS.

Link State Change Events Number of link status updates received from the hard-
ware.

Queued Send Packets Number of send packets pending transmission due to
hardware queues overflow.

Send Completions in Passive/Sec Number of send completion events handled in passive
mode per second.

Receive Completions in Passive/Sec Number of receive completion events handled in pas-
sive mode per second.

Copied Send Packets Number of send packets that were copied in slow path.

Correct Checksum Packets In Slow Path Number of receive packets that required the driver to
perform the checksum calculation and resulted in suc-
cess.

Bad Checksum Packets In Slow Path Number of receive packets that required the driver to

perform checksum calculation and resulted in failure.

Undetermined Checksum Packets In Slow | Number of receive packets with undetermined check-

Path sum result.
Watch Dog Expired/Sec Number of watch dogs expired per second.
Requester time out received Number of time out received when the local machine

generates outbound traffic.

Requester out of order sequence NAK Number of Out of Sequence NAK received when the
local machine generates outbound traffic, i.e. the num-
ber of times the local machine received NAKs indicat-
ing OOS on the receiving side.

Requester RNR NAK Number of RNR (Receiver Not Ready) NAKs
received when the local machine generates outbound
traffic.

Responder RNR NAK Number of RNR (Receiver Not Ready) NAKs sent

when the local machine receives inbound traffic.
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Table 26 - WinOF-2 Diagnostics Counters

Features Overview and Configuration

Mellanox WinOF-2 Diagnostics Counters Description

Responder out of order sequence received

Number of Out of Sequence packets received when
the local machine receives inbound traffic, i.e. the
number of times the local machine received messages
that are not consecutive.

Responder duplicate request received

Number of duplicate requests received when the local
machine receives inbound traffic.

Requester RNR NAK retries exceeded
errors

Number of RNR (Receiver Not Ready) NAKSs retries
exceeded errors when the local machine generates out-
bound traffic.

3.6.4.1.7 Mellanox WinOF-2 Device Diagnostic Counters

Mellanox WinOF-2 device diagnostic counters set consists of the following counters:.

Table 27 - Device Diagnostics Counters

Mellanox WinOF-2 Device Diagnostic Counters

Description

LO MTT miss The number of access to LO MTT that were missed
LO MTT miss/Sec The rate of access to LO MTT that were missed

LO MTT hit The number of access to LO MTT that were hit

LO MTT hit/Sec The rate of access to LO MTT that were hit

L1 MTT miss The number of access to L1 MTT that were missed
L1 MTT miss/Sec The rate of access to L1 MTT that were missed

L1 MTT hit The number of access to L1 MTT that were hit

L1 MTT hit/Sec The rate of access to L1 MTT that were hit

LO MPT miss The number of access to LO MKey that were missed
L0 MPT miss/Sec The rate of access to LO MKey that were missed

LO MPT hit The number of access to LO MKey that were hit

LO MPT hit/Sec The rate of access to LO MKey that were hit

L1 MPT miss The number of access to L1 MKey that were missed
L1 MPT miss/Sec The rate of access to L1 MKey that were missed

L1 MPT hit The number of access to L1 MKey that were hit

L1 MPT hit/Sec The rate of access to L1 MKey that were hit

RXS no slow path credis No room in RXS for slow path packets

RXS no fast path credis No room in RXS for fast path packets

RXT no slow path credis No room in RXT for slow path packets

RXT no fast path credis No room in RXT for fast path packets
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Table 27 - Device Diagnostics Counters

Description

Mellanox WinOF-2 Device Diagnostic Counters

Slow path packets slice load

Number of slow path packets loaded to HCA as slices
from the network

Fast path packets slice load

Number of fast path packets loaded to HCA as slices
from the network

Steering pipe 0 processing time

Number of clocks that steering pipe 0 worked

Steering pipe 1 processing time

Number of clocks that steering pipe 1 worked

WQE address translation back-pressure

No credits between RXW and TPT

Receive WQE cache miss

Number of packets that got miss in RWqe buffer LO
cache

Receive WQE cache hit

Number of packets that got hit in RWqe buffer LO
cache

Slow packets miss in LDB L1 cache

Number of slow packet that got miss in LDB L1 cache

Slow packets hit in LDB L1 cache

Number of slow packet that got hit in LDB L1 cache

Fast packets miss in LDB L1 cache

Number of fast packet that got miss in LDB L1 cache

Fast packets hit in LDB L1 cache

Number of fast packet that got hit in LDB L1 cache

Packets miss in LDB L2 cache

Number of packet that got miss in LDB L2 cache

Packets hit in LDB L2 cache

Number of packet that got hit in LDB L2 cache

Slow packets miss in REQSL L1

Number of slow packet that got miss in REQSL L1
fast cache

Slow packets hit in REQSL L1

Number of slow packet that got hit in REQSL L1 fast
cache

Fast packets miss in REQSL L1

Number of fast packet that got miss in REQSL L1 fast
cache

Fast packets hit in REQSL L1

Number of fast packet that got hit in REQSL L1 fast
cache

Packets miss in REQSL L2 Number of packet that got miss in REQSL L2 fast
cache

Packets hit in REQSL L2 Number of packet that got hit in REQSL L2 fast cache

No PXT credits time Number of clocks in which there were no PXT credits

EQ slices busy time

Number of clocks where all EQ slices were busy

CQ slices busy time

Number of clocks where all CQ slices were busy

MSIX slices busy time

Number of clocks where all MSIX slices were busy

QP done due to VL limited

Number of QP done scheduling due to VL limited
(e.g. lack of VL credits)

134

Mellanox Technologies

Rev 1.60




Yiiiy

Mellanox

TECHNOLOGIES

Table 27 - Device Diagnostics Counters

Mellanox WinOF-2 Device Diagnostic Counters

Features Overview and Configurat

Description

ion

QP done due to desched

Number of QP done scheduling due to desched (Tx
full burst size)

QP done due to work done

Number of QP done scheduling due to work done (Tx
all QP data)

QP done due to limited

Number of QP done scheduling due to limited (e.g.
max read)

QP done due to E2E creadits

Number of QP done scheduling due to e2e credits
(other peer credits)

Packets sent by SXW to SXP

Number of packets that were authorized to send by
SXW (to SXP)

Steering hit

Number of steering lookups that were hit

Steering miss

Number of steering lookups that were miss

Steering processing time

Number of clocks that steering pipe worked

No send credits for scheduling time

The number of clocks that were no credits for schedul-
ing (Tx)

No slow path send credits for scheduling
time

The number of clocks that were no credits for schedul-
ing (Tx) for slow path

TPT indirect memory key access

The number of indirect mkey accesses

3.6.4.1.8 Mellanox WinOF-2 PCI Device Diagnostic Counters

Mellanox WinOF-2 PCI device diagnostic counters set consists of the following counters:

Table 28 - PCI Device Diagnostic Counters

Mellanox WinOF-2 PCI Device Diagnostic

Counters

Description

PCI back-pressure cycles

The number of clocks where BP was received from the
PCI, while trying to send a packet to the host.

PCI back-pressure cycles/Sec

The rate of clocks where BP was received from the
PCI, while trying to send a packet to the host.

PCI write back-pressure cycles

The number of clocks where there was lack of posted
outbound credits from the PCI, while trying to send a
packet to the host.

PCI write back-pressure cycles/Sec

The rate of clocks where there was lack of posted out-
bound credits from the PCI, while trying to send a
packet to the host.

PCI read back-pressure cycles

The number of clocks where there was lack of non-
posted outbound credits from the PCI, while trying to
send a packet to the host.
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Table 28 - PCI Device Diagnostic Counters

Mellanox WinOF-2 PCI Device Diagnostic

Counters

Description

PCI read back-pressure cycles/Sec

The rate of clocks where there was lack of non-posted
outbound credits from the PCI, while trying to send a
packet to the host.

PCI read stuck no receive buffer

The number of clocks where there was lack in global
byte credits for non-posted outbound from the PCI,
while trying to send a packet to the host.

Available PCI BW

The number of 128 bytes that are available by the host.

Used PCI BW

The number of 128 bytes that were received from the
host.

RX PCI errors

The number of physical layer PCle signal integrity
errors. The number of transitions to recovery due to
Framing errors and CRC (dlp and tlp). If the counter is
advancing, try to change the PCle slot in use.

Note: Only a continues increment of the counter value
is considered an error.

TX PCI errors

The number of physical layer PCle signal integrity
errors. The number of transition to recovery initiated
by the other side (moving to Recovery due to getting
TS/EIEOS). If the counter is advancing, try to change
the PCle slot in use.

Note: transitions to recovery can happen during initial
machine boot. The counter should not increment after
boot.

Note: Only a continues increment of the counter value
is considered an error.

TX PCI non-fatal errors

The number of PCI transport layer Non-Fatal error
msg sent. If the counter is advancing, try to change the
PClIe slot in use.

TX PCI fatal errors

The number of PCle transport layer fatal error msg
sent. If the counter is advancing, try to change the
PCle slot in use.

3.6.4.1.9 Mellanox WinOF-2 Hardware RSS Diagnostic Counters

Mellanox WinOF-2 hardware RSS diagnostic counters set provides monitoring for hardware
RSS behavior. These counters are accumulative and collect packets per type (IPv4 or IPv6 only,
IPv4/6 TCP or UDP), for tunneled and non-tunneled traffic separately, and when the hardware

RSS is functional or dysfunctional.

The counters are activated upon first addition into perfmon, and are stopped upon removal.
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Setting "RssCountersActivatedAtStartup” registry key to 1 in the NIC properties will cause the
RSS counters to collect data from the startup of the device.

All RSS counters are provided under the counter set “Mellanox Adapter RSS Counters”

Each Ethernet adapter provides multiple instances:

* Instance per vPort per CPU in HwRSS mode is formatted: <NetworkAdapter> +
vPort_<id> CPU_<cpu>

* Instance per network adapter per CPU in native RSS per CPU is formatted: <Network-
Adapter> CPU_<cpu>.

Table 29 - RSS Diagnostic Counters

Mellanox WinOF-2 RSS Diagnostic

Counters Description

Rss IPv4 Only Shows the number of received packets that have RSS hash
calculated on IPv4 header only

Rss IPv4/TCP Shows the number of received packets that have RSS hash
calculated on IPv4 and TCP headers

Rss IPv4/UDP Shows the number of received packets that have RSS hash
calculated on IPv4 and UDP headers

Rss IPv6 Only Shows the number of received packets that have RSS hash
calculated on IPv6 header only

Rss IPv6/TCP Shows the number of received packets that have RSS hash
calculated on IPv6 and TCP headers

Rss IPv6/UDP Shows the number of received packets that have RSS hash
calculated on [Pv6 and UDP headers

Encapsulated Rss [Pv4 Only Shows the number of received encapsulated packets that have
RSS hash calculated on IPv4 header only

Encapsulated Rss IPv4/TCP Shows the number of received encapsulated packets that have
RSS hash calculated on IPv4 and TCP headers

Encapsulated Rss [Pv4/UDP Shows the number of received encapsulated packets that have
RSS hash calculated on IPv4 and UDP headers

Encapsulated Rss IPv6 Only Shows the number of received encapsulated packets that have
RSS hash calculated on IPv6 header only

Encapsulated Rss [Pv6/TCP Shows the number of received encapsulated packets that have
RSS hash calculated on IPv6 and TCP headers

Encapsulated Rss [Pv6/UDP Shows the number of received encapsulated packets that have
RSS hash calculated on IPv6 and UDP headers

NonRss [Pv4 Only Shows the number of IPv4 packets that have no RSS hash cal-
culated by the hardware

NonRss IPv4/TCP Shows the number of IPv4 TCP packets that have no RSS

hash calculated by the hardware
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Table 29 - RSS Diagnostic Counters

Mellanox WinOF-2 RSS Diagnostic

Counters Description

NonRss IPv4/UDP Shows the number of IPv4 UDP packets that have no RSS
hash calculated by the hardware

NonRss [Pv6 Only Shows the number of [Pv6 packets that have no RSS hash cal-
culated by the hardware

NonRss [Pv6/TCP Shows the number of [Pv6 TCP packets that have no RSS
hash calculated by the hardware

NonRss [Pv6/UDP Shows the number of IPv6 UDP packets that have no RSS

hash calculated by the hardware

Encapsulated NonRss IPv4 Only Shows the number of encapsulated IPv4 packets that have no
RSS hash calculated by the hardware

Encapsulated NonRss IPv4/TCP Shows the number of encapsulated IPv4 TCP packets that
have no RSS hash calculated by the hardware

Encapsulated NonRss IPv4/UDP Shows the number of encapsulated IPv4 UDP packets that
have no RSS hash calculated by the hardware

Encapsulated NonRss IPv6 Only Shows the number of encapsulated IPv6 packets that have no
RSS hash calculated by the hardware

Encapsulated NonRss IPv6/TCP Shows the number of encapsulated IPv6 TCP packets that
have no RSS hash calculated by the hardware

Encapsulated NonRss IPv6/UDP Shows the number of encapsulated IPv6 UDP packets that
have no RSS hash calculated by the hardware

Rss Misc Shows the number of received packets that have RSS hash
calculated with unknown RSS hash type

Encapsulated Rss Misc Shows the number of received encapsulated packets that have
RSS hash calculated with unknown RSS hash type

NonRss Misc Shows the number of packets that have no RSS hash calcu-

lated by the hardware for no apparent reason

Encapsulated NonRss Misc Shows the number of encapsulated packets that have no RSS
hash calculated by the hardware for no apparent reason

3.7 Network Direct Interface

The Network Direct Interface (NDI) architecture provides application developers with a net-
working interface that enables zero-copy data transfers between applications, kernel-bypass 1/0
generation and completion processing, and one-sided data transfer operations.
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3.7.1

NDI is supported by Microsoft and is the recommended method to write an RDMA application.
NDI exposes the advanced capabilities of the Mellanox networking devices and allows applica-
tions to leverage advances of RDMA.

Both RoCE and InfiniBand (IB) can implement NDI.
For further information please refer to:

http://msdn.microsoft.com/en-us/library/cc904397(v=vs.85).aspx

Test Running

In order to run the test, follow the steps below:
1. Connect two servers to Mellanox adapters.
2. Verify ping between the two servers.
3. Configure the RoCE version to be:
* RoCE V2:
* 1. Linux side - V2
* ii. Win side - V2
* iii.Verify that ROCE udp_port is the same on the two servers. For the registry key, refer to 3.5.5.3
“RoCE Options,” on page 119.
4. Select the server side and the client side, and run accordingly:
a. Server:
nd_rping/rping -s [-v -V -d] [-S size] [-C count] [-a addr] [-p port]
b. Client:
nd rping/rping -c [-v -V -d] [-S size] [-C count] -a addr [-p port]

Executable Options:

Letter Usage

- Server side

-P Persistent server mode allowing multiple connections
-C Client side

-a Address

-p Port

Debug Extensions:

Letter Usage

-v Displays ping data to stdout every test cycle
-V Validates ping data every test cycle

-d Shows debug prints to stdout

-S Indicates ping data size - must be < (64*1024)
-C Indicates the number of ping cycles to perform
Example:

Features Overview and Configuration
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» Linux server:
rping -v -s -a <IP address> -C 10
» Windows client:
nd rping -v -c -a <same IP as above> -C 10

The Network Direct Interface (NDI) architecture provides application developers with a net-
working interface that enables zero-copy data transfers between applications, kernel-bypass 1/O
generation and completion processing, and one-sided data transfer operations.

NDI is supported by Microsoft and is the recommended method to write an RDMA application.
NDI exposes the advanced capabilities of the Mellanox networking devices and allows applica-
tions to leverage advances of RDMA.

Both RoCE and InfiniBand (IB) can implement NDI.
For further information please refer to:

http://msdn.microsoft.com/en-us/library/cc904397(v=vs.85).aspx
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Utilities

Utilities

Fabric Performance Utilities

The performance utilities described in this chapter are intended to be used as a performance
micro-benchmark. They support both InfiniBand and RoCE.

For further information on the following tools, please refer to the help text of the tool by
running the --help command line parameter.

Table 30 - Fabric Performance Utilities

Utility Description

nd_write_bw

This test is used for performance measuring of RDMA-Write requests
in Microsoft Windows Operating Systems. nd_write_bw is perfor-
mance oriented for RDMA-Write with maximum throughput, and runs
over Microsoft's NetworkDirect standard. The level of customizing for
the user is relatively high. User may choose to run with a customized
message size, customized number of iterations, or alternatively, cus-
tomized test duration time. nd_write_bw runs with all message sizes
from 1B to 4MB (powers of 2), message inlining, CQ moderation.

nd_write_lat

This test is used for performance measuring of RDMA-Write requests
in Microsoft Windows Operating Systems. nd_write lat is perfor-
mance oriented for RDMA-Write with minimum latency, and runs over
Microsoft's NetworkDirect standard. The level of customizing for the
user is relatively high. User may choose to run with a customized mes-
sage size, customized number of iterations, or alternatively, customized
test duration time. nd_write_lat runs with all message sizes from 1B to
4MB (powers of 2), message inlining, CQ moderation.

nd_read_bw

This test is used for performance measuring of RDMA-Read requests
in Microsoft Windows Operating Systems. nd_read bw is performance
oriented for RDMA-Read with maximum throughput, and runs over
Microsoft's NetworkDirect standard. The level of customizing for the
user is relatively high. User may choose to run with a customized mes-
sage size, customized number of iterations, or alternatively, customized
test duration time. nd read bw runs with all message sizes from 1B to
4MB (powers of 2), message inlining, CQ moderation.

nd_read_lat

This test is used for performance measuring of RDMA-Read requests
in Microsoft Windows Operating Systems. nd_read lat is performance
oriented for RDMA-Read with minimum latency, and runs over Micro-
soft's NetworkDirect standard. The level of customizing for the user is
relatively high. User may choose to run with a customized message
size, customized number of iterations, or alternatively, customized test
duration time. nd_read_lat runs with all message sizes from 1B to 4MB
(powers of 2), message inlining, CQ moderation.
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Table 30 - Fabric Performance Utilities

Utility Description

nd_send_bw This test is used for performance measuring of Send requests in Micro-
soft Windows Operating Systems. nd_send bw is performance ori-
ented for Send with maximum throughput, and runs over Microsoft's
NetworkDirect standard. The level of customizing for the user is rela-
tively high. User may choose to run with a customized message size,
customized number of iterations, or alternatively, customized test dura-
tion time. nd_send_bw runs with all message sizes from 1B to 4MB
(powers of 2), message inlining, CQ moderation.

nd_send_lat This test is used for performance measuring of Send requests in Micro-
soft Windows Operating Systems. nd_send lat is performance oriented
for Send with minimum latency, and runs over Microsoft's NetworkDi-
rect standard. The level of customizing for the user is relatively high.
User may choose to run with a customized message size, customized
number of iterations, or alternatively, customized test duration time.
nd_send lat runs with all message sizes from 1B to 4MB (powers of
2), message inlining, CQ moderation.

4.1.1 Win-Linux nd_rping Test

The purpose of this test is to check interoperability between Linux and Windows via an RDMA
ping. The Windows nd_rping was ported from Linux's RDMACM example: rping.c

*  Windows

e To use the built-in nd rping.exe tool, go to: Program Files\Mellanox\MLNX-
_VPI\IB\Tools

* To build the nd_rping.exe from scratch, use the SDK example: choose the machine's OS
in the configuration manager of the solution, and build the nd rping.exe.

¢ Linux

Installing the MLNX OFED on a Linux server will also provide the "rping" application.

4.2 Management Utilities

The management utilities described in this chapter are used to manage device’s performance,
NIC attributes information and traceability.

4.2.1 miIx5cmd Utilities

mlx5cmd is a general management utility used for configuring the adapter, retrieving its informa-
tion and collecting its WPP trace.
» Usage

Mlx5cmd.exe <tool-name> <tool-arguments>
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4.2.1.1

4.2.1.2

4.2.1.3

4.2.1.4

4.2.1.5

Performance Tuning Utility

This utility is used mostly for IP forwarding tests to optimize the driver’s configuration to
achieve maximum performance when running in IP router mode.

» Usage

Mlx5cmd.exe -PerfTuning <tool-arguments>

Information Utility

This utility displays information of Mellanox NIC attributes. It is the equivalent utility to ibstat
and vstat utilities in WinOF.

» Usage

Mlx5cmd.exe -Stat <tool-arguments>

Trace Utility

The utility saves the ETW WPP tracing of the driver.
» Usage

Mlx5cmd.exe -Trace <tool-arguments>

QoS Configuration Utility

The utility configures Quality of Service (QoS) settings.
» Usage
M1x5cmd.exe -QoSConfig -Name <Network Adapter Name> <-DefaultUntaggedPriority | -Dcqcn>

For further information about the parameters, you may refer to Section 3.1.5.2, “RCM Configu-
ration”, on page 48.

mstdump Utility

This utility creates 3 mstdump file upon user request. For further information on the files created,
you may refer to Table 39, “Events Causing Automatic State Dumps,” on page 159.

» Usage

Mlx5cmd.exe -Mstdump [-bdf <pci-bus#> <pci-device#> <pci-function#>]

* The PCI information can be queried from the “General” properties tab under “Location”.

Example:
If the “Location” is “PCI Slot 3 (PCI bus 8, device 0, function 0)”, run the following command:
Mlx5cmd.exe -Mstdump -bdf 8.0.0

* The output will indicate the files location.

Example:

Utilities
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4.2.1.6

4.2.1.7

4.2.1.8

4.2.1.9

“Mstdump succeeded. Dump files for device at location 8.0.0 were created in c:\windows\temp
directory.”

Registry Keys Utility
This utility shows the registry keys that were set in the registry and are read by the driver.
» Usage
M1x5Cmd.exe -RegKeys [-bdf <pci-bus#> <pci-device#> <pci-function#>]
The PCI information can be queried from the "General" properties tab under "Location".
Example:
If the "Location" is "PCI Slot 3 (PCI bus 8, device 0, function 0)", run the following command:
M1x5Cmd.exe -RegKeys -bdf 8.0.0

Non-RSS Traffic Capture Utility

The RssSniffer utility provides sampling of packets that did not pass through the RSS engine,
whether it is non-RSS traffic, or in any other case that the hardware determines to avoid RSS
hashing.

The tool generates a packet dump file in a .pcap format. The RSS sampling is performed globally
in native RSS mode, or per vPort in virtualization mode, when the hardware vRSS mode is
active.

Note that the tool can be configured to capture only a part of the packet, as well as specific
packets in a sequence (N-th).

For detailed usage, run m1x5cmd.exe -RssSniffer -hh

Sniffer Utility

Sniffer utility provides the user with the ability to capture Ethernet and RoCE traffic that flows to
and from the Mellanox NIC's ports The tool generates a packet dump file in .pcap format. This
file can be read using the Wireshark tool (www.wireshark.org) for graphical traffic analysis.

For detailed usage, run m1x5cmd.exe -sniffer -help

Link Speed Utility

This utility provides the ability to query supported link speeds by the adapter. Additionally, it
enables the user to force set a particular link speed that the adapter can support.
» Usage
M1x5Cmd -LinkSpeed -Name <Network Adapter Name> -Query
Example:
M1x5Cmd -LinkSpeed -Name <Network Adapter Name> -Set 1

For detailed usage, run m1x5cmd.exe -LinkSpeed -hh
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4.3

4.3.1

Snapshot Utility

The snapshot tool scans the machine and provides information on the current settings of the oper-
ating system, networking and hardware.

Q It is highly recommended to add this report when you contact the support team.

Snapshot Usage

The snapshot tool can be found at:

<installation directory>\Management Tools\MLNX System Snapshot.exe
The user can set the report location.

» To generate the snapshot report:

Step 1. [Optional] Change the location of the generated file by setting the full path of the file to be
generated, or by pressing “Set target file” and choosing the directory that will hold the gen-
erated file and its name.

Step 2.  Click on Generate HTML button

Windows System Snapshot - 1.3 = B
File  About

Mellanox

TECHNDOLOGIES

Windows Spstem Information Snapshot Utility

Set target file | IC: S zershadministratorD esktophaystem_snap
Generate HT ML

Once the report is ready, the folder which contains the report will open automatically.

Utilities
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5 Troubleshooting

You may be able to easily resolve the issues described in this section. If a problem persists and
you are unable to resolve it, please contact your Mellanox representative or Mellanox Support at
support@mellanox.com.

5.1 Installation Related Troubleshooting

Table 31 - Installation Related Issues

Issue Cause Solution
The installation of An incorrect driver version | Use the correct driver package accord-
WinOF-2 fails with the | might have been installed, | ing to the CPU architecture.
following error mes- e.g., you are trying to install
sage: a 64-bit driver on a 32-bit
“This installation machine (or vice versa).

package is not sup-
ported by this pro-
cessor type. Contact
your product ven-
dor".

5.1.1 Installation Error Codes and Troubleshooting

5.1.1.1 Setup Return Codes
Table 32 - Setup Return Codes

Error Code Description Troubleshooting
1603 Fatal error during installation Contact support
1633 The installation package is not supported Make sure you are installing the
on this platform. right package for your platform

For additional details on Windows installer return codes, please refer to:
http://support.microsoft.com/kb/229683

5.1.1.2 Firmware Burning Warning Codes
Table 33 - Firmware Burning Warning Codes

Error Code Description Troubleshooting
1004 Failed to open the device Contact support
1005 Could not find an image for at The firmware for your device was not
least one device found. Please try to manually burn the
firmware.
1006 Found one device that has multiple | Burn the firmware manually and select
images the image you want to burn.

148 Mellanox Technologies Rev 1.60



Yiiiy

Mellanox

TECHNOLOGIES

Table 33 - Firmware Burning Warning Codes

Error Code Description

1007 Found one device for which force
update is required

Troubleshooting

Troubleshooting

Burn the firmware manually with the
force flag.

1008 Found one device that has mixed
versions

The firmware version or the expansion
rom version does not match.

For additional details, please refer to the MFT User Manual:

http://www.mellanox.com > Products > Firmware Tools

5.1.1.3 Restore Configuration Warnings

Table 34 - Restore Configuration Warnings

Error Code Description

3 Failed to restore the configu- | Please see log for more details and contact the

Troubleshooting

ration support team
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5.2 InfiniBand Related Troubleshooting
Table 35 - InfiniBand Related Issues
Issue Cause Solution
The InfiniBand inter- Port status might be Enable switch admin or connect cable.
faces are not up after the | PORT_DOWN: _
first reboot after the SVYltCh port state mlght .be
installation process is “disabled” or cable is dis-
completed. connected.
Port status might be Run the SM on the fabric.
PORT INITIALIZED: SM
might not be running on the
fabric.
Port status might be Please contact Mellanox Support.
PORT ARMED: Firmware
issue.
SR-IOV might be enabled Use the mlxconfig tool to disable SR-
with firmware that does not | IOV. Consult the MFT User Manual for
support SR-IOV and IPoIB | further details.
simultaneously.
in this case, the driver will
report an error message
stating that [PoIB is not
supported by the firmware.
5.3 Ethernet Related Troubleshooting
For further performance related information, please refer to the Performance Tuning Guide and
to Section 3.6, “Performance Tuning and Counters”, on page 120
Table 36 - Ethernet Related Issues
Issue Cause Solution
Low performance Non-optimal system con- See section “Performance Tuning and
figuration might have Counters” on page 120. to take advantage
occurred. of Mellanox 10/40/56 GBit NIC perfor-
mance.
The driver fails to start. | There might have been an 1. Open the event log and look under
RSS configuration mis- "System" for the "m1x5" source.
match between the TCP 2. Iffound, enable RSS, run: "netsh int
stack and the Mellanox tcp set global rss = enabled".
adapter. or a less recommended suggestion (as it
will cause low performance):
» Disable RSS on the adapter, run:
"netsh int tcp set global rss
= no dynamic balancing".
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Table 36 - Ethernet Related Issues

Issue

The driver fails to start
and a yellow sign
appears near the "Mel-
lanox ConnectX-4/
ConnectX-5 Adapter
<x>"in the Device
Manager display. (Code
10)

Cause

Look into the Event Viewer
to view the error.

Troubleshooting

Solution

If the failure occurred due to unsup-
ported mode type, refer to

Section 3.1.2, “Mode Configuration”
for the solution.

If the solution isn't mentioned in
event viewer, disable and re-enable
"Mellanox ConnectX-4/ConnectX-
5 Adapter <x>" from the Device
Manager display. If the failure
resumes, please refer to Mellanox
support at

support@mellanox.com.

No connectivity to a
Fault Tolerance team
while using network
capture tools (e.g.,
Wireshark).

The network capture tool
might have captured the
network traffic of the non-
active adapter in the team.
This is not allowed since
the tool sets the packet filter
to "promiscuous", thus
causing traffic to be trans-
ferred on multiple inter-
faces.

Close the network capture tool on the
physical adapter card, and set it on the
team interface instead.

No Ethernet connectiv-
ity on 10Gb adapters
after activating Perfor-
mance Tuning (part of
the installation).

A TepWindowSize registry
value might have been
added.

Remove the value key under

HKEY LOCAL MACHINE\SYSTEM\Cur-
rentControlSet\Ser-
vices\Tcpip\Parameters\TcpWind
owSize

Or

Set its value to 0xFFFF.

Packets are being lost.

The port MTU might have
been set to a value higher
than the maximum MTU
supported by the switch.

Change the MTU according to the maxi-
mum MTU supported by the switch.

NVGRE changes done
on a running VM, are

not propagated to the
VM.

The configuration changes
might not have taken effect
until the OS is restarted.

Stop the VM and afterwards perform
any NVGRE configuration changes on
the VM connected to the virtual switch.
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5.4 Performance Related Troubleshooting

Table 37 - Performance Related Issues

Low performance issues | The OS profile mightnotbe | 1. Go to "Power Options" in the "Control
configured for maximun Panel". Make sure "Maximum Perfor-
performace. mance" is set as the power scheme

2. Reboot the machine.

5.4.1 General Diagnostic

Issue 1. Go to “Device Manager”, locate the Mellanox adapter that you are debugging, right-
click and choose “Properties” and go to the “Information” tab:
* PCI Gen 1: should appear as "PCI-E 2.5 GT/s"
* PCI Gen 2: should appear as "PCI-E 5.0 GT/s"
* PCI Gen 3: should appear as "PCI-E 8.0 GT/s"
* Link Speed: 56.0 Gbps / 40.0Gbps / 10.0Gbps / 100 Gbps

Issue 2. To determine if the Mellanox NIC and PCI bus can achieve their maximum speed, it's
best to run nd_send bw in a loopback. On the same machine:

1. Run "start /b /affinity Ox1 nd_send bw -S <IP_host>" where <IP_host> is the local
IP.

2. Run "start /b /affinity 0x2 nd_send bw -C <IP_host>"

3. Repeat for port 2 with the appropriate IP.

4. On PCI Gen3 the expected result is around 5700MB/s

On PCI Gen?2 the expected result is around 3300MB/s

Any number lower than that points to bad configuration or installation on the wrong PCI slot.

Malfunctioning QoS settings and Flow Control can be the cause as well.

Issue 3. To determine the maximum speed between the two sides with the most basic test:

1. Run "nd_send bw -S <IP_host1>" on machine 1 where <IP_host1> is the local IP.

2. Run "nd_send bw -C <IP_host]1>" on machine 2.

3. Results appear in Gb/s (Gigabits 230), and reflect the actual data that was trans-
ferred, excluding headers.

4. If these results are not as expected, the problem is most probably with one or more
of the following:

* Old Firmware version.

*  Misconfigured Flow-control: Global pause or PFC is configured wrong on the hosts, routers and-
switches. See Section 3.1.3.1,“Configuring 5S6GbE Link Speed,” on page 39

* CPU/power options are not set to "Maximum Performance".
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5.5 Virtualization Related Troubleshooting
Table 38 - Virtualization Related Issues
Issue Cause Solution

When enabling the VMQ, in | Might be missing critical Please refer to:

case NVGRE offload is Microsoft updates. http://support.microsoft.com/kb/

enabled, and a teaming of 2975719

two virtual ports is per- “August 2014 update rollup for Win-

formed, no ping is detected dows server RT 8.1, Windows server

between the VMs and/or 8.1, and Windows server 2012 R2” —

ping is detected but no estab- specifically, fixes.

lishing of TCP connection is

possible.

When running the system Low resources for VF 1. Run the mlxconfig tool, according to

from an SR-IOV, The opera- the instructions in the "MFT User

resources might fail. www.mellanox.com ->Products ->
InfiniBand/VPI Drivers -> Firmware
Tools".

2. Extract the device name from “mst
status”, select the appropriate size (>
0, 2,4,8), and run the following
command:
mlxconfig -[device name] set
VF_LOG_BAR SIZE=size
Rev 1.60 Mellanox Technologies 153


www.mellanox.com
www.mellanox.com

Yiiiy

Mellanox

TECHNOLOGIES

5.6 Reported Driver Events

The driver records events in the system log of the Windows server event system which can be
used to identify, diagnose, and predict sources of system problems.

To see the log of events, open System Event Viewer as follows:

* Right click on My Computer, click Manage, and then click Event Viewer.
OR

1. Click start-->Run and enter "eventvwr.exe".
2. In Event Viewer, select the system log.

The following events are recorded:

* Mellanox ConnectX-4 VPI Adapter <X> device has been requested for <Y> Virtual Func-
tions (VFs), while it only supports <Z> VFs. Therefore, only <q> VFs will be allowed.

* Mellanox ConnectX-4 VPI Adapter <X> device has been configured to use RSS while
Windows' TCP RSS is disabled. This configuration prevents the initialization and enabling
of the port. You need to either enable Windows' TCP RSS, or configure the adapter's port
to disable RSS. For further details, see the README file under the documentation folder.

*  Mellanox ConnectX-4 VPI Adapter <X>: Jumbo packet value read from registry (<Y>) is
greater than the value supported by FW (<Z>). Therefore use the maximum value sup-
ported by FW(<g>).

* Mellanox ConnectX-4 VPI Adapter <X>: Maximum MTU supported by FW
<L>.<Y>.<Z>(<g>) is smaller than the minimum value <K>.

* Mellanox ConnectX-4 VPI Adapter <X> device is successfully stopped.

* Mellanox ConnectX-4 VPI Adapter <X> device startup fails due to less than minimum
MSI-X vectors available.

* Mellanox ConnectX-4 VPI Adapter <X> device detects that the link is up, and has initi-
ated a normal operation.

¢ Mellanox ConnectX-4 VPI Adapter <X> device detects that the link is down. This may
occur if the physical link is disconnected or damaged, or if the other end-port is down.

* Mellanox ConnectX-4 VPI Adapter <X>Mellanox ConnectX-4 VPI Adapter <X> device

configures not to use RSS. This configuration may significantly affect the network perfor-
mance.

e Mellanox ConnectX-4 VPI Adapter <X> device reports an "Error event" on CQn #<Y>.
Since the event type is:<Z>, the NIC will be reset. (The issue is reported in Function
<K>)_

* Mellanox ConnectX-4 VPI Adapter <X> device reports a send=<Y> "CQE error" on cqn
#<Z> qpn #<g> cqe_error->syndrome <K>, cqe error->vendor error syndrome <L>,
Opcode <F>. Therefore, the NIC will be reset. (The issue is reported in Function <M>).
For more information refer to details.
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Mellanox ConnectX-4 VPI Adapter <X> device reports an "EQ stuck" on EQn <Y>,
Attempting recovery.

Mellanox ConnectX-4 VPI Adapter <X> device reports a send completion handling time-
out on TxQueue 0x<Y>. Attempting recovery.

Mellanox ConnectX-4 VPI Adapter <X> device reports a receive completion handling
timeout on RxQueue 0x<Y>. Attempting recovery.

Flow control on the device Mellanox ConnectX-4 VPI Adapter <X> wasn't enabled.
Therefore, RoCE cannot function properly. To resolve this issue, please make sure that
flow control is configured on both the hosts and switches in your network. For more
details, please refer to the user manual.

Mellanox ConnectX-4 VPI Adapter <X> device is configured with a MAC address desig-
nated as a multicast address: <Y>.

Please configure the registry value NetworkAddress with another address, then restart the
driver.

The miniport driver initiates reset on device Mellanox ConnectX-4 VPI Adapter <X>.
NDIS initiates reset on device Mellanox ConnectX-4 VPI Adapter <X>.
Reset on device Mellanox ConnectX-4 VPI Adapter <X> has finished.
Mellanox ConnectX-4 VPI Adapter <X> has got:

* vendor id <Y>

e device id <Z>

* subvendor id <F>

e subsystem id <L>

e HWrevision <M>

*+ FWversion <R><G><Q>

* porttype <N>

Mellanox ConnectX-4 VPI Adapter <X>: QUERY_HCA_ CAP command fails with error
<Y>.

The adapter card is dysfunctional.

Most likely a FW problem.

Please burn the last FW and restart the Mellanox ConnectX device.

Mellanox ConnectX-4 VPI Adapter <X>: QUERY_ADAPTER command fails with error
<Y>,

The adapter card is dysfunctional.

Most likely a FW problem.

Please burn the last FW and restart the Mellanox ConnectX device.

Troubleshooting
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* Mellanox ConnectX-4 VPI Adapter <X>: The number of allocated MSI-X vectors is less
than recommended. This may decrease the network performance.
The number of requested MSI-X vectors is: <Y> while the number of allocated MSI-X
vectors is: <Z>.

e Mellanox ConnectX-4 VPI Adapter <X>: FW command fails. op 0x<Y>, status 0x<Z>,
errno <F>, syndrome 0x<L>.

* Too many IPs in-use for RRoCE.
Mellanox ConnectX-4 VPI Adapter <X>: RRoCE supports only <Y> IPs per port.
Please reduce the number of IPs to use the new IPs.

e Mellanox ConnectX-4 VPI Adapter <X>: Driver startup fails because an insufficient num-
ber of Event Queues (EQs) is available.

(<Y> are required, <Z> are recommended, <M> are available)

¢ Mellanox ConnectX-4 VPI Adapter <X>: Execution of FW command fails. op 0x<Y>,
errno <Z>.

* Mellanox ConnectX-4 VPI Adapter <X>: Driver startup has failed due to unsupported
port type=<Y> configured on the device.
The driver supports Ethernet mode only, please refer to the Mellanox WinOF-2 User Man-
ual for instructions on how to configure the correct mode.

* Mellanox ConnectX-4 VPI Adapter <X>: Driver startup fails because minimal driver
requirements are not supported by FW <Y>.<Z>.<L>.

FW reported:

e rss_ind tbl cap <Q>
* vlan_cap <M>

*  max rqs <F>

*  max sqs <N>

*  max tirs <O>

Please burn a firmware that supports the requirements and restart the Mellanox ConnectX device.
For additional information, please refer to Support information on http://mellanox.com.

* Mellanox ConnectX-4 VPI Adapter <X>: Driver startup fails because maximum flow
table size that is supported by FW <Y>.<Z>.<L> is too small (<K> entries).
Please burn a firmware that supports a greater flow table size and restart the Mellanox
ConnectX device. For additional information, please refer to Support information on http:/
/mellanox.com.

e Mellanox ConnectX-4 VPI Adapter <X>: Driver startup fails because required receive
WQE size is greater than the maximum WQEs size supported by FW <Y>.<Z><M>.
(<F> are required, <O> are supported)
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Mellanox ConnectX-4 VPI Adapter <X>: Driver startup fails because maximum WQE
size that is supported by FW <Y>.<L>.<M> is too small (<K>).

Please burn a firmware that supports a greater WQE size and restart the Mellanox Con-
nectX device. For additional information, please refer to Support information on http://
mellanox.com

Mellanox ConnectX-4 VPI Adapter <X>: CQ moderation is not supported by FW
<Y>.<Z><L>.

Mellanox ConnectX-4 VPI Adapter <X>: CQ to EQ remap is not supported by FW
<Y>.<Z><L>.

Mellanox ConnectX-4 VPI Adapter <X>: VPort counters are not supported by FW
<Y>.<Z><L>.

Mellanox ConnectX-4 VPI Adapter <X>: LSO is not supported by FW <Y>.<Z>.<[>,
Mellanox ConnectX-4 VPI Adapter <X>: Checksum offload is not supported by FW
<Y>.<Z><L>.

NDIS initiated reset on device Mellanox ConnectX-4 VPI Adapter <X> has failed.
Mellanox ConnectX-4 VPI  Adapter <X>: mstdump %System-

Root%\Temp\<Y> <Z><L> <M> <F> <O>.]og was created after fatal error.

Mellanox ConnectX-4 VPI  Adapter <X>: mstdump %System-
Root%\Temp\<Y> <Z><[> <M> <F> <O>.log was created after OID request.
Mellanox ConnectX-4 VPI Adapter <X> Physical/Virtual function drivers compatibility
issue <Y>.

Mellanox ConnectX-4 VPI Adapter <X> (module <Y>) detects that the link is down.

Cable is unplugged. Please connect the cable to continue working.

Mellanox ConnectX-4 VPI Adapter <X> (module <Y>) detects that the link is down.
Cable is unplugged. Please connect the cable to continue working.

Mellanox ConnectX-4 VPI Adapter <X> Setting QoS port default priority is not allowed
on a virtual device. This adapter will use the default priority <Y>.

Mellanox ConnectX-4 VPI Adapter <X>: FW health report - ver <Y>, hw <Z>, callra
<A>, var[1] <B> synd <C>.
Mellanox ConnectX-4 VPI Adapter <X>: Adapter failed to initialize due to FW initializa-

tion timeout.

Mellanox ConnectX-4 VPI Adapter <X>: Setting QoS port default priority is not allowed
on a virtual device. This adapter will use the default priority <Y>.

Mellanox ConnectX-4 VPI Adapter <X> failed to set port default priority to <Y>. This
adapter will use the default priority <Z>.

Mellanox ConnectX-4 VPI Adapter <X>: Dcqcen is not allowed on a virtual device.

Troubleshooting
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Dcqen was enabled for adapter Mellanox ConnectX-4 VPI Adapter <X> but FW
<Y>.<Z>.<W> does not support it. Dcqcn congestion control will not be enabled for this
adapter. Please burn a newer firmware. For more details, please refer to the user manual
document.

Mellanox ConnectX-4 VPI Adapter <X> failed to set Dcqcn RP/NP congestion control
parameters. This adapter will use default Dcqecn RP/NP congestion control values. Please
verify the Dcqen configuration and then restart the adapter.

Mellanox ConnectX-4 VPI Adapter <X> failed to enable Dcqcn RP/NP congestion con-
trol for priority <Y>. This adapter will continue without Dcqen <Y> congestion control
for this priority. Please verify the Dcqen configuration and then restart the adapter.

Mellanox ConnectX-4 VPI Adapter <X>: mstdump SystemRoot\Temp\<Y>.log was cre-
ated after a timeout on TxQueue.

Mellanox ConnectX-4 VPI Adapter <X>: mstdump SystemRoot\Temp\<Y>.log was cre-
ated after a timeout on RxQueue.

Mellanox ConnectX-4 VPI Adapter <X>: Dcqcn RP attributes:
¢ DcqenClampTgtRate = <Y>

¢ DcqenClampTgtRateAfterTimelnc = <Z>
¢ DcqcenRpgTimeReset = <E>

* DcqcenRpgByteReset = <L>

*  DcqenRpgThreshold = <M>

*  DcqcenRpgAiRate = <N>

*  DcqcnRpgHaiRate = <R>

¢ DcqcnAlphaToRateShift = <W>

*  DcqgenRpgMinDecFac = <G>

*  DcgcenRpgMinRate = <Q>

* DcqcnRateToSetOnFirstCnp = <F>

*  DcqenDeeTepG = <V>

*  DcqenDceeTepRtt = <O>

* DcgcnRateReduceMonitorPeriod = <K>
* Dcqenlnitial AlphaValue = <J>
Mellanox ConnectX-4 VPI Adapter <X>: Dcqcn NP attributes:
¢ DcqenMinTimeBetweenCnps = <Y>

*  DcqenCnpDscp = <Z>

¢ DcqenCnpPrioMode = <V>

¢ DcqenCnp802pPrio = <W>
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* Mellanox ConnectX-4 VPI Adapter <X>: FW health report - ver <Y>, hw <Z>, callra
<W>, var! <K>, synd <K>.
*  Mellanox ConnectX-4 VPI Adapter <X>: RDMA device initialization failure <Y>. This

adapter will continue running in Ethernet only mode.

¢ Mellanox ConnectX-4 VPI Adapter <X>:
mstdump %SystemRoot%\Temp\<A> <B> <C> <D> <E> <F>.log was created after
changed of link state.

* Mellanox ConnectX-4 VPI Adapter <X> adapter detected that the port type was changed.
Therefore, the following registry keys were set to the default values of the new port
type(<Y>).

. *JumboPacket = <Z>

5.7 State Dumping
Upon several types of events, the drivers can produce a set of files reflecting the current state of
the adapter.
Automatic state dumps are done upon the following events:
Table 39 - Events Causing Automatic State Dumps
Event Type Description Provider Default
CMD_ERR Command failure or timeout on a command MIx5 On c
EQ STUCK Driver decided that an event queue is stuck MIx5 On e
TXCQ _STUCK Driver decided that a transmit completion queue | MIx5 On t
is stuck
RXCQ _STUCK Driver decided that a receive completion queue is | MIx5 On r
stuck
PORT_STATE Adapter passed to “port up” state, “port down” MIx5 On p
state or “port unknown” state.
ON_OID User application asked to generate dump files MIx5 N/A 0
where
Provider The driver creating the set of files.
Default Whether or not the state dumps are created by default upon this event.
Tag Part of the file name, used to identify the event that has triggered the
state dump.
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Dump events can be enabled/disabled by adding DWORD32 parameters into HKLM\Sys-
tem\CurrnetControlSet\Services\mlx5\Parameters\Diag as follows:

» Dump events can be disabled by adding MstDumpMode parameter as follows:
Ms t DumpMode 0

» PORT STATE events can be disabled by adding EnableDumpOnUnknownLink and
EnableDumpOnPortDown parameters as follows:

EnableDumpOnUnknownLink 0
EnableDumpOnPortDown 0
EnableDumpOnPortUp 0

» EQ STUCK, TXCQ STUCK and RXCQ STUCK events can be disabled by adding Dis-
ableDumpOnEqStuck, DisableDumpOnTxCqStuck and DisableDumpOnRxCqStuck
parameters as follows:

DisableDumpOnTxCgStuck 1
DisableDumpOnTxCqStuck 1
DisableDumpOnRxCgStuck 1

The set consists of the following files:

* 3 consecutive mstdump files

These files are created in the %SystemRoot%\temp directory, and should be sent to Mellanox
Support for analysis when debugging WinOF2 driver problems. Their names have the following
format:<Driver mode of work> <card location> <event tag name> <event num-

ber> <event name> <file type> <file index>.log

where:
Driver mode of work The mode of driver work. For example: ‘SingleFunc’
card location In form bus_device function, For example: 4 0 0
event_tag name One-symbol tag. See in Table 39 - “Events Causing Automatic State
Dumps,” on page 159
event_number The index of dump files set and created for this event. This number is
restricted by the hidden Registry parameter DumpEventsNum
event_name A short string naming the event. For example: ‘eth-down-1’ =
“Ethernet portl passed to DOWN state”
file_type Type of file in the set. For example: “crspace”, “fwtrace”, “eq_dump” and
“eq_print”
file_index The file number of this type in the set
Example:

Name: SingleFunc 4 0 0 p000_eth-down-1_eq dump 0.log

The default number of sets of files for each event is 20. It can be changed by adding DumpE-
ventsNum DWORD32 parameter under HKLM\System\CurretControlSet\Ser-
vices\mlx5\Parameters and setting it to another value.
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5.8 Extracting WPP Traces

WinOF-2 Mellanox driver automatically dumps trace messages that can be used by the driver
developers for debugging issues that have recently occurred on the machine.

The default location for the trace file is:
%SystemRoot%\system32\LogFiles\MInx\Mellanox-WinOF2-System.etl
The automatic trace session is called Mellanox-WinOF2-Kernel.
» To view the session:
logman query Melloanox-WinOF2-Kernel -ets
» To stop the session:
logman stop Mellanox-WinOF2-Kernel -ets

When opening a support ticket, it is advised to attach the file to the ticket.
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Appendix A:  NVGRE Configuration Scripts Examples

The setup is as follow for both examples below:

Hypervisor hostl4 = "Portl", 192.168.20.114/24
VM on hostl4 = host14-005, 172.16.14.5/16, Mac 00155D720100
VM on hostl4 = host14-006, 172.16.14.6/16, Mac 00155D720101
Hypervisor hostl5 = "Portl", 192.168.20.115/24
VM on hostl5 = host15-005, 172.16.15.5/16, Mac 00155D730100
VM on hostl5 = host15-006, 172.16.15.6/16, Mac 00155D730101

A.1 Adding NVGRE Configuration to Host 14 Example

The following is an example of adding NVGRE to Host 14.

# On both sides
# vSwitch create command

# Note, that vSwitch configuration is persistent, no need to configure it after each
reboot

New-VMSwitch "VSwMLNX" -NetAdapterName "Portl" -AllowManagementOS S$true

# Shut down VMs

Stop-VM -Name "host14-005" -Force -Confirm

Stop-VM -Name "host14-006" -Force -Confirm

# Connect VM to vSwitch (maybe you have to switch off VM before), doing manual does also
work

# Connect-VMNetworkAdapter -VMName " host14-005" -SwitchName "VSwMLNX"

Add-VMNetworkAdapter -VMName "host14-005" -SwitchName "VSwMLNX" -StaticMacAddress
"00155D720100"

Add-VMNetworkAdapter -VMName "hostl14-006" -SwitchName "VSwMLNX" -StaticMacAddress
"00155D720101"
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ff Sommmes The commands from Step 2 - 4 are not persistent, Its suggested to create
script is running after each 0S reboot

# Step 2. Configure a Subnet Locator and Route records on each Hyper-V Host (Host 1 and
Host 2) hostld & hostl5

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.14.5 -ProviderAddress
192.168.20.114 -VirtualSubnetID 5001 -MACAddress "00155D720100" -Rule "TranslationMetho-
dEncap"

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.14.6 -ProviderAddress
192.168.20.114 -VirtualSubnetID 5001 -MACAddress "00155D720101" -Rule "TranslationMetho-
dEncap"

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.15.5 -ProviderAddress
192.168.20.115 -VirtualSubnetID 5001 -MACAddress "00155D730100" -Rule "TranslationMetho-
dEncap"

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.15.6 -ProviderAddress
192.168.20.115 -VirtualSubnetID 5001 -MACAddress "00155D730101" -Rule "TranslationMetho-
dEncap"

# Add customer route

New-NetVirtualizationCustomerRoute -RoutingDomainID "{11111111-2222-3333-4444-
000000005001 }" -VirtualSubnetID "5001" -DestinationPrefix "172.16.0.0/16" -NextHop
"0.0.0.0" -Metric 255

# Step 3. Configure the Provider Address and Route records on Hyper-V Host 1 (Host 1
Only) hostl4

SNIC = Get-NetAdapter "Portl"

New-NetVirtualizationProviderAddress -InterfaceIndex SNIC.InterfaceIndex -ProviderAd-
dress 192.168.20.114 -PrefixLength 24

New-NetVirtualizationProviderRoute -InterfaceIndex SNIC.InterfaceIndex -Destination-
Prefix "0.0.0.0/0" -NextHop 192.168.20.1

# Step 5. Configure the Virtual Subnet ID on the Hyper-V Network Switch Ports for each
Virtual Machine on each Hyper-V Host (Host 1 and Host 2)

# Run the command below for each VM on the host the VM is running on it, i.e. the for
host14-005, host14-006 on

# host 192.168.20.114 and for VMs host15-005, host15-006 on host 192.168.20.115

# hostl4 only

Get-VMNetworkAdapter -VMName host14-005 | where {$ .MacAddress -eq "00155D720100"} |
Set-VMNetworkAdapter -VirtualSubnetID 5001

Get-VMNetworkAdapter -VMName host14-006 | where {$ .MacAddress -eq "00155D720101"} |
Set-VMNetworkAdapter -VirtualSubnetID 5001
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A.2 Adding NVGRE Configuration to Host 15 Example

The following is an example of adding NVGRE to Host 15.

# On both sides
# vSwitch create command

# Note, that vSwitch configuration is persistent, no need to configure it after each
reboot

New-VMSwitch "VSwMLNX" -NetAdapterName "Portl" -AllowManagementOS Strue

# Shut down VMs

Stop-VM -Name "host15-005" -Force -Confirm

Stop-VM -Name "host15-006" -Force -Confirm

# Connect VM to vSwitch (maybe you have to switch off VM before), doing manual does also
work

# Connect-VMNetworkAdapter -VMName " host14-005" -SwitchName "VSwMLNX"

Add-VMNetworkAdapter -VMName "host15-005" -SwitchName "VSwMLNX" -StaticMacAddress

"00155D730100"

Add-VMNetworkAdapter -VMName "host15-006" -SwitchName "VSwMLNX" -StaticMacAddress
"00155D730101"

fif Sem=ee=s The commands from Step 2 - 4 are not persistent, Its suggested to create

script is running after each 0S reboot

# Step 2. Configure a Subnet Locator and Route records on each Hyper-V Host (Host 1 and
Host 2) hostl4 & hostl5

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.14.5 -ProviderAddress
192.168.20.114 -VirtualSubnetID 5001 -MACAddress "00155D720100" -Rule "TranslationMetho-
dEncap"

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.14.6 -ProviderAddress
192.168.20.114 -VirtualSubnetID 5001 -MACAddress "00155D720101" -Rule "TranslationMetho-
dEncap"

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.15.5 -ProviderAddress
192.168.20.115 -VirtualSubnetID 5001 -MACAddress "00155D730100" -Rule "TranslationMetho-
dEncap"

New-NetVirtualizationLookupRecord -CustomerAddress 172.16.15.6 -ProviderAddress
192.168.20.115 -VirtualSubnetID 5001 -MACAddress "00155D730101" -Rule "TranslationMetho-
dEncap"

# Add customer route

New-NetVirtualizationCustomerRoute -RoutingDomainID "{11111111-2222-3333-4444-
000000005001}" -VirtualSubnetID "5001" -DestinationPrefix "172.16.0.0/16" -NextHop
"0.0.0.0" -Metric 255

# Step 4. Configure the Provider Address and Route records on Hyper-V Host 2 (Host 2
Only) hostl5

SNIC = Get-NetAdapter "Portl"

New-NetVirtualizationProviderAddress -InterfaceIndex SNIC.InterfaceIndex -ProviderAd-
dress 192.168.20.115 -PrefixLength 24

New-NetVirtualizationProviderRoute -InterfaceIndex SNIC.InterfaceIndex -Destination-
Prefix "0.0.0.0/0" -NextHop 192.168.20.1
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# Step 5. Configure the Virtual Subnet ID on the Hyper-V Network Switch Ports for each
Virtual Machine on each Hyper-V Host (Host 1 and Host 2)

# Run the command below for each VM on the host the VM is running on it, i.e. the for
host14-005, host14-006 on

# host 192.168.20.114 and for VMs host15-005, host15-006 on host 192.168.20.115

# hostl5 only

Get-VMNetworkAdapter -VMName host15-005 | where {$ .MacAddress -eq "00155D730100"} |
Set-VMNetworkAdapter -VirtualSubnetID 5001

Get-VMNetworkAdapter -VMName host15-006 | where {$ .MacAddress -eq "00155D730101"} |
Set-VMNetworkAdapter -VirtualSubnetID 5001
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Appendix B:  Windows MPI (MS-MPI)

B.1 Overview

Message Passing Interface (MPI) is meant to provide virtual topology, synchronization, and com-
munication functionality between a set of processes.

With MPI you can run one process on several hosts.
*  Windows MPI run over the following protocols:
* Sockets (Ethernet)
* Network Direct (ND)

B.1.1 System Requirements
* Install HPC (Build: 4.0.3906.0).
» Validate traffic (ping) between the whole MPI Hosts.
* Every MPI client need to run smpd process which open the mpi channel.

e MPI Initiator Server need to run: mpiexec. If the initiator is also client it should also run
smpd.

B.2 Running MPI

Step 1.  Run the following command on each mpi client.
start smpd -d -p <port>

Step 2. Install ND provider on each MPI client in MPI ND.

Step 3. Run the following command on MPI server.

mpiexec.exe -p <smpd port> -hosts <num of hosts>
<hosts ip list> -env MPICH NETMASK <network ip/subnet> -
env MPICH ND ZCOPY THRESHOLD -1 -env MPICH DISABLE ND <0/
1> -env MPICH DISABLE SOCK <0/1> -affinity <process>

B.3 Directing MSMPI Traffic

Directing MPI traffic to a specific QoS priority may delayed due to:

* Except for NetDirectPortMatchCondition, the QoS powershell CmdLet for NetworkDi-
rect traffic does not support port range. Therefore, NetwrokDirect traffic cannot be
directed to ports 1-65536.

* The MSMPI directive to control the port range (namely: MPICH PORT RANGE
3000,3030) is not working for ND, and MSMPI chose a random port.
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B.4 Running MSMPI on the Desired Priority
Step 1. Set the default QoS policy to be the desired priority (Note: this prio should be lossless all
the way in the switches*)
Step 2.  Set SMB policy to a desired priority only if SMD Traffic running.
Step 3. [Recommended] Direct ALL TCP/UDP traffic to a lossy priority by using the “IPProtocol-
MatchCondition”.
TCP is being used for MPI control channel (smpd), while UDP is being used for other
services such as remote-desktop.
Arista switches forwards the pcp bits (e.g. 802.1p priority within the vlan tag) from ingress to
egress to enable any two End-Nodes in the fabric as to maintain the priority along the route.
In this case the packet from the sender goes out with priority X and reaches the far end-node with
the same priority X.
Q The priority should be losslessin the switches
» To force MSMPI to work over ND and not over sockets, add the following in mpiexec com-
mand:
-env MPICH DISABLE ND 0 -env MPICH DISABLE SOCK 1
B.5 Configuring MPI
Step 1.  Configure all the hosts in the cluster with identical PFC (see the PFC example below).
Step 2.  Run the WHCK ND based traffic tests to Check PFC (ndrping, ndping, ndrpingpong,
ndpingpong).
Step 3.  Validate PFC counters, during the run-time of ND tests, with “Mellanox Adapter QoS
Counters” in the perfmon.
Step 4. Install the same version of HPC Pack in the entire cluster.
NOTE: Version mismatch in HPC Pack 2012 can cause MPI to hung.
Step 5. Validate the MPI base infrastructure with simple commands, such as “hostname”.
B.5.1 PFC Example
In the example below, ND and NDK go to priority 3 that configures no-drop in the switches. The
TCP/UDP traffic directs ALL traffic to priority 1.
* Install dcbx.
Install-WindowsFeature Data-Center-Bridging
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* Remove the entire previous settings.
Remove-NetQosTrafficClass
Remove-NetQosPolicy -Confirm:S$SFalse

* Set the DCBX Willing parameter to false as Mellanox drivers do not support this feature
Set-NetQosDcbxSetting -Willing 0

* Create a Quality of Service (QoS) policy and tag each type of traffic with the relevant
priority.
In this example we used TCP/UDP priority 1, ND/NDK priority 3.
New-NetQosPolicy “SMB" -NetDirectPortMatchCondition 445 -PriorityValue8021Action 3
New-NetQosPolicy “DEFAULT" -Default -PriorityValue8021Action 3

New-NetQosPolicy “TCP" -IPProtocolMatchCondition TCP -PriorityValue8021Actionl
New-NetQosPolicy “UDP" -IPProtocolMatchCondition UDP -PriorityValue8021Action 1

* Enable PFC on priority 3.
Enable-NetQosFlowControl 3

* Disable Priority Flow Control (PFC) for all other priorities except for 3.
Disable-NetQosFlowControl 0,1,2,4,5,6,7

* Enable QoS on the relevant interface.

Enable-netadapterqos -Name

B.5.2 Running MPI Command Examples

* Running MPI pallas test over ND.

> mpiexec.exe -p 19020 -hosts 4 11.11.146.101 11.21.147.101
11.21.147.51

11.11.145.101 -env MPICH NETMASK 11.0.0.0/

255.0.0.0 -env MPICH ND ZCOPY THRESHOLD -1 -env MPICH DISABLE ND O
-env

MPICH DISABLE SOCK 1 -affinity c:\\testl.exe

* Running MPI pallas test over ETH.

> exempiexec.exe -p 19020 -hosts 4 11.11.146.101 11.21.147.101
11.21.147.51

11.11.145.101 -env MPICH NETMASK 11.0.0.0/

255.0.0.0 -env MPICH ND ZCOPY THRESHOLD -1 -env MPICH DISABLE ND 1
-env

MPICH DISABLE SOCK 0 -affinity c:\\testl.exe
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